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ABSTRACT 

This report contains the user guide and technical basis (models and methods) for the 
NRCDose3 computer code. It provides the end user with instructions for using NRCDose3 and 
documents the bases for updates made to the previous version of the code, NRCDose 2.3.20. 
NRCDose3 is a software suite that integrates the functionality of three individual Fortran codes 
(LADTAP II, GASPAR II, and XOQDOQ) developed by the U.S. Nuclear Regulatory 
Commission (NRC) in the 1980s. The nuclear industry and the NRC staff have used these 
codes to assess liquid radioactive releases and offsite doses, gaseous radioactive effluents and 
offsite doses, and meteorological transport and dispersion, respectively. The codes are primarily 
used in support of reactor licensing, to evaluate the safety and environmental dose impacts of 
liquid and gaseous radioactive effluent releases. NRCDose3 uses the same basic calculation 
methods (algorithms) as the Fortran codes. However, the updated code includes a more 
user-friendly graphical interface for entering data. Also, significant changes have been made to 
the data management and operation to support expanded capabilities. 
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1-1 

1.0 INTRODUCTION 
NRCDose3 is the most recent version of the NRCDose code, a software suite that integrates 
under a unified graphical user interface (GUI) the functionality of three individual Fortran codes 
(LADTAP II, GASPAR II, and XOQDOQ) developed by and for the U.S. Nuclear Regulatory 
Commission (NRC) in the 1980s. NRCDose3 features an updated Windows GUI; an expanded 
radionuclide library including 203 radionuclides with dose conversion factors; fully 
user-modifiable parameters for LADTAP, GASPAR, and XOQDOQ; and compatibility with 
Windows 7 and above, as well as Internet Explorer 7 and above. 

The original NRCDose code (version 2.3.20 and earlier) was developed by an NRC contractor, 
Chesapeake Nuclear Services, Inc. (CNS), for end users including the NRC staff, applicants, 
and licensees. It incorporated the LADTAP II, GASPAR II, and XOQDOQ Fortran codes, which 
the nuclear industry and the NRC staff use to assess and evaluate liquid radioactive releases 
and offsite doses, gaseous radioactive effluents and offsite doses, and meteorological transport 
and dispersion, respectively. The codes are primarily used in support of domestic and 
international reactor licensing, to assess the safety and environmental dose impacts of liquid 
and gaseous radioactive effluent releases associated with routine (normal) plant operations and 
anticipated operational occurrences. 

The NRCDose3 code, together with the underlying LADTAP, GASPAR, and XOQDOQ Fortran 
codes, implements the calculation methodologies described in this manual and the following 
NRC regulatory guides (RGs): 

• RG 1.109, “Calculation of Annual Doses to Man from Routine Releases of Reactor 
Effluents for the Purpose of Evaluating Compliance with 10 CFR Part 50, 
Appendix I,” Revision 1, issued October 1977 [Ref. 1] 

• RG 1.111, “Methods for Estimating Atmospheric Transport and Dispersion of 
Gaseous Effluents in Routine Releases from Light-Water-Cooled Reactors,” 
Revision 1, issued July 1977 [Ref. 2] 

• RG 1.113, “Estimating Aquatic Dispersion of Effluents from Accidental and Routine 
Reactor Releases for the Purpose of Implementing Appendix I,” Revision 1, issued 
April 1977 [Ref. 3] 

The NRC staff applies these dose assessment methods in its safety and environmental reviews 
and evaluations as prescribed in the following: 

• RG 4.2, “Preparation of Environmental Reports for Nuclear Power Stations,” 
Revision 3, issued September 2018 [Ref. 4] 

• NUREG-1555, “Standard Review Plans for Environmental Reviews for Nuclear 
Power Plants: Environmental Standard Review Plan,” Revision 1, issued July 2007 
[Ref. 5] 

• NUREG-0800, “Standard Review Plan for the Review of Safety Analysis Reports for 
Nuclear Power Plants: LWR Edition,” Revision 6, issued March 2007 [Ref. 6] 

  



 

1-2 

1.1 LADTAP II Code 

The LADTAP II Fortran code, described in NUREG/CR-4013, “LADTAP II—Technical 
Reference and User Guide,” issued April 1986 [Ref. 7], implements the liquid pathway modeling 
described in RG 1.109 and RG 1.113. LADTAP II estimates the radiation dose to individuals, 
population groups, and biota from ingestion pathways (aquatic foods, water, and terrestrial 
irrigated foods) and external exposure pathways (swimming, boating, and shoreline recreational 
activities). The calculated doses provide information for National Environmental Policy Act 
(NEPA) evaluations and for determining compliance with the “as low as is reasonably 
achievable” (ALARA) philosophy of Appendix I, “Numerical Guides for Design Objectives and 
Limiting Conditions for Operation to Meet the Criterion ‘As Low as Is Reasonable Achievable’ for 
Radioactive Material in Light-Water-Cooled Nuclear Power Effluents,” to Title 10 of the Code of 
Federal Regulations (10 CFR) Part 50, “Domestic Licensing of Production and Utilization 
Facilities” [Ref. 8]. 

1.2 GASPAR II Code 

The GASPAR II Fortran code, described in NUREG/CR-4653, “GASPAR II—Technical 
Reference and User Guide,” issued March 1987 [Ref. 9], implements the atmospheric pathway 
modeling described in RG 1.109 and RG 1.111. GASPAR II estimates the radiation doses to 
individuals and population groups from inhalation, ingestion (terrestrial foods), and external 
exposure (ground and plume) pathways. The calculated doses provide information for NEPA 
evaluations and for determining compliance with the ALARA philosophy of Appendix I to 
10 CFR Part 50. GASPAR II does not estimate radiation doses to biota. 

1.3 XOQDOQ Code 

The XOQDOQ Fortran code, described in NUREG/CR-2919, “XOQDOQ: Computer Program for 
the Meteorological Evaluation of Routine Effluent Releases at Nuclear Power Stations,” issued 
September 1982 [Ref. 10], implements the atmospheric pathway modeling described in 
RG 1.111. XOQDOQ calculates the relative atmospheric dispersion (X/Q) and relative 
atmospheric deposition (D/Q) values at locations specified by the user and at various standard 
radial distances and distance segments for downwind sectors. The model is based on a 
straight-line Gaussian model, and the code can account for variation in the location of release 
points, additional plume dispersion due to building wakes, plume depletion through dry 
deposition and radioactive decay, and adjustments to consider nonstraight trajectories. 

1.4 NRCDose3 Code Update 

This update to the NRCDose code does not change the basic calculation methods (algorithms) 
of the LADTAP II, GASPAR II, and XOQDOQ Fortran codes. In general, this update improves 
the GUI to make it more user friendly for data input. It also includes significant changes to the 
data management and code operation to support expanded capabilities. The most significant 
changes and revisions to the code are summarized below and explained in greater detail in 
Section 4 of this manual: 

• Support for updated dose conversion factor (DCF). Previous versions of the NRCDose 
code containing LADTAP II and GASPAR II used only one set of DCF values, largely 
those appearing in RG 1.109 and based on the methodology in International 
Commission on Radiological Protection (ICRP) Publication 2, “Report of Committee II on 
Permissible Dose for Internal Radiation” (ICRP-2), issued 1960 [Ref. 11]. NRCDose3 
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allows the user to select the ICRP-2 (default) DCF values; those for exposure to workers 
from ICRP Publication 30, “Limits for Intakes of Radionuclides by Workers” (ICRP-30), 
issued 1979 [Ref. 12]; or those for public exposure from ICRP Publication 72, 
“Age-Dependent Doses to Members of the Public from Intake of Radionuclides—Part 5, 
Compilation of Ingestion and Inhalation Dose Coefficients” (ICRP-72), issued 1995 
[Ref. 13]. 

• Updated age groups. ICRP-72 uses six age groups (infant, 1-year, 5-year, 10-year, 
15-year, and adult). RG 1.109, the original basis for LADTAP II and GASPAR II, uses 
four age groups (infant, child, teen, and adult). NRCDose3 uses all six age groups when 
ICRP-72 DCF values are selected. 

** User Note **—ICRP-30 provides DCF values only for the adult worker, not for other age 
groups. An applicant or licensee preparing an NRC licensing action request (LAR) should 
discuss use of ICRP-72 DCF values with the NRC staff before submitting the request. 

• Updated default usage factors. When ICRP-72 DCF values are selected, NRCDose3 
uses updated usage (consumption and exposure) factors based on data in the 
U.S. Environmental Protection Agency (EPA) publication EPA/600/R-090/052F, 
“Exposure Factors Handbook: 2011 Edition” (EFH), issued September 2011 [Ref. 14]. 

** User Note **—The EPA’s EFH usage factors are different from those in RG 1.109. An 
applicant or licensee preparing an NRC LAR should discuss use of EFH usage factors with the 
NRC staff before submitting the request. 

• Updated LADTAP biota dose calculations. The LADTAP II Fortran code originally had 
limited provisions for estimating the radiation dose to biota from liquid radioactive 
effluent releases. In NRCDose3, the biota dose model has been revised, with updates to 
effective radius dose factors (as used for calculating internal doses to biota) and the 
ability to include user-defined biota. For every special location defined in LADTAP, biota 
doses may be calculated for the following species: 

- fish 
- muskrat 
- raccoon 
- duck 
- heron 
- user-defined species 

Section 6.3 and appendix D to this manual give the technical basis of the biota dose 
model used in NRCDose3 to estimate the radiation dose to biota from liquid radioactive 
effluent releases. 

• Added GASPAR biota dose calculations. The GASPAR II Fortran code originally had no 
provision for estimating the radiation dose to biota from gaseous radioactive effluent 
releases. In NRCDose3, the code has been revised to include biota dose models. For 
every special location defined in GASPAR, biota doses may be calculated for the 
following representative and surrogate species, as applicable for gaseous effluents and 
exposure pathways, including direct exposure (plume and ground deposition), as well as 
dietary intake (plant and meat): 
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- muskrat 
- raccoon 
- duck 
- heron 
- cow 
- fox 
- user-defined species 

Section 6.3 and appendix D to this manual give the technical basis of the biota dose 
model used in NRCDose3 to estimate the radiation dose to biota from gaseous 
radioactive effluent releases. 

• Additionally, NRCDose3 features the following functional improvements: 

- updated Visual Basic .NET GUI. 
- expanded radionuclide library covering 203 radionuclides. 
- fully user-modifiable parameters for LADTAP, GASPAR, and XOQDOQ 
- compatibility with Windows 7 and above and Internet Explorer 7 and above. 

1.5 Software Quality Assurance and Configuration Management Plans 

More information about NRCDose3 is available in CNS-19001, “NRCDose3 Computer Code: 
Software Quality Assurance Plan,” issued July 2019 [Ref. 15], and CNS-19003, “NRCDose3 
Computer Code: Configuration Management and Maintenance Plan,” issued July 2019 
[Ref. 16]. NUREG/BR-0167, “Software Quality Assurance Program and Guidelines,” issued 
February 1993 [Ref. 17], defines three levels of software: 

(1) Level 1—technical application software used in a safety decision by the NRC. 

(2) Level 2—technical or nontechnical application software not used in a safety decision 
by the NRC. 

(3) Level 3—technical or nontechnical application software not used in a safety decision 
and having local or limited use by the NRC. 

The NRCDose3 quality assurance documents conform to the Level 2 requirements. 
Development of NRCDose3 has proceeded under the software quality assurance plan and 
configuration management and maintenance plan (CMMP). CNS-19004, “NRCDose3 Computer 
Code: Validation and Validation Report,” issued July 2019 [Ref. 18], describes the work done to 
verify proper implementation of the new coding. 

In addition, NRCDose3 was developed under CNS-19002, “NRCDose3 Computer Code: 
Software Design Document,” issued July 2019 [Ref. 19]. The software design document 
presents detailed information on the code and database structure, integration of the modified 
Fortran codes, and definition of the supplemental databases used for program operation, data 
management, and generation of reports. 
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2.0 INSTALLATION 
This section describes how to obtain and install NRCDose3 and specifies the computing 
requirements for doing so. 

2.1 Distribution 

The NRCDose3 code is available for download from the NRC’s Radiation Protection Computer 
Code Analysis and Maintenance Program (RAMP) website (https://ramp.nrc-gateway.gov/), 
which also provides access to technical references, training and presentation materials, and 
code support (through forum boards). 

2.2 Installation 

The NRCDose3 code can be installed on a single computer running a Windows 7.0 or later 
operating system with administrative privileges and compatible with Internet Explorer 7.0 or 
later. The code is available through the RAMP website (https://ramp.nrc-gateway.gov/), where a 
user registration is required. Text reports are used for generating outputs such as the traditional, 
supplemental, and final safety analysis reports (FSARs) from the LADTAP, GASPAR, and 
XOQDOQ calculations. 

The initial installation will create a user-specified directory (e.g., C:/NRCDose3 by default) for 
use by NRCDose3. For updates, the install routine will automatically delete the current version 
before installing the updated version. Only the updated program files are replaced. User-created 
case files (*.LNP, *.GNP, or *.XNP files) will not be deleted from the directory; however, it is 
recommended that all case files be saved to a different folder or storage device as a backup. 

The NRCDose code (version 2.3.20 or earlier) is a separate program from NRCDose3. LADTAP 
and GASPAR files created in NRCDose (version 2.3.20 or earlier) are not compatible with 
NRCDose3. However, XOQDOQ files created in NRCDose (version 2.3.20 or earlier) are 
compatible with NRCDose3. Existing NRCDose code installations are not affected by the 
installation of NRCDose3, so both NRCDose and NRCDose3 may be installed and used on the 
same computer. 

2.2.1 Installation Process 

(1) Download and save the NRCDose3 installation file, NRCDose3_v114_Setup.exe, from 
the RAMP website (https://ramp.nrc-gateway.gov/). To begin installation, double-click 
(open) the NRCDose3_v114_Setup.exe file, which will start the installation process, and 
open the Welcome screen shown in Figure 2-1. Select the “Next” button to continue with 
installation. 

  

https://ramp.nrc-gateway.gov/
https://ramp.nrc-gateway.gov/
https://ramp.nrc-gateway.gov/
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Figure 2-1 Installation Welcome Screen 

(2) The installer will then allow the user to specify a destination folder for the installation of 
the NRCDose3 program, as shown in Figure 2-2. By default, the code will install on the 
root directory (i.e., C:/NRCDose3); however, a user-defined directory can be designated. 
The installer will create the installation directory if needed or will use the default 
directory. It will also display the computer hard drive space needed for NRCDose3 and 
the available space on the drive selected for installation (e.g., C:/). Select the “Next” 
button to continue with installation. 

 

Figure 2-2 Installation Folder Screen 
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(3) The installer will then ask the user to select the location of the folder where the 
NRCDose3 shortcut icons will be created and installed, as shown in Figure 2-3. The 
installer defaults to the installation directory (i.e., C:/NRCDose3); the user may select a 
different directory using the drop-down menu arrow next to the file directory name. 
Additionally, the user can select whether to make the NRCDose3 icon available to either 
the current user or all users. The default option is to make the shortcut icon available to 
all users. Select the “Next” button to continue with installation. 

 

Figure 2-3 Shortcut Folder Screen 

(4) The installer now has enough information to install the code and will display the settings 
used for installation as shown in Figure 2-4. Select the “Next” button to continue with 
installation. The user should see the installation progress screen shown in Figure 2-5. To 
terminate the installation of NRCDose3 at this point, select the “Cancel” button shown in 
Figure 2-5. 
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Figure 2-4 Installation Confirmation Screen 

 

Figure 2-5 Installation Progress Screen 

(5) When the installer has completed installing NRCDose3, the Installation Completion 
screen shown in Figure 2-6 will appear. Select the “Finish” button to exit the installer. 
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Figure 2-6 Installation Completion Screen 

(6) The NRCDose3 shortcut icon will appear on the Windows operating system desktop as
shown in Figure 2-7. Double-click on the NRCDose3 shortcut icon to open the program
and display the NRCDose3 main selection screen shown in Figure 2-8.

Figure 2-7 NRCDose3 Shortcut Icon 

(7) As shown in Figure 2-8, the NRCDose3 main selection screen shows the LADTAP,
GASPAR, and XOQDOQ modules. The toolbar at the top of the screen contains three
tool/menu options:

• Quit—Select this tool to exit NRCDose3.

• About—Select this tool to open the About NRCDose3 screen as shown in Figure 2-9.
This displays information about the version of NRCDose3. Select the “OK” button to
return to the NRCDose3 main selection screen shown in Figure 2-8.

• Manuals—Select this tool to open a drop-down menu, shown in Figure 2-10, that lists
the following technical references included with NRCDose3:

- NRCDose3 Quick Start Guide
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- NRCDose3 user’s manual: Draft NUREG-XXXX, “NRCDose3 Code Version
1.1.4: User Guide and Technical Manual”

- GASPAR II manual: NUREG/CR-4653

- LADTAP II manual: NUREG/CR-4013

- XOQDOQ manual: NUREG/CR-2919

Figure 2-8 NRCDose3 Main Selection Screen 
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Figure 2-9 About NRCDose3 Screen 

Figure 2-10 Manuals Tool Drop-down Menu 
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2.2.2 Code Support 

Any questions, suggestions, corrections, or comments concerning the NRCDose3 code or its 
documentation should be submitted through the NRCDose3 support link on the RAMP website 
(https://ramp.nrc-gateway.gov/codes/nrcdose/request-support). 

2.2.3 Code Error and Problem Reporting 

While extensive testing has been performed and effort directed toward minimizing 
(noncomputational) errors in NRCDose3, unanticipated circumstances may lead to errors and 
problems (bugs). To report an error or bug in the program, first collect as much information as 
possible about it, including answers to the following questions: 

• On what computer operating system is NRCDose3 being executed? 

• Is the error or bug reproducible? 

• What are the steps leading up to the problem? 

• What are the exact symptoms (e.g., program crash, error message)? 

To report a problem, send a ZIP file containing the case files and answers to the above 
questions through the NRCDose3 Forum webpage using the NRCDose3 support link on the 
NRC RAMP website (https://ramp.nrc-gateway.gov/codes/nrcdose/request-support). 

 

https://ramp.nrc-gateway.gov/codes/nrcdose/request-support
https://ramp.nrc-gateway.gov/codes/nrcdose/request-support
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3.0 LADTAP 
The LADTAP module within NRCDose3 executes a modified version of the LADTAP II Fortran 
code. This update to the NRCDose code has not changed the basic calculation methods 
(algorithms) of LADTAP II, as described in NUREG/CR-4013, except as needed to 
accommodate the use of different DCFs with different age groups. However, significant changes 
have been made to the data management and operation to support the expanded capabilities of 
NRCDose3. LADTAP II performs environmental dose assessments for releases of liquid 
radioactive effluents from nuclear power plants in surface waters, implementing the dose 
assessment methods described in RG 1.109. LADTAP II calculates the radiation dose to 
individuals, population groups, and biota from ingestion of aquatic foods, water, and terrestrial 
irrigated foods. Additionally, LADTAP II calculates external exposures from boating, swimming, 
and shoreline recreational activities. The calculated doses provide information for NEPA 
evaluations and for determining compliance with the NRC public dose limits in 10 CFR Part 20, 
“Standards for Protection Against Radiation” [Ref. 20], the EPA public dose limits in 
40 CFR Part 190, “Environmental Protection Standards for Nuclear Power Operations” [Ref. 21], 
and the NRC ALARA design objectives and numerical guides in 10 CFR Part 50, Appendix I. 

The following sections discuss the steps for setting up and conducting LADTAP dose 
calculations using NRCDose3. The user is directed to NUREG/CR-4013 for the LADTAP II 
Fortran code user guide and for technical bases and detailed discussion of the assumptions, 
limitations, and methods of the LADTAP dose calculations. 

To open the LADTAP module, select the “LADTAP Liquid Pathway Dose Assessment” button 
on the NRCDose3 main selection screen, shown in Figure 3-1. This will open the LADTAP 
module main screen, shown in Figure 3-2. 
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Figure 3-1 NRCDose3 Main Selection Screen (LADTAP Module) 
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Figure 3-2 LADTAP Module Main Screen 

The LADTAP module main screen opens with the case data last saved in the database. On 
initial install, the program loads with an example test case. There are three main functional 
areas for entering data and performing LADTAP dose calculations: (1) the toolbar and initial 
setup area, (2) the data input tabs, and (3) code execution and reports. The following sections 
discuss these areas and describe the options and capabilities in each. 

3.1 Toolbar and Initial Setup 

This portion of the LADTAP module main screen contains three tools and three initial setup 
input fields, as shown in Figure 3-2. The three tools are File, Quit, and About. The initial setup 
fields are Scenario, Source Term, and Dose Factors (drop-down menu). 

3.1.1 File Tool 

The File tool provides the functionality for managing the LADTAP files, as shown in Figure 3-3. 
The File drop-down menu offers the following options: 
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• New—Select this option to begin a new LADTAP case. This will clear any previously 
entered information from the database. 

• Open LN3 File—Select this option to access and open a *.LN3 file previously created 
with NRCDose3. 

• Save to Database—Select this option to save the current case to the database. 
When LADTAP starts, the data that were last saved (typically from the previous run) 
are loaded, populating all LADTAP screens and windows. 

• Save to LN3 File—Select this option to save the completed case to a *.LN3 file, for 
later use or for sharing with others. 

• Delete—Select this option to open an Explorer window that will allow the user to 
delete any previously saved *.LN3 files. 

** User Note **—NRCDose3 uses the *.LN3 file type and format for LADTAP files. Files in other 
formats (for example, *.LNP files generated by LADTAP under NRCDose (version 2.3.20 or 
earlier)) are not compatible with NRCDose3. 

 

Figure 3-3 LADTAP Toolbar with File Drop-down Menu 
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3.1.2 Quit Tool 

The Quit tool allows the user to terminate the operation of the LADTAP module. When the Quit 
tool is selected, the Question prompt screen (shown in Figure 3-4) will be displayed to verify that 
the user wants to exit the module. Select the “Yes” button to terminate the LADTAP module 
without saving any changes to the data not previously saved. To save changes (to the database 
and/or a *.LN3 file) before quitting, select the “No” button, then choose the appropriate entry 
from the File drop-down menu. 

Figure 3-4 LADTAP Module Quit Tool Screen

 
3.1.3 About Tool 

Selecting the About tool brings up the About LADTAP screen shown in Figure 3-5, which 
displays information about LADTAP II. Select the “OK” button to return to the LADTAP module 
main screen shown in Figure 3-2. 

Figure 3-5 About LADTAP Screen 
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3.1.4 Scenario Field 

In the Scenario field, enter a title for the LADTAP case. This is a descriptive text field only; the 
data in this field are not used for any LADTAP dose calculations. The title should help users 
identify the facility/site and release point (e.g., “Facility XYZ and Miscellaneous Waste 
Discharge”). As shown in Figure 3-2, the initial test case included in the NRCDose3 installation 
(which is loaded when the LADTAP module is first opened) is entitled “NUREG/CR-4013 
Sample Problem 1—ICRP-2.” When opened subsequently, LADTAP will show the last saved 
case scenario. 

3.1.5 Source Term Field 

In the Source Term field, enter a name for the source term. This is a descriptive text field only; 
the data in this field are not used for any LADTAP dose calculations. As shown in Figure 3-2, 
the name of the source term in the initial test case, “NUREG/CR-4013 Sample Problem 1—
ICRP-2,” is “Test #1.” 

3.1.6 Dose Factors Drop-Down Menu 

The Dose Factors drop-down menu, shown in Figure 3-6, allows the user to select the DCF 
values to be used for the LADTAP dose calculations. The options available are “ICRP-2 
(Default),” “ICRP-30,” and “ICRP-72.” Note that if the DCF values are changed, then the 
assumed source term (if any has been entered) will be cleared, and the assumed usage and 
consumption factors will be updated to the values associated with the selected ICRP 
methodology. The installation includes test cases using the ICRP-30 and ICRP-72 DCFs; apart 
from the DCFs, these test cases have the same data as the “NUREG/CR-4013 Sample 
Problem 1—ICRP-2” test case. 

** User Note **—For the purposes of demonstrating compliance with 10 CFR Part 50, 
Appendix I, and 40 CFR Part 190, the ICRP-2 DCF values should be selected. For 
demonstrating compliance with 10 CFR Part 20, the ICRP-30 DCF values should be selected. 
An applicant or licensee preparing an NRC LAR should discuss the use of ICRP-72 DCF values 
with the NRC staff before submitting the request. 
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Figure 3-6 LADTAP Dose Factors Drop-down Menu 

3.2 Data Input Tabs 

The six LADTAP data input tabs, shown in Figure 3-2, are as follows: 

(1) Selections 
(2) ALARA Locations 
(3) Fish/Population/Biota 
(4) Irrigation Food Data 
(5) Dose Factors 
(6) Pathway Factors 

It is recommended, though not required, that the user enter the necessary case parameters and 
data into the data input tabs in the order in which they are listed. 

3.2.1 Selections Tab 

The Selections tab is used to enter the basic parameters for the LADTAP dose calculations. The 
Selections tab includes several input fields, selection radio buttons, and three data-specific input 
sections, as shown in Figure 3-7. Refer to NUREG/CR-4013 for more information on the inputs 
in this tab. 
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Figure 3-7 Selections Tab 

 Input Fields and Radio Buttons 

3.2.1.1.1 Discharge Flow Rate 

This field is used to enter the liquid effluent discharge flow rate, in cubic feet per second (cfs). 
The value from the initial test case, “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is 
3150 cfs. The allowable range for values in this field is greater than 0 cfs. 

3.2.1.1.2 Source Term Multiplier 

This field is used to enter, if desired, a multiplier to the source term entered on the Selections 
tab. The allowable range for values in this field is 1 or greater, and the default value is 1. 
Typically, the multiplier will remain at 1, but it can be adjusted to account for multiunit sites if the 
entered source term is on a per-unit basis. 

3.2.1.1.3 50 mi Population 

This field is used to enter the total human population within 50 miles of the site, as specified in 
10 CFR Part 50, Appendix I. The value from the initial test case, “NUREG/CR-4013 Sample 
Problem 1—ICRP-2,” is 2200000. The allowable range for values in this field is greater than 0. 

3.2.1.1.4 Print Dose Factors 
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The user should select this check box if DCF values are to be listed and printed in the LADTAP 
output file. The default value for this box is unchecked. 

3.2.1.1.5 Site Type 

Here the user should select either “Fresh water” or “Salt water” as appropriate for the site. This 
selection controls the bioaccumulation factors to be used, as different sets exist for freshwater 
and saltwater species, as well as certain consumption values (e.g., saltwater invertebrate). The 
value from the initial test case, “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is “Fresh 
water,” which is also the default selection in a new case/file. 

3.2.1.1.6 Dose Contributions 

This setting determines whether the dose contribution per radionuclide, in percent, is printed in 
the LADTAP output file. The value from the initial test case, “NUREG/CR-4013 Sample Problem 
1—ICRP-2,” is “No,” which is also the default selection in a new case/file. 

 Population Fractions  

As shown in Figure 3-7, this section gives the option of modifying the population age group 
fractions, with the default value setting of “No.” Table 3-1 shows the default population fractions. 
These values are from Section 2.1.1 of NUREG/CR-4013 and represent U.S. averages at the 
time of development of RG 1.109. 

Table 3-1 LADTAP Age Group Population Fractions 

Population Age Group Age Range 
(years) 

Default Age Group 
Fractions 
(percent) 

ICRP-30 Age Group 
Fractions 
(percent) 

Children 0–11 18 0 

Teens 11–17 11 0 

Adults 17 and older 71 100 

To change or adjust these default values, select the “Yes” button, then the “Edit” button when it 
becomes active (not grayed out). This will open the Population Fractions screen shown in 
Figure 3-8, where the age group fraction of the total population can be adjusted. Provide a 
justification when any default NRCDose3 parameter is modified. As noted in Table 3-1, if the 
LADTAP dose calculation to be performed is using the ICRP-30 DCF values, the age group 
fractions are automatically set to 1.00 for adults and 0 for teens and children. This is because 
ICRP-30 contains DCF values only for the adult age range; therefore, only adult doses are 
calculated. 
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Figure 3-8 Population Fractions Screen 

 Reconcentration 

This section of the Selections tab provides information on the reconcentration factor (R-factor) in 
the LADTAP dose calculation, as shown in Figure 3-7. The R-factor is used to account for any 
recirculation that may occur in the receiving water body, which could increase the environmental 
concentrations above that calculated directly from the effluent activity and the discharge flow 
rate. As shown in Figure 3-9, one of four impoundments or reconcentration models can be 
selected: 

(1) None—This model assumes no additional decay or dilution of the liquid effluents 
before they reach the main receiving water body. The discharge point radioactivity 
concentration is determined simply by the activity release rate and the discharge 
flow rate. 

(2) Completely Mixed—This model estimates the effluent reconcentration at the 
midpoint of the plant life and assumes complete mixing within a closed 
impoundment volume. This model assumes negligible radioactivity loss due to 
leakage or evaporation. 

(3) Plug Flow—This model assumes that radioactive effluents are released to an 
impoundment system (pond), where they are naturally diluted and delayed (and 
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therefore decay) before they are released to the main receiving water body. The 
degree of dilution and decay is proportional to the relative size of the impoundment 
system. This model assumes no radioactivity loss due to leakage or evaporation. 
When this model is selected, the blowdown rate and the reactor effluent discharge 
rate (entered at the top of the Selections tab) are compared. If the blowdown rate is 
less than 99 percent of the effluent discharge rate, an error message is printed. 
However, the run is not stopped, and the values given are used. 

(4) Partially-Mixed—This model is derived from a mass balance for steady-state 
conditions described in RG 1.113. It assumes no radioactivity loss due to leakage 
or evaporation. 

Impoundment systems delay release to the main receiving water body, allowing additional 
dilution or time for radiological decay. The option selected in “NUREG/CR-4013 Sample 
Problem 1—ICRP-2” for this setting is “Partially-Mixed.” The calculated R-factor is site and 
radionuclide specific. Section 3.3.3 of NUREG/CR-4013 describes each of these models in 
detail. 

 

Figure 3-9 R-Factor Model Options 

All the impoundment or reconcentration models except for the “None” option require the user to 
input two additional parameters, as shown in Figure 3-7: 
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• Effluent discharge rate from impoundment system to the receiving water body, in cfs. 
The value from the initial test case, “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is 
200 cfs, and the allowable range for values in this field is greater than 0 cfs. 

• Impoundment total volume, in cubic feet (ft3). The value from the initial test case, 
“NUREG/CR-4013 Sample Problem 1—ICRP-2,” is 50000 ft3, and the allowable range 
for values in this field is greater than 0 ft3. 

 Source Term 

As shown in Figure 3-7, the final section on the Selections tab is the Source Term section, 
where the user can enter the annual released activity in curies (Ci) and the R-factor (if desired) 
for each radionuclide. The R-factor, as entered here, would be a value derived using a 
site-specific model, which can be manually entered for each radionuclide. Enter the R-factors 
only if the reconcentration model option of “None” has been selected in the Reconcentration 
section (see Section 3.2.1.3). Selecting any other reconcentration model (“Completely Mixed,” 
“Plug Flow,” or “Partially-Mixed”) will override any manually entered R-factors. 

 

Figure 3-10 DCF Warning Message 

More radionuclides can be added to the bottom of the list by selecting the “Add Nuclide” button, 
which will flash the DCF warning message shown in Figure 3-10, and then open the Select 
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Nuclide screen, shown in Figure 3-11. Select the radionuclide to be added, and then click the 
“Add” button as shown in Figure 3-11 to add the radionuclide to the source term. By holding 
down the “Ctrl” key during radionuclide selection, the user can select multiple radionuclides. 

** User Note **—Before adding any radionuclides, the user should verify that the proper ICRP 
methodology is chosen so that the code selects the correct forms of the radionuclides. 

The user can remove radionuclides from the Source Term section by selecting (highlighting) the 
radionuclide to be removed and then clicking the “Delete Nuclide” button. Selecting the “Clear” 
button clears all source term data (nuclide, quantity, and R-factor) for all radionuclides in the 
Source Term section of the Selections tab. 

 

Figure 3-11 Select Nuclide Screens 

** User Note **—The input data should be periodically saved using the “Save” button at the 
bottom of the LADTAP module main screen (Figure 3-2). This will save the data to the 
database, under the file name designated by the user. Saved values (and the saved file) will 
then be available should the program be inadvertently terminated or otherwise quit. Remember 
that upon initial opening of the LADTAP module (or the GASPAR or XOQDOQ module), the 
data loaded are those last saved to the database. In this situation, the loaded data are not 
linked to any file name; they should be saved to an existing or new file as appropriate. To 
ensure that the data are those desired, the user should open the file corresponding to the case 
desired, edit the data for an existing case and save them under a different file name, or create a 
new file name. 
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3.2.2 ALARA Locations Tab 

The ALARA Locations tab is used to enter the parameters for the maximum exposed individual 
in the LADTAP dose calculation. As shown in Figure 3-12, the ALARA Locations tab contains 
two sections: (1) the ALARA—Max. Individual section and (2) the Additional Usage Locations 
section. The ALARA—Additional Location section is used to enter the exposure assumptions for 
any additional usage locations. 

 ALARA—Max. Individual 

The ALARA—Max. Individual section is divided into four data input sections: (1) “Shore-width 
factor,” (2) “Dilution Factor,” (3) “Transit Time,” and (4) “Change default usage and consumption 
data.” 

 

Figure 3-12 ALARA Locations Tab 

3.2.2.1.1 Shore-Width Factor 

The shore-width factor represents a fraction of the dose from an infinite plane source that would 
be received from the shoreline geometry at the location of interest. Here the user should select 
the location that will be used to determine the shore-width factor. Table 3-2 shows the exposure 
situations and the assumed shore-width factors from RG 1.109.  
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Table 3-2 Shore-Width Factors 

Exposure Situation Shore-Width Factor 

Discharge Canal Bank 0.1 

River Shoreline 0.2 

Lake Shore 0.3 

Nominal Ocean Site 0.5 

Tidal Basin 1.0 

3.2.2.1.2 Dilution Factor 

The dilution factor represents the amount of dilution expected from the discharge point to the 
receiving water body and the usage location for the pathway. In practice, the concentration at 
the point of exposure is determined by dividing the radionuclide concentration (as calculated 
from the source term (activity released), the discharge flow rate, and any R-factor) by the 
dilution factor. There are three dilution factor pathway types: (1) aquatic food and boating, 
(2) shoreline and swimming, and (3) drinking water. A known value may be entered manually, or 
a value may be calculated using the characteristics of the receiving water body. For each 
pathway type, select the “Calc” button to open the Dilution Factor Calculation screen shown in 
Figure 3-13. Section 3.1 of NUREG/CR-4013 provides more information on calculating dilution 
factors based on applicable parameters and a hydrological surface water model. 

 

Figure 3-13 Dilution Factor Calculation Screen 
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To calculate a dilution factor using the screen shown in Figure 3-13, the user must input the 
following parameters: 

• Surface Water Model—Select the appropriate hydrological model by clicking on either 
“River” or “Lake.” 

• Surface Water Velocity—Enter the surface water velocity in feet per second (ft/s). The 
allowable range for values in this field is greater than 0 ft/s. 

• Surface Water Depth—Enter the surface water depth in feet. The allowable range for 
values in this field is greater than 0 feet. 

• Downstream Distance—Enter the downstream distance in feet. The allowable range for 
values in this field is greater than 0 feet. 

• Offshore Distance—Enter the offshore distance in feet. The allowable range for values in 
this field is greater than 0 feet. 

• River Width / Lake Discharge Depth—Enter either the river width or the lake discharge 
depth (depending on the model selected) in feet. The allowable range for values in this 
field is greater than 0 feet. 

The dilution factor is calculated from the values entered for the receiving water body 
characteristics (flow, depth, and downstream distance) in the selected hydrological model. 

** User Note **—If the discharge flow rate is large compared to the parameter values entered 
for the receiving water body characteristics, LADTAP could return a dilution factor less than 1, 
which indicates that the defined parameters are not compatible with the selected model. If this 
occurs, dose calculations will not be correct. The LADTAP output will issue the following error 
message, at which point the program will terminate: 

WARNING: PARAMETER VALUES INPUTTED FOR THE DILUTION CALCULATION 
ARE INCOMPATIBLE WITH THE MODEL. TERMINATING PROGRAM 

3.2.2.1.3 Transit Time 

This section is used to enter the transit time, in hours (hr), from the discharge point of the 
receiving water body to the usage location. As shown in Figure 3-12, a separate transit time can 
be entered for the drinking water pathway, while all other pathways have the same transit time. 
The value from the initial test case, “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is 3.0 for 
the drinking water pathway and 0.1 for the other pathways. The allowable range for values in 
this field is greater than 0 hours. 

3.2.2.1.4 Change Default Usage and Consumption Data 

This section allows the user to change the default usage and consumption data for the 
maximum exposed individual. The default data are taken from RG 1.109, Revision 1, for the 
ICRP-2 (default) and ICRP-30 DCF values, and from the EPA’s EFH for the ICRP-72 DCF 
values. To change the usage and consumption data, select the “Yes” radio button and the “Edit” 
button shown in Figure 3-12 to open the Max Individual Consumption screen shown in 
Figure 3-14. 
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Figure 3-14 Max Individual Consumption Screen 

Using the drop-down menu, select the appropriate age group from RG 1.109, and enter the 
applicable rates of consumption of fish, invertebrates, aquatic plants, and drinking water, in 
kilograms per year (kg/yr), for the assumed maximum individual. Also, enter the assumed 
usage/exposure time (hr/yr) for shoreline, swimming, and boating recreational activities. When 
edits are complete, select the “Save” button to save the revised usage and consumption data. 
While progressing through the different age groups, save the data for each age group 
separately. Select “Defaults” to restore the default usage and consumption data from RG 1.109. 

 Additional Usage Locations 

The Additional Usage Locations section allows the user to enter additional locations for the 
LADTAP dose calculation. The initial test case, “NUREG/CR-4013 Sample Problem 1—
ICRP-2,” includes information for two additional usage locations (“At outfall” and “Downstream”). 
To add a usage location, select the “Add” button to activate the ALARA—Additional Location 
section, as shown in Figure 3-15. To remove a usage location, select (highlight) the location to 
be removed, and click the “Remove” button. 
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Figure 3-15 ALARA—Additional Location Section, Activated 

 ALARA—Additional Location 

After activating the ALARA—Additional Location section (see Section 3.2.2.2), the user can 
enter the information required for each additional usage location: namely, the location, the 
pathway dilution factor, the transit time, and the shore-width factor (as discussed in 
Section 3.2.2.1). For each additional usage location, only a single dilution factor and transit time 
can be entered. Location-specific usage and consumption data can be entered by selecting the 
“Yes” radio button and then the “Edit” button shown in Figure 3-15 to open the Max Individual 
Consumption screen shown in Figure 3-14. 
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Figure 3-16 Add. Locations Usage/Consumption Screen 

Enter the required usage and consumption data following the instructions in Section 3.2.2.1.4 
and select the “Save” button when edits are complete to save the revised data. Save the data 
for each age group separately. 

3.2.3 Fish/Population/Biota Tab 

The Fish/Population/Biota tab is used to enter the parameters for the annual aquatic animal 
harvest and consumption, as well as the total population drinking water consumption and 
recreation time. As shown in Figure 3-17, the Fish/Population/Biota tab contains three sections: 
(1) the Fish Usage section, (2) the Population Usage section, and (3) the Biota Locations 
section. Figure 3-17 also displays the four drop-down menu options for the Fish Usage section 
(sport or commercial fishing and sport or commercial invertebrate harvest) and the four 
drop-down menu options for the Population Usage section (drinking water, shoreline, swimming, 
and boating). 
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Figure 3-17 Fish/Population/Biota Tab 

 Fish Usage 

This section is for data on the total fish and invertebrate harvests at user-designated locations. 
Select the usage type from the four options shown in Figure 3-17: 

• Sport Fishing 

• Commercial Fishing 

• Sport Invertebrate Harvest 

• Commercial Invertebrate Harvest 

After selecting an option, the user can add or edit locations, then enter the annual harvest 
(catch), dilution, and transit time for each location, as shown in Figure 3-18. To define a new 
location for fishing or invertebrate harvesting, select the “Add” button, which will activate the 
location area at the bottom of the Fish Usage section. For each location, enter the name of the 
location, the amount of the annual harvest (in kg/yr), a dilution factor (unitless), and the transit 
time (in hours). (The values used in “NUREG/CR-4013 Sample Problem 1—ICRP-2” are “Fish 
Downstream,” 70000 kg/yr, 4, and 1 hr, respectively.) If necessary, select the “Calc” button to 
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open the Dilution Factor Calculation screen shown in Figure 3-13, and enter the parameters 
required for the code to calculate a dilution factor, as discussed in Section 3.2.2.1.2 above. 

 

Figure 3-18 Fish Usage Section of the Fish/Population/Biota Tab 

After entering the required input parameters for the location, select the “Save” button to add the 
location to the LADTAP dose calculation input file. To remove a location, select (highlight) the 
location from the “records” (upper) portion of the Fish Usage section, and select the “Remove” 
button. 

 Population Usage 

In this section, the user can enter data on the total drinking water usage and recreation 
(shoreline, swimming, and boating) times at user-designated locations. Select the desired 
population usage pathway from the four options shown in Figure 3-17: 

• Drinking Water 

• Shoreline 

• Swimming 
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• Boating

Then enter the input parameters for the selected pathway, as shown in Figure 3-19. To define a 
new population usage location, select the “Add” button to activate the location area at the 
bottom of the Population Usage section. 

Figure 3-19 Population Usage Section of the Fish/Population/Biota Tab 

The input required for each location depends on the usage option chosen from the drop-down 
menu: 

• When the “Drinking Water” option is selected, enter the name of the drinking water
location, the total population, the dilution factor (unitless), and the transit time (in hours).
(The values from “NUREG/CR-4013 Sample Problem 1—ICRP-2” are “Water at 16 mi
downstream,” 2200000, 4, and 1 hr, respectively.) The default average individual
consumption rates and population age-group distribution will be used for the dose
calculation. Alternatively, enter the supply rate and average individual usage rate in
gallons per day. The code will then calculate the exposed population. If necessary,
select the “Calc” button to open the Dilution Factor Calculation screen shown in
Figure 3-13, and enter the parameters required for the code to calculate a dilution factor,
as discussed in Section 3.2.2.1.2 above.
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• When the “Shoreline” option is selected, enter the name of the shoreline location, the 
annual usage in person-hours per year (person-hr/yr), the dilution factor (unitless), the 
transit time (in hours), and the shore-width factor. (The values from “NUREG/CR-4013 
Sample Problem 1—ICRP-2” are “Downstream Shore,” 83000 person-hr/yr, 4, and 1 hr, 
respectively.) Table 3-2 lists the shore-width factor drop-down menu options, which are 
described in Section 3.2.2.1.1. If necessary, select the “Calc” button to open the Dilution 
Factor Calculation screen shown in Figure 3-13, and enter the parameters required for 
the code to calculate a dilution factor, as discussed in Section 3.2.2.1.2 above. 

• When the “Swimming” option is selected, enter the name of the swimming location, the 
annual usage (in person-hr/yr), the dilution factor (unitless), and the transit time (in 
hours). (The values from “NUREG/CR-4013 Sample Problem 1—ICRP-2” are “Water at 
16 mi downstream,” 120000 person-hr/yr, 4, and 1 hr, respectively.) If necessary, select 
the “Calc” button to open the Dilution Factor Calculation screen shown in Figure 3-13, 
and enter the parameters required for the code to calculate a dilution factor, as 
discussed in Section 3.2.2.1.2 above. 

• When the “Boating” option is selected, enter the name of the boating location, the annual 
usage (in person-hr/yr), the dilution factor (unitless), and the transit time (in hours). (The 
values from “NUREG/CR-4013 Sample Problem 1—ICRP-2” are “Downstream 
boating,” 520000 person-hr/yr, 4, and 1 hr, respectively.) If necessary, select the “Calc” 
button to open the Dilution Factor Calculation screen shown in Figure 3-13, and enter 
the parameters required for the code to calculate a dilution factor, as discussed in 
Section 3.2.2.1.2 above. 

After entering the required input parameters for the location, select the “Save” button to add the 
location to the LADTAP dose calculation input file. To remove a location, select (highlight) the 
location from the “records” (upper) portion of the Population Usage section, and select the 
“Remove” button. 

 Biota Locations 

In this section, the user can identify and define biota exposure locations. To define a location, 
select the “Add” button to activate the “Location” area at the bottom of the section, as shown in 
Figure 3-20. For each location, enter the name of the location, the dilution factor (unitless), and 
the transit time (in hours). (The values from “NUREG/CR-4013 Sample Problem 1—ICRP-2” are 
“Fish at outfall,” 1, and 1 hr, respectively.) If necessary, select the “Calc” button to open the 
Dilution Factor Calculation screen shown in Figure 3-13, and enter the parameters required for 
the code to calculate a dilution factor, as discussed in Section 3.2.2.1.2 above. Section 3.2.5 of 
NUREG/CR-4013 provides additional information and explains the biota dose function in the 
LADTAP II Fortran code. 
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Figure 3-20 Biota Locations Section of the Fish/Population/Biota Tab 

The LADTAP code includes three primary aquatic species (fish, invertebrate, and algae) and 
four secondary terrestrial species (muskrat, raccoon, heron, and duck). As described below, 
more species can be added with user-defined exposure assumptions. NUREG/CR-4013, 
Section 3.2.5, provides details on the modeling and exposure assumptions for the three primary 
and four secondary species. The internal dose component to primary species is calculated 
considering the bioaccumulation factors for each radionuclide concentration, at the defined 
location and dilution, which determine an assimilated concentration in the biota mass. The dose 
to an individual organism is determined by multiplying this biota mass concentration by the 
nuclide-specific effective energy deposited in the individual, based on a defined effective radius. 
Tables 3-3 and 3-4 below summarize the modeling and exposure assumptions. 

The effective radius is used to model organisms as spheres, so that different dose absorption 
values can be applied for organisms of different sizes or masses. The effective radius is the 
radius of a sphere (considered muscle) that has the same mass as the organism in question, 
assuming the mass is uniformly distributed. Appendix D describes the modeling and 
calculations for the nuclide-specific deposited energy (dose) values based on effective radius. 
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Table 3-3 Default Values for Terrestrial Biota Exposure Parameters 

Terrestrial 
Biota 

Effective Body 
Radius (cm) 

Body Mass 
(g) 

Consumption 
of Food (g/d) Food Organism 

Muskrat 6 1,000 100 Aquatic plants 

Raccoon 14 1,200 200 Invertebrate 

Heron 11 4,600 600 Fish 

Duck 5 1,000 100 Aquatic plants 

Table 3-4 Biota Exposure Assumptions 

Biota Shoreline (Sediment) 
Exposure Time (h/yr) 

Swimming 
Exposure Time 

(h/yr) 

Fish 4,380 8,760 

Invertebrate 8,760 8,760 

Algae 0 8,760 

Muskrat 2,922 2,922 

Raccoon 2,191 0 

Heron 2,922 2,920 

Duck 4,383 4,383 

If a new biota type will be used, select the “Add Biota” button shown in Figure 3-20 to open the 
Additional Biota Types screen shown in Figure 3-21. Then select the “Add Biota Type” button, 
as shown in Figure 3-21, to activate the input parameter fields for the new biota. Enter the 
following input parameters: 

• Name—Enter the name of the biota to be added. 

• Food Type—Choose the food type for the new biota from the three options in the 
drop-down menu (“Algae,” “Fish,” and “Invertebrate”). 

• Mass—Enter the mass of the biota, in grams (g). The allowable range for values in this 
field is greater than 0 g. 

• Effective Radius—Enter the effective radius in centimeters (cm). The allowable range for 
values in this field is greater than 0 cm. 
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• Consumption Rate—Enter the consumption rate of the biota in grams per day (g/day). 
The allowable range for values in this field is greater than 0 g/day. 

• Shoreline Exposure—Enter the shoreline exposure from the biota in hours per year 
(hr/yr). The allowable range for values in this field is greater than 0 hr/yr. 

• Swimming Exposure—Enter the swimming exposure from the biota in hr/yr. The 
allowable range for values in this field is greater than 0 hr/yr. 

BNWL-1754, “Models and Computer Codes for Evaluating Environmental Radiation Doses,” 
issued February 1974 [Ref. 22], Section 6, describes the modeling used in LADTAP for the biota 
calculations. Table 6.1-1 in that report presents the exposure assumptions for the various 
primary and secondary biota. 

 

Figure 3-21 Additional Biota Types Screen 
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After entering the required input parameters for the new biota, select the “Save” button to add 
the biota type to the LADTAP dose calculation input file. To remove a biota type, select 
(highlight) it in the upper portion of the Additional Biota Types screen, as shown in Figure 3-21, 
and select the “Delete Biota Type” button. Select the “Close” button to return to the Biota 
Locations section of the Fish/Population/Biota tab. 

3.2.4 Irrigation Food Data Tab 

The Irrigation Food Data tab is used to enter the parameters for calculating human exposure 
from consumption of vegetables, leafy vegetables, milk, and meat that have been irrigated with 
water contaminated with radioactive effluents. As shown in Figure 3-22, the Irrigation Food Data 
tab contains two main data input sections: (1) Irrigated Food Pathways, and (2) Water Usage 
Locations. Additional data for these sections can be entered in the Irrigated Food Data and 
Water Usage Data subsections. 

** User Note **—For every irrigated food pathway defined in the Irrigation Food Data tab, at 
least one water usage location must be defined on this tab as well. 

 

Figure 3-22 Irrigation Food Data Tab 
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 Irrigated Food Pathways 

This section is for adding or removing data on irrigated food pathways for the LADTAP dose 
calculations. To add an irrigated food pathway, select the “Add” button; this will open the 
information screen and user note shown in Figure 3-23. Select the “OK” button to activate the 
Irrigated Food Data subsection, as shown in Figure 3-24 and as discussed in Section 3.2.4.1.1 
below. To remove an irrigated food pathway, select (highlight) it, and select the “Remove” 
button. The Irrigated Food Pathways section also displays the total number of irrigated food 
pathway records entered. 

 

Figure 3-23 Irrigation Food Data Note Screen 

3.2.4.1.1 Irrigated Food Data 

Once the Irrigated Food Data subsection is activated, as shown in Figure 3-24, enter the 
following input parameters for the new irrigated food type: 

• Food Type—Choose the irrigated food type from the four options in the drop-down menu 
(“Vegetables,” “Leafy Vegetables,” “Milk,” and “Meat”). 
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• Irrigation Rate—Enter the irrigation rate for the food type, in liters per square meter per 
month (L/m2/mon). The allowable range for values in this field is greater than 
0 L/m2/mon. 

• Total Production Rate—Enter the production rate for the irrigated food type within a 
50-mile radius, in either kg/yr or liters per year (L/yr). The allowable range for values in 
this field is greater than 0 kg/yr or 0 L/yr. 

 

Figure 3-24 Irrigated Food Data Subsection 

• Noncontaminated Irrigation Water—These fields are used only for the milk and meat 
options. They show the fraction of the amount of noncontaminated irrigation water used 
for livestock feed production. Both fields are unitless, and the allowable range for values 
in each field is greater than 0.00. 

• Growing Period—Enter the length of the growing period for the selected food type, in 
days. The allowable range for values in this field is greater than 0.00 days. The default 
values from RG 1.109 are 30 days for milk and meat (reflecting pasture grass) and 
60 days for vegetables and leafy vegetables. 

• Crop Yield—Enter the crop yield for the selected food type, in kilograms per square 
meter (kg/m2). The allowable range for values in this field is greater than 0.00 kg/m2. The 
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default values from RG 1.109 are 0.7 kg/m2 for milk and meat (reflecting pasture grass) 
and 2.0 kg/m2 for vegetables and leafy vegetables. 

To reflect site-specific information, the user can change the individual consumption rates either 
under the Pathway Factors tab, discussed in Section 3.2.6, or by selecting the “Yes” button and 
the “Edit” button in the “Change default usage and consumption data” area in Figure 3-24. This 
will open the Usage/Consumption screen shown in Figure 3-25. Enter the required usage and 
consumption information following the instructions in Section 3.2.2.1.4 and select the “Save” 
button when edits are complete to save the revised data. 

 

Figure 3-25 Usage/Consumption Screen 

After entering the required data for each new irrigated food pathway, select the “Save” button to 
add to the pathway to the LADTAP dose calculation input file. Selecting either the “Save” or 
“Cancel” button in the Irrigated Food Data subsection (Figure 3-24) will activate the “Usage 
Locations” button and allow the user to reopen the Water Usage Locations section of the 
Irrigation Food Data tab, which is described in Section 3.2.4.2. 
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 Water Usage Locations 

In the Water Usage Locations section, shown in Figure 3-26, the user can define the water 
usage location for each irrigated food pathway. To add a location, select the “Add” button, which 
will activate the Water Usage Data subsection, as shown in Figure 3-26 and as discussed in 
Section 3.2.4.2.1. To remove a water usage location, select (highlight) the location and select 
the “Remove” button. The Water Usage Locations section also displays the total number of 
water usage location records entered. 

 

Figure 3-26 Water Usage Data Subsection 

3.2.4.2.1 Water Usage Data 

Once the Water Usage Data subsection is activated, as shown in Figure 3-26, enter a location 
name, dilution factor, production rate, and transit time for each irrigated food pathway type. The 
dilution factor can be calculated as discussed in Section 3.2.2.1.2. (As previously noted, at least 
one water usage location must be entered for every irrigated food pathway defined; the same 
water usage location may be used for several irrigated food pathways.) Select “Save” to add the 
location to the LADTAP case. 

** User Note **—If multiple water usage locations are listed for a single irrigated food pathway, 
the LADTAP FSAR Input Report will include only the location with the highest dose. 
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3.2.5 Dose Factors Tab 

The Dose Factors tab, shown in Figure 3-27, is used to view the DCF values selected for the 
LADTAP dose calculation. The factors displayed will be those for the ICRP dose factor 
methodology (i.e., ICRP-2 (default), ICRP-30, or ICRP-72) selected from the Dose Factors 
drop-down menu. To display the DCF values, select the applicable age group and intake 
pathway (i.e., adult ingestion or inhalation, teen ingestion or inhalation, child ingestion or 
inhalation, or infant ingestion or inhalation). 

 

Figure 3-27 Dose Factors Tab with DCF Methodology and Age/Pathway Options 

As mentioned above, the Dose Factors drop-down menu provides three DCF sets: 

(1) ICRP-2 (Default)—This option provides the default radionuclides and DCF values 
used by NRCDose3, following the precedent set by the NRC release of LADTAP II 
and GASPAR II. These DCF values are based on the ICRP-2 methodology, which 
is the current basis of the NRC regulations in 10 CFR Part 50, Appendix I, and of 
the EPA regulations in 40 CFR Part 190. ICRP-2 DCF values are included for four 
age groups (Infant, Child, Teen, and Adult) and seven organs (Bone, Liver, Total 
Body, Thyroid, Kidney, Lung, and Gastrointestinal-Lower Large Intestine (GI-LLI)). 
Appendix A to this manual lists the 203 radionuclides covered by the ICRP-2 
methodology, as well as the relevant technical references. 
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(2) ICRP-30—This option provides occupational DCF values for ingestion and 
inhalation based on the ICRP-30 methodology, which is the current basis of the 
NRC regulations in 10 CFR Part 20. The ICRP-30 methodology includes DCF 
values for 24 organs, for adults only (since the values apply only to occupational 
exposures). The available radionuclides are the same as the 203 radionuclides 
listed in appendix A and available for the ICRP-2 option. Section 6.1 discusses in 
detail the selection of the radionuclide inhalation class (i.e., D/M/Y). 

(3) ICRP-72—This option provides DCF values based on the methodology in ICRP 
Publication 60, “1990 Recommendations of the International Commission on 
Radiological Protection” (ICRP-60), issued 1991 [Ref. 33]. DCF values are 
included for inhalation and ingestion pathways, for six age groups (Newborn, 1 yr, 
5 yr, 10 yr, 15 yr, and Adult) and 27 organs (including Remainder and Effective). 
The 203 radionuclides listed in appendix A for the ICRP-2 and ICRP-30 options are 
also available for the ICRP-72 option. Section 6.1 discusses in detail the selection 
of the radionuclide inhalation class (i.e., F/M/S). 

** User Note **—An applicant or licensee preparing an NRC LAR should discuss the use of 
ICRP-72 DCF values with the NRC staff before submitting the request. 

After selecting the appropriate ICRP methodology and dose factors from their respective 
drop-down menus, the user can review all applicable organ DCF values, as shown in 
Figure 3-28. Select the “Nuclide Data” button to open the Nuclide Data screen shown in 
Figure 3-29 and view applicable nuclide data, such as atomic weight, isomeric state, decay 
constant, and external dose factors. Select the “Exit” button to return to the Dose Factors tab. 
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Figure 3-28 Dose Factors Tab with ICRP-2 DCF Values for Review 
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Figure 3-29 Nuclide Data Screen 

3.2.6 Pathway Factors Tab 

The Pathway Factors tab is used to view and edit the remaining parameters needed to complete 
the liquid pathway LADTAP dose calculation. As shown in Figure 3-30, the Pathway Factors tab 
contains the main liquid pathway parameters sections and three option selection buttons. The 
three option selection buttons are (1) “Bioaccumulation Factors,” (2) “Usage/Consumption,” and 
(3) “Page Defaults.” 

** User Note **—The initial install includes the parameter values recommended in RG 1.109, 
except when the DCFs from ICRP-72 are used, in which case the Usage/Consumption values 
are taken from the EPA’s EFH. Any change made to the values in this tab will be saved in the 
program’s main database and will be used for future calculations. Therefore, if values are 
changed to reflect site-specific information, then after saving the case/file (which will also save 
all changes applicable to the case/file), the user should reset the values to the defaults so that 
the changes do not affect future uses and calculations. 
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Figure 3-30 Pathway Factors Tab 

 Liquid Pathway Parameters 

On the Pathway Factors tab, users can review and edit the following liquid pathway parameters, 
as shown in Figure 3-30: 

• The processing time for aquatic foods is entered in hours. The default value, also used 
in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 24.0 hr. 
The allowable range for values in this field is greater than 0.0 hrs. 

• The processing time for water supply systems is entered in hours. The default value, 
also used in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 
12.0 hr. The allowable range for values in this field is greater than 0.0 hrs. 

• The pasture grass consumption rate for milk-producing animals is entered in kilograms 
per day (kg/d). The default value, also used in “NUREG/CR-4013 Sample Problem 1—
ICRP-2,” is the RG 1.109 value of 50.0 kg/d. The allowable range for values in this field 
is greater than 0.0 kg/d. 

• The water consumption rate for milk-producing animals is entered in liters per day (L/d). 
The default value, also used in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the 
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RG 1.109 value of 60.0 L/d. The allowable range for values in this field is greater than 
0.0 L/d. 

• The pasture grass consumption rate for beef-producing animals is entered in kg/d. The 
default value, also used in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the 
RG 1.109 value of 50.0 kg/d. The allowable range for values in this field is greater than 
0.0 kg/d. 

• The water consumption rate for beef-producing animals is entered in L/d. The default 
value, also used in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 
value of 50.0 L/d. The allowable range for values in this field is greater than 0.0 L/d. 

• The fraction of deposition captured by vegetation is unitless. The default value, also 
used in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 0.25. 
The allowable range for values in this field is greater than 0.0 and less than 1.0. 

• For the total U.S. population, the default value, also used in “NUREG/CR-4013 Sample 
Problem 1—ICRP-2,” is the RG 1.109 value of 2.60E+08. The allowable range for values 
in this field is greater than 0.0. (Note: This value is a carryover from previous LADTAP 
population dose calculations; it remains a required code factor but is not used for current 
calculations.) 

• The midpoint of the plant life is entered in years, with the default value of 20 years (also 
used for “NUREG/CR-4013 Sample Problem 1—ICRP-2”). RG 1.109 references a 
nominal value of 15 years; however, in the LADTAP II and GASPAR II Fortran codes, 
this value was changed to 20 years to reflect the nominal 40-year expected operating life 
for a nuclear plant (without license extension). The allowable range for values in this field 
is greater than 0.0 years. 

• The plant weathering half-life is entered in days. The default value, also used in 
“NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 14 days. The 
allowable range for values in this field is greater than 0.0 days. 

• The density thickness of the root zone is entered in kg/m2. The default value, also used 
in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 240 kg/m2. 
The allowable range for values in this field is greater than 0.0 kg/m2. 

• Default age group fractions are entered for “Adult,” “Teen,” and “Child” (unitless). The 
default values, also used in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” are the 
RG 1.109 values of 0.71, 0.11, and 0.18, respectively. The allowable range for values in 
these fields is greater than 0.0. If using the ICRP-30 DCF values, the user should enter 
fractions of 1.00 for “Adult” and 0 for “Teen” and “Child,” since ICRP-30 contains DCF 
values only for the adult age range. 

• Growing periods for vegetables, leafy vegetables, milk, and meat are entered in days. 
The default values, also used in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” are 
the RG 1.109 values of 60, 60, 30, and 45 days, respectively. The allowable range for 
values in these fields is greater than 0.0 days. 

• Crop yields for vegetables, leafy vegetables, milk, and meat are entered in kg/m2. The 
default values, also used in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” are the 
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RG 1.109 values of 2.0, 2.0, 0.7, and 0.7 kg/m2, respectively. The allowable range for 
values in these fields is greater than 0.0 kg/m2. 

Additionally, as shown in Figure 3-30, the Pathway Factors tab includes the sport and 
commercial aquatic food harvest parameters listed below. The RG 1.109 values used as 
defaults represent the total U.S. harvest data from the 1970s. For commercial harvests, all 
production within 50 miles of the site is considered part of the total U.S. harvest. Appendix D to 
RG 1.109 contains equations for computing the average concentration in the U.S. commercial 
harvest (equation D-2) and the annual population-integrated dose (equation D-4). The 
parameters to be entered are as follows: 

• The sport harvest processing time is entered in hours. The default value, also used in 
“NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 168 hr. The 
allowable range for values in this field is greater than 0.0 hrs. 

• The commercial harvest processing time is entered in hours. The default value, also 
used in “NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 240 
hr. The allowable range for values in this field is greater than 0.0 hrs. 

• The freshwater fish harvest is entered in kg/yr. The default value, also used in 
“NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 
4.40E+07 kg/yr. The allowable range for values in this field is greater than 0.0 kg/yr. 

• The freshwater invertebrate harvest is entered in kg/yr. The default value, also used in 
“NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 
2.30E+06 kg/yr. The allowable range for values in this field is greater than 0.0 kg/yr. 

• The saltwater fish harvest is entered in kg/yr. The default value, also used in 
“NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 
6.58E+08 kg/yr. The allowable range for values in this field is greater than 0.0 kg/yr. 

• The saltwater invertebrate harvest is entered in kg/yr. The default value, also used in 
“NUREG/CR-4013 Sample Problem 1—ICRP-2,” is the RG 1.109 value of 
4.10E+08 kg/yr. The allowable range for values in this field is greater than 0.0 kg/yr. 

 Bioaccumulation Factors 

To review and edit either the bioaccumulation factors for aquatic biota or the transfer factors for 
meat, soil, and milk, select the “Bioaccumulation Factors” button shown in Figure 3-30 to open 
the Bioaccumulation Factors & Transfer Coefficients screen shown in Figure 3-31. 
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Figure 3-31 Bioaccumulation Factors & Transfer Coefficients Screen 

Then use the scrolling tool to review and adjust the bioaccumulation factors for saltwater and 
freshwater plants and fish, as well as the transfer factors for meat, soil, and milk. The RG 1.109 
default values should be used unless site-specific values have been determined and are 
supported by adequate technical bases. Select the “Save” button to save any edits to the 
bioaccumulation factors or transfer coefficients. When the database has been updated, 
NRCDose3 will inform the user as shown in Figure 3-32. After reviewing and adjusting the 
bioaccumulation factors and transfer coefficients, select the “Close” button to return to the 
Pathway Factors tab. NRCDose3 will again prompt the user to save any changes, as shown in 
Figure 3-32. Select the “Yes” button to close the prompt window. 
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Figure 3-32 Bioaccumulation Factors & Transfer Coefficients Prompt Screens 

 Usage/Consumption 

To review and edit the usage and consumption rates for food, drink, and recreation, select the 
“Usage/Consumption” button shown in Figure 3-30 to open the Usage/Consumption Data 
screen shown in Figure 3-33. In general, maximum individual factors are used for individual 
dose evaluations, while average individual factors are used for population dose evaluations. As 
shown in Figure 3-33, the Usage/Consumption Data screen shows the following tables of data, 
which correspond to the databases used in the LADTAP dose calculations: 

• Maximum Individual Exposure Consumption Data for Selected Dose Factors—This table 
gives usage/consumption rates, in kg/yr, for four age groups (“Adults,” “Teens,” 
“Children,” and “Infants”) and eight usage/consumption types (“Fish,” “Freshwater 
Invertebrates,” “Aquatic Plants,” “Drinking Water,” “Shoreline Usage,” “Swimming 
Usage,” “Boating Usage,” and “Saltwater Invertebrates”). 

• Irrigated Food Type Consumption Data—This table gives the maximum and average 
consumption rates, in kg/yr, and holdup times, in hours, for four age groups (“Adults,” 
“Teens,” “Children,” and “Infants”) and four food types (“Vegetables,” “Leafy Vegetables,” 
“Milk,” and “Meat”). “Max Individual Holdup Time (hr)” refers to the holdup time used to 
calculate the maximum dose, which is the minimum holdup time. 

• Average Individual Consumption Data—This table gives the average individual 
consumption, in kg/yr, for three age groups (“Adults,” “Teens,” and “Children”) and three 
consumption types (“Fish,” “Invertebrates,” and “Drinking Water”). 

The values in these tables depend on the ICRP methodology selected. For the ICRP-2 and 
ICRP-30 methodologies, the exposure assumption values are generally from RG 1.109; for the 
ICRP-72 methodology, the exposure assumption values are derived from the EPA’s EFH. 
Appendix C to this manual describes in detail the default usage and consumption rates under 
each ICRP methodology. 

  



 

3-41 

 

Figure 3-33 Usage/Consumption Data Screen 

Select the “Save” button to save any edits made to the usage/consumption data. When the 
database has been updated, NRCDose3 will inform the user as shown in Figure 3-32. After 
reviewing and adjusting the usage/consumption data, select the “Close” button to return to the 
Pathway Factors tab. NRCDose3 will again prompt the user to save any changes made to the 
usage/consumption data, as shown in Figure 3-32. Select the “Yes” button to close the prompt 
window. 

** User Note **—If the ICRP methodology has been changed (e.g., from ICRP-2 to either 
ICRP-30 or ICRP-72), the user should review the usage and consumption rates to ensure that 
the proper values are used in the LADTAP dose calculation. An applicant or licensee preparing 
an NRC LAR should discuss the use of ICRP-72 DCF values with the NRC staff before 
submitting the request. The code will automatically set the usage/consumption values to those 
associated with the DCFs being used (i.e., the RG 1.109 generic factors for the ICRP-2 and 
ICRP-30 DCFs, and the EPA’s EFH for the ICRP-72 DCFs). 
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 Page Defaults 

Select the “Page Defaults” button on the Pathway Factors tab shown in Figure 3-30 to return all 
liquid pathway parameters in the LADTAP dose calculation to their default values. 

** User Note**—Remember that any changes made to the pathway factors will be carried 
forward for future runs. Defaults should be reset using the “Get Default” option. Also remember 
that saving a case/file will save all configurations and values selected for the case. Resetting to 
defaults will not affect any changes made for a particular case/file unless this file is again saved 
after values are changed back to defaults. 

3.3 Code Execution and Reports 

3.3.1 Executing LADTAP 

After all data for the LADTAP dose calculation have been entered, select the “Save” button, as 
shown in Figure 3-34, to save the data to the data set being used to create the input file, as well 
as to a file name if one has been created for the case. NRCDose3 will save the data to the 
LADTAP database, which will be used for the calculation. If a saved file (i.e., a *.LN3 file) is 
being used, it will also be updated. Select the “OK” button to save the data to the database file 
(for use in creating the input for the run) and, as applicable, to the open *.LN3 file. 

 

Figure 3-34 Saving LADTAP Inputs  
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If the data are to be saved to a different *.LN3 database file, then open the File drop-down menu 
and select “Save to LN3 File…” as shown in Figure 3-3. This will open a Windows Explorer 
directory, as shown in Figure 3-35. Name the *.LN3 file and choose the directory location as 
desired. Future saves within NRCDose3 will save to this file name, as well as to the database 
used for code execution. 

 

Figure 3-35 Windows Explorer Directory for Saving LADTAP Inputs to a New File 
  



 

3-44 

 

Figure 3-36 LADTAP Module Main Screen—“Create Input” Button 

Select the “Create Input” button to activate the “View Input” and “Run LADTAP” buttons on the 
LADTAP module main screen, as shown in Figure 3-36. Select the “View Input” button to 
display the Text Viewer screen and review the text file of input data, as shown in Figure 3-37. 
Select the “Save As…” button to open a Windows Explorer directory and save the input as an 
input field file (*.LN3). Select the “Print” button to print the input text file, and the “Close” button 
to close the Text Viewer screen and return to the LADTAP module main screen. 
  



 

3-45 

 

Figure 3-37 Viewing LADTAP Input—Text Viewer Screen 

Select the “Run LADTAP” button shown in Figure 3-36 to execute the code and generate the 
output report. This will also activate the “View Output,” “FSAR Report,” and “Supplemental 
Report” buttons on the LADTAP module main screen, as shown in Figure 3-38. After 
NRCDose3 completes the LADTAP dose calculation, the output will automatically appear as a 
text output file, as shown in Figure 3-39. Select the “Save As…” button shown in Figure 3-39 to 
open a Windows Explorer directory and save the output as a text file (*.txt). Select the “Print” 
button to print the output text file, and the “Close” button to close the Text Viewer screen and 
return to the LADTAP module main screen. The user can also access the output text file by 
selecting the “View Output” button. 

** User Note **—Though it is not required, users should consider saving LADTAP files in a 
user-specified directory other than the NRCDose3 directory, so that future users can access 
and share the files without having to navigate to the NRCDose3 directory. 
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Figure 3-38 LADTAP Module Main Screen—“Run LADTAP” Button 
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Figure 3-39 Viewing LADTAP Output—Text Viewer Screen 

3.3.2 LADTAP Reports 

LADTAP creates two additional reports: the FSAR Input Report and the Supplemental Report. 
As shown in Figure 3-40, the FSAR Input Report consolidates the input data and dose 
calculations into a single text report that provides the information considered most important for 
the preparation and review of results for licensing documents. Select the “Save As…” button 
shown in Figure 3-40 to open a Windows Explorer directory and save the FSAR Input Report 
output as a text file (*.txt). Select the “Print” button to print the FSAR Input Report, and the 
“Close” button to close the Text Viewer screen and return to the LADTAP module main screen. 

  



 

3-48 

 

Figure 3-40 LADTAP FSAR Input Report Screen 

As shown in Figure 3-41, the Supplemental Report provides additional documentation of the 
modeling assumptions used for the calculations, such as bioaccumulation factors, transfer 
factors, and various pathway constants. Select the “Save As…” button shown in Figure 3-41 to 
open a Windows Explorer directory and save the Supplemental Report output as a text file 
(*.txt). Select the “Print” button to print the Supplemental Report, and the “Close” button to close 
the Text Viewer screen and return to the LADTAP module main screen. 
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Figure 3-41 LADTAP Supplemental Report Screen 

** User Note **—Only one report is viewable at a time. A report may be either printed or saved 
as a text file, which can then be further edited or saved in different formats using standard text 
editor functions. 
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4.0 GASPAR 
The GASPAR module within NRCDose3 executes a modified version of the GASPAR II Fortran 
code. This update to the NRCDose code has not changed the basic calculation methods 
(algorithms) of GASPAR II, as described in NUREG/CR-4653. However, significant changes 
have been made to the data management and operation to support the expanded capabilities of 
NRCDose3. GASPAR II performs environmental dose assessments for releases of gaseous 
radioactive effluents from nuclear power plants into the atmosphere, implementing the dose 
assessment methods described in RG 1.109. GASPAR II calculates the radiation dose to 
individuals, population groups, and biota from inhalation of contaminated air, direct exposure 
from contaminated ground, and consumption of contaminated foods. The calculated doses 
provide information for NEPA evaluations and for determining compliance with the NRC public 
dose limits in 10 CFR Part 20, the EPA public dose limits in 40 CFR Part 190, and the NRC 
ALARA design objectives and numerical guides in 10 CFR Part 50, Appendix I. 

The following sections discuss the steps for setting up and performing GASPAR dose 
calculations using NRCDose3. The user is directed to NUREG/CR-4653 for the GASPAR II 
Fortran code user guide and for technical bases and detailed discussion of the assumptions, 
limitations, and methods of the GASPAR dose calculations. 

To open the GASPAR module, select the “GASPAR Gaseous Pathway Dose Assessment” 
button on the NRCDose3 main selection screen, shown in Figure 4-1. This will open the 
GASPAR module main screen, shown in Figure 4-2. 
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Figure 4-1 NRCDose3 Main Selection Screen (GASPAR Module) 
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Figure 4-2 GASPAR Module Main Screen 

The GASPAR module main screen opens with the case data last saved in the database. It 
contains three main functional areas for entering data and performing GASPAR dose 
calculations: (1) the toolbar and initial setup area, (2) the data input tabs, and (3) code execution 
and reports. The following sections discuss these areas and describe the options and 
capabilities in each. 

4.1 Toolbar and Initial Setup 

This portion of the GASPAR module main screen contains three tools and two initial setup input 
fields, as shown in Figure 4-2. The three tools are File, Quit, and About. The initial setup fields 
are Case Title and Dose Factors (drop-down menu). 

4.1.1 File Tool 

The File tool provides the functionality for managing the GASPAR files, as shown in Figure 4-3. 
The File drop-down menu offers the following options: 

• New—Select this option to begin a new GASPAR case. This will clear the database 
that is used for creating the input for a run (i.e., it will clear the existing input data). 
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• Open GN3 File—Select this option to access and open a *.GN3 file previously 
created with NRCDose3. 

• Save to Database—Select this option to save the current case to the input database. 
When GASPAR is opened, the data that were last saved (typically from the previous 
run) are loaded, populating all GASPAR screens and windows. 

• Save to GN3 File—Select this option to save the completed case to a *.GN3 file, for 
later use or for sharing with others. 

• Delete—Select this option to open an Explorer window that will allow the user to 
delete any previously saved *.GN3 files. 

** User Note **—NRCDose3 uses the *.GN3 file type and format for GASPAR files. Files in 
other formats (for example, *.GNP files generated by GASPAR under NRCDose (version 2.3.20 
or earlier)) are not compatible with NRCDose3. 

 

Figure 4-3 GASPAR Toolbar with File Drop-down Menu 
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4.1.2 Quit Tool 

The Quit tool allows the user to terminate the operation of the GASPAR module. When the Quit 
tool is selected, the Question prompt screen (shown in Figure 4-4) will be displayed to verify that 
the user wants to exit the module. Select the “Yes” button to terminate the GASPAR module 
without saving any changes to the data not previously saved. To save changes (to the database 
and/or a *.GN3 file) before quitting, select the “No” button, then choose the appropriate entry 
from the File drop-down menu. 

 

Figure 4-4 GASPAR Module Quit Tool Screen 

4.1.3 About Tool 

Selecting the About tool brings up the About GASPAR screen shown in Figure 4-5, which 
displays information about GASPAR II. Select the “OK” button to return to the GASPAR module 
main screen shown in Figure 4-2. 

 

Figure 4-5 About GASPAR Screen 
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4.1.4 Case Title Field 

In the Case Title field, enter a title for the GASPAR case. This is a descriptive text field only; the 
data in this field are not used for any GASPAR dose calculations. The title should help users 
identify the facility/site and release point (e.g., “Facility XYZ and Miscellaneous Waste 
Discharge”). As shown in Figure 4-2, the initial test case included in the NRCDose3 installation 
(which is loaded when the GASPAR module is first opened) is entitled “GASPAR Test Case 1—
ICRP-2.” This file is included in the installation directory (i.e., the default directory 
C:/NRCDose3) and serves as verification for installation. 

4.1.5 Dose Factors Drop-Down Menu 

The Dose Factors drop-down menu, shown in Figure 4-6, allows the user to select the DCF 
values to be used for the GASPAR dose calculations. The options available are “ICRP-2 
(Default),” “ICRP-30,” and “ICRP-72.” Note that if the DCF values are changed, then the 
assumed source term (if any has been entered) will be cleared, and the assumed usage and 
consumption factors will be updated to the values associated with the selected ICRP 
methodology. 

** User Note **—For the purposes of demonstrating compliance with 10 CFR Part 50, 
Appendix I, and 40 CFR Part 190, the ICRP-2 DCF values should be selected. For 
demonstrating compliance with 10 CFR Part 20, the ICRP-30 DCF values should be selected. 
An applicant or licensee preparing an NRC LAR should discuss the use of ICRP-72 DCF values 
with the NRC staff before submitting the request. 
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Figure 4-6 GASPAR Dose Factors Drop-down Menu 

4.2 Data Input Tabs 

The six GASPAR data input tabs, shown in Figure 4-2, are as follows: 

(1) Options 

(2) Source Term 

(3) Special Location Data 

(4) Dose Factors 

(5) Pathway Factors 

(6) Consumption Values 

It is recommended, though not required, that the user enter the necessary case parameters and 
data into the data input tabs in the order in which they are listed. 
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4.2.1 Options Tab 

The Options tab is used to enter various parameters for the GASPAR dose calculations. It 
includes several check boxes (left-hand side of tab) and input fields (right-hand side of tab), as 
shown in Figure 4-7. Refer to NUREG/CR-4653 for more information on the inputs in this tab. 

 

Figure 4-7 Options Tab 

 Options Tab—Left-Hand Side Options 

As shown in Figure 4-7, the following check boxes appear on the left side of the Options tab: 

• Calculate individual doses only—Check this option (box) to have GASPAR 
calculate only the individual doses from gaseous effluents. If this option (box) is 
unchecked, GASPAR will perform population dose calculations in addition to 
individual dose calculations. The value from “GASPAR Test Case 1—ICRP-2” for 
this option is checked. Population dose calculations require additional data on 
population; meteorology; and milk, meat, and vegetable production, which should 
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be entered in the Pop/Prod Data tab. Selecting this option will open the 
population data warning screens shown in Figure 4-8. Selecting the “OK” button 
on both warning screens will return the user to the Options tab. 

** User Note **—If the user does not enter data for the population or for milk, meat, or 
vegetable production, a value of 1.0 is automatically entered; the program requires a value to 
perform the calculations. The term “meteorological” as used in the guidance pertaining to 
GASPAR refers to the relative concentration (X/Q) and relative deposition (D/Q) values 
produced by the XOQDOQ module of NRCDose3, but not to the actual meteorological data 
input to that code. 

 

Figure 4-8 Population Data Warning Screens 

• Print dose-factor library data—Check this option (box) to print all applicable DCF values 
in the GASPAR dose calculation output file. The value from “GASPAR Test Case 1—
ICRP-2” for this option is unchecked. 

• Perform PARTS calculation—Check this option (box) only if the code should perform 
calculations with the PARTS subroutine. These calculations represent site-specific dose 
factors normalized to unit release in microcuries per second (μCi/s), atmospheric 
dispersion in seconds per cubic meter (s/m3), and deposition measured per square 
meter (m-2). The value from “GASPAR Test Case 1—ICRP-2” for this option is 
unchecked. Selecting this option will open the PARTS calculation information screens 
shown in Figure 4-9. Selecting the “OK” button on both warning screens will return the 
user to the Options tab. Selecting the “Info…” button next to this option will open the 
PARTS information screen shown in Figure 4-10. Selecting the “OK” button on both 
warning screens will return the user to the Options tab. This option is functional only with 
the ICRP-2 DCFs. 
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Figure 4-9 PARTS Calculation Information Screens 

Figure 4-10 PARTS Information Screen 

• Read X/Q and D/Q data from XOQDOQ-generated file—Check this option (box) to use
meteorological dispersion parameters generated by the XOQDOQ code. If this option is
checked, the dispersion parameters for population dose calculations and the special
locations will be read from a file created by XOQDOQ. Section 5.3 further explains this
function in XOQDOQ. The value from “GASPAR Test Case 1—ICRP-2” for this option is
unchecked.

Biota Dose Modeling and “Add Biota” Button 

Biota dose modeling is an addition to GASPAR that did not exist in the GASPAR II Fortran 
code. The same modeling methodology as used in LADTAP II has been employed. Section 6.0 
gives additional details. GASPAR includes six assumed terrestrial species: those assumed in 
LADTAP (muskrat, raccoon, heron, and duck) plus cow (surrogate herbivore) and fox (surrogate 
carnivore). As described below, more species can be added with user-defined exposure 
assumptions. 

The internal dose component for terrestrial biota is calculated using the same methodology as in 
LADTAP II, using the models in BNWL-1754. Similarly to LADTAP, which uses environmental 
transfer factors (bioaccumulation factors) for fish, invertebrates, and algae, GASPAR uses 
transfer factors for vegetation and meat. The GASPAR modeling is based on defining each 
species as either herbivore or carnivore (eating plants or meat, respectively), with radionuclide 
concentrations calculated using the RG 1.109 model. 

The internal dose component for all herbivores (cow, muskrat, raccoon, duck, and heron) is 
calculated considering the radionuclide concentration in the meat, as modeled by RG 1.109, 
equation C-12, for cows, and applying the nuclide-specific absorbed dose coefficients for the 
appropriate effective radius. (See the user note below on effective radius.) For herbivores other 
than cows, the internal dose is calculated by taking the ratio of the assumed ingestion rate to 
the biota mass and applying the adult human ingestion DCF, adjusting for the difference in 
absorbed energy between an adult human (30 cm effective radius) and the biota in question. 
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The internal dose to a carnivore is calculated similarly but correlated to the calculated (cow) 
meat concentration, with adjustments for differences in mass, consumption rate, and effective 
radius. For both herbivores and carnivores, the adult human inhalation dose is added (as an 
approximation of the inhalation exposure component) to yield the total internal dose. 

The external dose component is the same as the adult human ground-plane dose multiplied by 
a factor of 2 to account for proximity to the ground and divided by 0.7 to remove the shield factor 
assumed for human exposure. Thus, the external component for the biota dose is 2.86 times 
that calculated for adult humans. Table 4-1 lists the parameters used to calculate the biota dose 
in GASPAR. 

Table 4-1 Biota Dose Parameters for GASPAR II in NRCDose3 

Species Mass (g) 
Effective 
Radius* 

(cm) 
Primary Food 

Eaten 
Consumption Rate 

(g/d) 

Muskrat 
(from LADTAP II) 1,000 5 Terrestrial 

plants 100 

Raccoon 
(from LADTAP II) 12,000 15 Terrestrial 

plants 200 

Duck 
(from LADTAP II) 1,000 5 Terrestrial 

plants 100 

Heron 
(from LADTAP II) 4,600 10 Terrestrial 

plants 600 

Cow 
(herbivore) N/A 30 Terrestrial 

plants N/A 

Fox 
(carnivore)a 5,700 10 Meat (cow) 520 

User-defined As defined As defined As defined As defined 

Notes: 
* For GASPAR, the effective radius chosen must be one of the eight radius values tabulated. The radii assigned 

are those considered most representative for the species, out of the available values. 
a. Fox modeling assumptions are derived from http://www.britannica.com/animal/red-fox-mammal 

and http://www.hse.gov.uk/pesticides/resources/R/Research_PN0908.pdf. 
  

http://www.britannica.com/animal/red-fox-mammal
http://www.hse.gov.uk/pesticides/resources/R/Research_PN0908.pdf
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• “Add Biota” Button—Select the “Add Biota” button shown in Figure 4-7 to open the 
Additional Biota Types screen shown in Figure 4-11 and enter the required exposure 
parameters for any new biota. To define a new biota type, select the “Add Biota Type” 
button to activate the biota information section at the bottom of the screen. For each new 
biota type, enter the name, the primary food type (carnivore or herbivore), the mass in 
grams, the effective radius in centimeters, and the consumption rate in g/yr. Select the 
“Save” button to save the new biota type and return to the Options tab. To remove a 
biota type, select (highlight) the biota type in the upper portion of the screen, and select 
the “Delete Biota Type” button. Select the “Clear” button to remove all biota types from 
the file. Select the “Close” button to close the Additional Biota Types screen and return 
to the Options tab. 

** User Note **—The code can address only a single food type, either plant or meat. While the 
raccoon is recognized to be an omnivore, by default it is modeled as a herbivore; this is 
consistent with the assumptions in LADTAP and BNWL-1754. The raccoon may also be 
modeled as a carnivore by using the “Add Biota Type” function with appropriate inputs for 
consumption. 

** User Note **—Species-specific modeling can be performed by modifying the exposure and 
uptake assumptions and transfer factors unique to the species (e.g., defining transfer factors for 
chickens). 

** User Note **—The effective radius is used to model organisms as spheres, so that different 
dose absorption values can be applied for organisms of different sizes or masses. The effective 
radius is the radius of a sphere (considered muscle) that has the same mass as the organism in 
question, assuming the mass is uniformly distributed. For an assumed nominal density of 1 
gram per cubic centimeter (g/cm3) for muscle, the effective radius can be approximated by 
dividing the organism’s mass (in grams) by 4.19 (where 4.19 is an approximation of 4/3 * π), 
then taking the cube root. Appendix D describes the modeling and calculations for the 
nuclide-specific deposited energy (dose) values based on effective radius. 
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Figure 4-11 Additional Biota Types Screen 

 Options Tab—Right-Hand Side Options 

As shown in Figure 4-7, the right side of the Options tab contains the following site-specific 
parameters, which capture the particular characteristics of the environment where the facility is 
currently or will be located: 

• The fraction of the year that leafy vegetables are grown is unitless, with the value in 
“GASPAR Test Case 1—ICRP-2” set to 0.75. The allowable range for values in this field 
is greater than 0.0. 

• The fraction of the year that milk cows are on pasture is unitless, with the value in 
“GASPAR Test Case 1—ICRP-2” set to 0.80. The allowable range for values in this field 
is greater than 0.0. 

• The fraction of the maximum individual’s vegetable intake from their own garden is 
unitless, with the value in “GASPAR Test Case 1—ICRP-2” set to 0.50. The allowable 
range for values in this field is greater than 0.0. 

• The fraction of milk-cow feed intake from pasture while on pasture is unitless, with the 
value in “GASPAR Test Case 1—ICRP-2” set to 1.00. The allowable range for values in 
this field is greater than 0.0. 

** User Note **—The milk transfer factors in GASPAR, taken from RG 1.109, Table E-1, are 
specific to dairy cows. It may be appropriate to apply them to other, similar milk-producing 
animals, but the user should consider the particular animal’s characteristics. 

• Humidity is entered as relative humidity (i.e., percentage of the amount of atmospheric 
moisture present relative to the amount that would be present if the air were saturated), 
provided that a value other than zero (0) is entered for “Average temperature over 



 

4-14 

growing season” (the next entry in this column). If “Average temperature over growing 
season” is entered as zero (0), then the value entered for humidity represents the 
absolute humidity, i.e., the weight of water present in a unit volume of moist air, 
measured in grams per cubic meter. The value in “GASPAR Test Case 1—ICRP-2,” 
which is set to 8.00, is treated as relative humidity in the GASPAR calculations, since the 
temperature is set at 70, a value other than zero. The allowable range for values in this 
field is greater than 0.0, as either an absolute value (absolute humidity) or a percentage 
(relative humidity). 

 

Figure 4-12 Humidity Information Screen 

 

Figure 4-13 Humidity Alert Screen 
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• The average temperature over the growing season is in degrees Fahrenheit (F), with the 
value in “GASPAR Test Case 1—ICRP-2” set to 70.00 degrees F. The allowable range 
for values in this field is greater than 0.0 degrees F. If the value is set to zero (0), then 
the humidity value will be treated as an absolute humidity (see above). 

• The fraction of the year that goats are on pasture is unitless, with the value in “GASPAR 
Test Case 1—ICRP-2” set to 1.00. The allowable range for values in this field is greater 
than 0.0. 

** User Note **—Some of the milk transfer factors taken from RG 1.109, Table E-1, are specific 
to goats. It may be appropriate to apply them to other, similar milk-producing animals, but the 
user should consider the particular animal’s characteristics. 

• The fraction of goat feed intake from pasture while on pasture is unitless, with the value 
in “GASPAR Test Case 1—ICRP-2” set to 1.00. The allowable range for values in this 
field is greater than 0.0. 

• The fraction of the year that beef cattle are on pasture is unitless, with the value in 
“GASPAR Test Case 1—ICRP-2” set to 0.80. The allowable range for values in this field 
is greater than 0.0. 

** User Note **—The meat transfer factors in GASPAR, taken from RG 1.109, Table E-1, are 
specific to beef cattle. It may be appropriate to apply them to other, similar animals, but the user 
should consider the particular animal’s characteristics. 

• The fraction of beef cattle feed intake from pasture while on pasture is unitless, with the 
value in “GASPAR Test Case 1—ICRP-2” set to 1.00. The allowable range for values in 
this field is greater than 0.0. 

4.2.2 Source Term Tab 

The Source Term tab, shown in Figure 4-16, is used to enter the source terms for the GASPAR 
dose calculations. Typically, there is a unique source term for each release type. For this 
version of GASPAR, as incorporated into NRCDose3, only a single source term may be used 
for each case/run. If a facility has different source terms for multiple release points, additional 
cases (*.GN3 files) will be needed. For each source term, enter a title (e.g., “Reactor Vent,” 
“Aux. Bldg. Vent”), the source term multiplication factor (unitless, with the default value of 1.00) 
that will be applied to the input release activity for each radionuclide, and the annual release 
time for purges in hours (with the default value of 0.0 hr). 

The “Release time for purges” entry is used for C-14 dose calculations only. It is used to adjust 
the total time available for plant uptake through photosynthesis. The maximum value allowed is 
4380 hr, which reasonably approximates the maximum possible amount of daylight over a year 
(one-half of 8760 hr per year). NUREG/CR-4653 provides the following explanation: 

The fractional equilibrium ratio, p, is used to account for the fractional equilibrium achieved 
between atmospheric and plant carbon concentrations for intermittent releases, such as purges 
of gaseous waste decay tanks. The equilibrium ratio is defined as the ratio of the total annual 
release time to the total annual time during which photosynthesis occurs (taken to be 4,380 hr). 
For continuous releases, p is set to unity. 
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Figure 4-14 Purge Information Screen 

 

Figure 4-15 Excess Purge Warning 
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Figure 4-16 Source Term Tab 

The radionuclides in the source term, along with the quantity of each (in curies), are displayed 
on the right-hand portion of the Source Term tab, as shown in Figure 4-16. To add a 
radionuclide to the source term, select the “Add Nuclide” button. 

** User Note **—Verify that the desired ICRP methodology has been selected before entering 
any additional radionuclide data. When the “Add Nuclide” button on the Source Term tab is 
selected, a warning message will flash to remind the user about DCF values, as shown in 
Figure 4-17, and then the Select Nuclide screen will appear. Changing the ICRP methodology 
will cause the source term to be cleared. 

Select (highlight) the radionuclide to be added, and then click the “Add” button to add the 
radionuclide to the source term. By holding down the “Ctrl” key during radionuclide selection, the 
user can select multiple radionuclides. The individual radionuclides, activity release, and total 
quantity in curies will be continuously updated. It is recommended that after entering the source 
term data, the user save the input to the *.GN3 file by selecting the “Save” button. 
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Figure 4-17 Source Term Warning Message 

To remove radionuclides from the source term, select (highlight) the radionuclide to be removed 
and then click the “Delete Nuclide” button, as shown in Figure 4-12. Selecting the “Clear” button 
clears all source term data (nuclide, class, f1 value, and quantity) for all radionuclides in the 
Source Term tab. 

4.2.3 Pop/Prod Data Tab 

In the Pop/Prod Data tab, shown in Figure 4-18, the user can enter extensive information about 
demographics, food production, and meteorology (if necessary) around the site. The Pop/Prod 
Data tab appears when the “Calculate individual doses only” box is unchecked in the Options 
tab (see Section 4.2.1). The Data Type drop-down menu contains five options for entering 
demographic data: (1) “Population,” (2) “Milk Production,” (3) “Meat Production,” (4) “Vegetable 
Production,” and (5) “Meteorological” (note that sector dispersion and deposition values will 
need to be entered manually unless an XOQDOQ-generated input file is created). The 
demographic and production data can be entered either as total values within a 50-mile radius 
or on a per-sector basis at varying distances from 1 to 50 miles. 

To enter per-sector data, select the “Input by distance and direction” check box. This activates 
the per-sector input table, with entries for each radial distance (1, 2, 3, 4, 5, 10, 20, 30, 40, and 
50 miles) and each of the 16 meteorological sectors, as shown in Figure 4-18. 



 

4-19 

** User Note **—Data are required for each Data Type drop-down menu option; if the user 
does not enter a value, a value of 1.0 is automatically added to support the calculations required 
by the code. 

 Population 

Select the Population option from the Data Type drop-down menu to enter the total population 
within 50 miles of the site. The allowable range for values in this field is greater than 0.0. To 
enter the population data on a per-sector basis, select the check box to open the per-sector 
input table for population data, as shown in Figure 4-18. Enter the population data for each 
radial distance (1, 2, 3, 4, 5, 10, 20, 30, 40, and 50 miles) and each of the 16 downwind 
direction sectors. Note that the value entered for each distance should represent the population 
in the range from one distance to the next. For example, the value for “1 mile” represents the 
population in the 0-to-1-mile distance range; the value for “10 miles” represents the population 
in the 5-to-10-mile distance range. Select the “Update” button to save the per-sector population 
data. Use the “Clear” button to delete the population data from the sector table; this will open 
the Clear Data warning screen shown in Figure 4-19. 

 

Figure 4-18 Pop/Production Data Tab 
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Figure 4-19 Clear Data Warning Screen 

 Milk Production 

Select the Milk Production option from the Data Type drop-down menu to enter the total milk 
production in L/yr within 50 miles of the site. The allowable range for values in this field is 
greater than 0.0 L/yr. To enter the milk production data on a per-sector basis, select the check 
box to open the per-sector input table, as shown in Figure 4-18. Enter the milk production data 
for each radial distance (1, 2, 3, 4, 5, 10, 20, 30, 40, and 50 miles, with each value representing 
a distance range as discussed above) and each of the 16 downwind direction sectors. Select 
the “Update” button to save the per-sector milk production data. Use the “Clear” button to delete 
the milk production data from the sector table; this will open the Clear Data warning screen 
shown in Figure 4-19. 

 Meat Production 

Select the Meat Production option from the Data Type drop-down menu to enter the total meat 
production in kg/yr within 50 miles of the site. The allowable range for values in this field is 
greater than 0.0 kg/yr. To enter the meat production data on a per-sector basis, select the check 
box to open the per-sector input table, as shown in Figure 4-18. Enter the meat production data 
for each radial distance (1, 2, 3, 4, 5, 10, 20, 30, 40, and 50 miles) and each of the 16 downwind 
direction sectors. Select the “Update” button to save the per-sector meat production data. Use 
the “Clear” button to delete the meat production data from the sector table; this will open the 
Clear Data warning screen shown in Figure 4-19. 

 Vegetable Production 

Select the Vegetable Production option from the Data Type drop-down menu to enter the total 
vegetable production in kg/yr within 50 miles of the site. (The default value for this field, also 
used in “GASPAR Test Case 1—ICRP-2,” is 1.00+03 kg/yr.) The allowable range for values in 
this field is greater than 0.0 kg/yr. To enter the vegetable production data on a per-sector basis, 
select the check box to open the per-sector input table, as shown in Figure 4-18. Enter the 
vegetable production data for each radial distance (1, 2, 3, 4, 5, 10, 20, 30, 40, and 50 miles) 
and each of the 16 downwind direction sectors. Select the “Update” button to save the 
per-sector vegetable production data. Use the “Clear” button to delete the vegetable production 
data from the sector table; this will open the Clear Data warning screen shown in Figure 4-19. 

 Meteorological 

Select the Meteorological option from the Data Type menu if the meteorological data (dispersion 
and deposition values) need to be manually entered into GASPAR, rather than imported from a 
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completed XOQDOQ run (see Section 5.3). As discussed in Section 4.2.1.1, this menu option is 
required only if “Read Met data from XOQDOQ-generated file” is not selected (the box is 
unchecked) on the Options tab. The calculated dispersion and deposition values depend on the 
release point characteristics, as specified in the XOQDOQ code inputs. The user should verify 
that the dispersion and deposition data, as entered or imported here, are representative of the 
source term for the modeled release point. 

To enter dispersion and deposition data, select the appropriate option for either dispersion 
(i.e., “Undecayed, Undepleted,” “Decayed, Undepleted,” or “Decayed, Depleted”) or ground 
deposition, as discussed in Section 2.2.6 of NUREG/CR-4653. Enter the applicable dispersion 
(in s/m3) or deposition (in m-2) for each radial distance (1, 2, 3, 4, 5, 10, 20, 30, 40, and 50 miles, 
with each value representing a distance range as discussed above) and each of the 16 
downwind meteorological sectors, as shown in Figure 4-20. The corresponding values from the 
XOQDOQ output are those given in the tables titled “SEGMENT BOUNDARIES IN MILES 
FROM SITE.” Select the “Update” button to save the data. Select the “Clear” button to delete 
the total data set from the sector table; this will open the Clear Data warning screen shown in 
Figure 4-19. Repeat this process for the other dispersion and deposition parameters. 

 

Figure 4-20 Pop/Production Data Tab—Meteorological Data 

As an alternative to manually entering the dispersion and deposition data, the user can import 
these data from a Microsoft (MS) Excel (*.xlsx) file by selecting the “Import X/Q and D/Q Data” 
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button, as shown in Figure 4-20. This will open a Windows Explorer directory allowing the user 
to navigate to the appropriate file to be imported, as shown in Figure 4-21. Select the file to be 
imported; NRCDose3 will then automatically import the data and populate the sector table 
shown in Figure 4-20. After the data have been imported, select the “Update” button shown in 
Figure 4-20 to save the data. 

A separate MS Excel (*.xlsx) file is required for each of the three dispersion parameters and the 
single deposition parameter, so this process must be performed four times for the four 
meteorological data sets (“Undecayed/Undepleted,” “Decayed/Undepleted,” 
“Decayed/Depleted,” and “Ground Deposition”). A template MS Excel example file, as shown in 
Figure 4-22, is included in the NRCDose3 installation. Only the values in the cells shaded yellow 
are imported into GASPAR. 

 

Figure 4-21 Windows Explorer Directory for Importing Meteorological Data to GASPAR 

 

Figure 4-22 Example MS Excel File for Meteorological Data 
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** User Note **—Make sure the dispersion or deposition data sets are entered into the template 
and dialog box for the correct downwind directions, starting with sector N and ending with 
sector NNW. 

4.2.4 Special Location Data Tab 

In the Special Location Data tab, shown in Figure 4-23, the user can enter the parameters 
needed to define the atmospheric dispersion and deposition values at any special receptor 
locations. As discussed in Section 4.2.1.1, this tab is available only if “Read X/Q and D/Q data 
from XOQDOQ-generated file” is not selected (unchecked box) on the Options tab. (Otherwise, 
the special locations will be taken from the XOQDOQ-generated file, where they are already 
defined.) The Special Location Data tab includes the Special Locations section (left-hand side of 
tab) and the Location for Individual Doses section (right-hand side of tab), as shown in 
Figure 4-23. 

 

Figure 4-23 Special Location Data Tab 

The Special Locations section (left-hand side of tab) lists the name and number of records for 
each special location. A maximum of five special locations is allowed; multiple cases/runs 
should be used if more than five locations are needed. To review or edit a special location, 
select (highlight) it and review or modify the entries in the Location for Individual Doses section 
(right-hand side of tab). To delete a special location record, select (highlight) it and then click the 
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“Remove” button, as shown in Figure 4-23. To add a special location record, select the “Add” 
button and enter the parameters listed in the Location for Individual Doses section. 

In the Location for Individual Doses section (right-hand side of tab), each special location is 
defined by the following parameters: 

• Name of Location—This field contains the name of the special location to be used in the 
GASPAR dose calculation. 

• Direction from Site—This field contains a drop-down menu from which the user can 
select one of the 16 downwind direction sectors. 

• Distance from Site—This field contains the distance of the special location from the site, 
as modeled in XOQDOQ, in meters. The allowable range for values in this field is 
greater than 0.0 m. 

• Atmospheric Dispersion Factors—This field contains the atmospheric dispersion factors, 
in s/m3, for the three atmospheric dispersion types (i.e., “Undecayed, Undepleted,” 
“Decayed, Undepleted,” and “Decayed, Depleted”). The allowable range for values in 
this field is greater than 0.0 s/m3. 

• Ground Deposition Factor—This field contains the ground deposition factor in m-2. The 
allowable range for values in this field is greater than 0.0 m-2. 

Select the “Don’t print any detailed reports” option (check box) if no detailed reports need to be 
printed. Uncheck this option if a report of the pathway dose contribution by radionuclide is 
desired. Detailed reports will be included for all unchecked pathway boxes. Select the “Save” 
button when edits to the special location have been completed. This will save the data for the 
specific location only, not for the total input file. 

4.2.5 Dose Factors Tab 

In the Dose Factors tab, shown in Figure 4-24, the user can select, review, and modify DCF 
values for the GASPAR dose calculation. The tab is identical to the Dose Factors tab in the 
LADTAP module, which is discussed in Section 3.2.5 (see Section 6.1 for a discussion of how 
the DCF values were determined). After selecting the appropriate ICRP methodology 
(i.e., ICRP-2 (default), ICRP-30, or ICRP-72) from the Dose Factors drop-down menu, open the 
Factors drop-down menu and select the applicable age group and pathway (i.e., adult ingestion 
or inhalation, teen ingestion or inhalation, child ingestion or inhalation, or infant ingestion or 
inhalation). 

At this point, all applicable organ DCF values will be available for review, as shown in 
Figure 4-24. Select the “Nuclide Data” button to open the Nuclide Data screen, which contains 
two tables of data, as shown in Figure 4-25. The top table contains applicable nuclide data, 
including atomic weight, isomeric state, and decay constant. The scrolling tool on the top table 
allows the user to view the DCF values, which are summarized in Table 4-2. The bottom table 
provides the effective energy (MeV/nt) deposited for each given effective radius; see appendix 
D to this manual for a detailed description of this table. Select the “Exit” button to return to the 
Dose Factors tab. 
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Figure 4-24 Dose Factors Tab 

Table 4-2 Description of GASPAR DCF Values 

DCF Description Units 

EXG TB Factor Total body (or effective) DCF from ground-plane exposure 
mrem hr⁄
ρCi m2⁄  

EXS TB Factor Total body (or effective) DCF from submersion in contaminated 
water 

mrem hr⁄
ρCi L⁄

 

EXG Skin 
Factor Skin DCF from ground-plane exposure 

mrem hr⁄
ρCi m2⁄  

EXS Skin 
Factor Skin DCF from submersion in contaminated water 

mrem hr⁄
ρCi L⁄
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Figure 4-25 Nuclide Data Screen 

If ICRP-2 DCF values are selected, then the total body DCF values from ICRP-2 are used, as in 
the original releases of LADTAP II, GASPAR II, and NRCDose version 2.3.20. If ICRP-30 DCF 
values are selected, then GASPAR uses effective and skin DCF values based on ICRP 
Publication 26, “Recommendations of the International Commission on Radiological Protection” 
(ICRP-26), issued 1977 [Ref. 23], as found in Federal Guidance Report No. 12, “External 
Exposure to Radionuclides in Air, Water, and Soil” (FGR 12), issued September 1993 [Ref. 24]. 
If ICRP-72 DCF values are selected, then GASPAR uses effective DCF values based on 
ICRP-60 (also from FGR 12) and skin DCF values based on ICRP-26. 

** User Note **—An applicant or licensee preparing an NRC LAR should discuss the use of 
ICRP-72 DCF values with the NRC staff before submitting the request. 

If ICRP-30 or ICRP-72 DCF values are selected, then external DCF values have been modified 
to account for short-lived progeny radionuclides. See Sections 6.1 and 6.2 for more details and 
Tables 6-1 and 6-2 for the adjusted radionuclides. 

Select the “Submersion” button to open the Noble Gas Submersion DFs—Default screen shown 
in Figure 4-26 and review the DCF values used for air submersion calculations. The gamma air 
and beta air DCF values from RG 1.109 have not been changed since the original release of 
GASPAR II. The gamma T-body and beta skin DCF values are based on the ICRP-26 values 
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when either ICRP-30 or ICRP-72 is selected. (See Section 6.1 for a discussion of the source of 
these DCF values.) Select the “Close” button to return to the Dose Factors tab. 

 

Figure 4-26 Noble Gas Submersion DFs—Default Screen 

4.2.6 Pathway Factors Tab 

The Pathway Factors tab is used to modify the default RG 1.109 environmental transport and 
exposure assumptions used for the GASPAR dose calculation. In general, the values for the 
parameters on this tab should be changed only if there are suitable data supporting a 
site-specific change. As shown in Figure 4-27, the Pathway Factors tab contains four main 
parameter input sections: (1) the general input parameters (upper left), (2) Holdup and 
Transport Times, (3) Goat Feed to Milk Transfer Factors, and (4) Physical Parameters. 
Additionally, this tab contains two selection buttons: (1) “Transfer Factors” and (2) “Page 
Defaults.” 

** User Note**—Remember that any changes made to the pathway factors will be carried 
forward for future runs. Defaults should be reset using the “Get Default” option. Also remember 
that saving a case/file will save all configurations and values selected for the case. Resetting to 
defaults will not affect any changes made for a particular case/file unless this file is again saved 
after values are changed back to defaults. Therefore, if there is any question about the saved 
values, it is best to reset to defaults before initiating a new case. 
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Figure 4-27 Pathway Factors Tab 

 General Pathway Parameters 

The following pathway parameters are entered in the upper left-hand side of the Pathway 
Factors tab, as shown in Figure 4-27: 

• The growing period for vegetables consumed by a human is entered in days. The default 
value, also used in “GASPAR Test Case 1—ICRP-2,” is the RG 1.109 value of 
60.0 days. The allowable range for values in this field is greater than 0.0 days. 

• The cow feed ingestion rate is entered in kg/d. The default value, also used in “GASPAR 
Test Case 1—ICRP-2,” is the RG 1.109 value of 50.0 kg/d. The allowable range for 
values in this field is greater than 0.0 kg/d. 

• The goat feed ingestion rate is entered in kg/d. The default value, also used in “GASPAR 
Test Case 1—ICRP-2,” is the RG 1.109 value of 6.0 kg/d. The allowable range for 
values in this field is greater than 0.0 kg/d. 

• The parameter “Vegetables retention for particulates other than iodine” is unitless. The 
default value, also used in “GASPAR Test Case 1—ICRP-2,” is the RG 1.109 value of 
0.2. The allowable range for values in this field is greater than 0.0 and not exceeding 
1.0. 
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• The weather removal constant is the vegetation weathering removal for a radionuclide in 
inverse seconds (s-1). The default value, also used in “GASPAR Test Case 1—ICRP-2,” 
is the RG 1.109 value of 5.73E-07 s-1 (corresponding to a 14-day half-life). The allowable 
range for values in this field is greater than 0.0 s-1. 

• The soil surface density is entered in kg/m2. The default value, also used in “GASPAR 
Test Case 1—ICRP-2,” is the RG 1.109 value of 240.0 kg/m2. The allowable range for 
values in this field is greater than 0.0 kg/m2. 

• The iodine retention is unitless. The default value, also used in “GASPAR Test Case 1—
ICRP-2,” is the RG 1.109 value of 1.0. The allowable range for values in this field is 0.0 
to 1.0. 

• The pasture grass yield is entered in kg/m2. The default value, also used in “GASPAR 
Test Case 1—ICRP-2,” is the RG 1.109 value of 0.7 kg/m2. The allowable range for 
values in this field is greater than 0.0 kg/m2. 

• The feed crop yield is entered in kg/m2. The default value, also used in “GASPAR Test 
Case 1—ICRP-2,” is the RG 1.109 value of 2.0 kg/m2. The allowable range for values in 
this field is greater than 0.0 kg/m2. 

• The garden vegetable crop yield is entered in kg/m2. The default value, also used in 
“GASPAR Test Case 1—ICRP-2,” is the RG 1.109 value of 2.0 kg/m2. The allowable 
range for values in this field is greater than 0.0 kg/m2. 

 Holdup and Transport Times 

The input parameters listed below are entered in the Holdup and Transport Times section of the 
Pathway Factors tab shown in Figure 4-27. All default values come from RG 1.109 and are also 
used in “GASPAR Test Case 1—ICRP-2.” For all fields, the allowable range of values is greater 
than 0.0 sec. The holdup and transport time parameters are as follows: 

• “Meat to consumption” is entered in seconds (sec), with the default value of 
1.73E+06 sec. 

• “Milk to the population” is entered in seconds, with the default value of 3.46E+05 sec. 

• “Vegetables to the population” is entered in seconds, with the default value of 
1.21E+06 sec. 

• “Vegetables to the individual” is entered in seconds, with the default value of 
5.18E+06 sec. 

• “Milk to the individual” is entered in seconds, with the default value of 1.73E+05 sec. 

• “Leafy vegetables to the individual” is entered in seconds, with the default value of 
8.64E+04 sec. 

• “Pasture grazing period” is entered in seconds, with the default value of 2.59E+06 sec. 

• “Feed storage time” is entered in seconds, with the default value of 7.78E+06 sec. 
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 Goat Feed to Milk Transfer Factors 

The Goat Feed to Milk Transfer Factors section displays the transfer factors for the elements 
listed in Table 4-3, in days per liter (d/L). Table 4-3 displays the default values from RG 1.109, 
which are also used in “GASPAR Test Case 1—ICRP-2.” The allowable range for values in 
each field is greater than 0.0 d/L. 

Table 4-3 Goat Feed to Milk Transfer Factors 

Element 
Transfer 
Factor 
(d/L) 

Element 
Transfer 
Factor 
(d/L) 

Element 
Transfer 
Factor 
(d/L) 

Hydrogen 0.17 Chlorine 0.50 Strontium 0.014 

Boron 0.012 Potassium 0.057 Iodine 0.06 

Carbon 0.10 Calcium 0.47 Cesium 0.30 

Magnesium 0.042 Iron 0.0013 Polonium 0.0018 

Phosphorus 0.25 Copper 0.013   

 Physical Parameters 

The input parameters listed below are entered in the Physical Parameters section of the 
Pathway Factors tab shown in Figure 4-27. All default values come from RG 1.109 and are also 
used in “GASPAR Test Case 1—ICRP-2,” except for the midpoint of the plant life, as discussed 
below. The physical parameters are as follows: 

• The midpoint of the plant life is entered in seconds, with the default value of 
6.31E+08 sec. This value corresponds to 20 years, which differs from the RG 1.109 
default value of 15 years and reflects the current 40-year operating license period for 
nuclear power plants. The allowable range for values in this field is greater than 
0.0 seconds. 

• The shielding factor for individuals is unitless, with the default value of 0.7. The allowable 
range for values in this field is 0.0 to 1.0. As used for the calculation, this factor is in the 
numerator, so its value should not exceed 1.0, where 1.0 would indicate no reduction for 
shielding. 

• The shielding factor for populations is unitless, with the default value of 0.5. The 
allowable range for values in this field is 0.0 to 1.0. 

• The hydrosphere water volume is entered in liters (L), with the default value in GASPAR 
(see NUREG/CR-4653) of 2.7E+19 L. The allowable range for values in this field is 
greater than 0.0 L. 
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• The volume of the atmosphere is entered in cubic meters (m3), with the default value in 
GASPAR (see NUREG/CR-4653) of 3.8E+18 m3. The allowable range for values in this 
field is greater than 0.0 m3. 

• The iodine deposition fraction is unitless, with the default value of 0.5. The allowable 
range for values in this field is greater than 0.0. 

 Transfer Factors 

To review and edit the transfer factors for meat, soil, and milk, select the “Transfer Factors” 
button shown in Figure 4-27 to open the Transfer Factors screen shown in Figure 4-28. To edit 
the transfer factor for an element, select the cell to be changed and type in the desired value. 
After any edits to the transfer factors, select the “Save” button to save the changes. Select the 
“Get Defaults” button to revert all transfer factors to their default values. When edits are 
complete, select the “Close” button; this will open the Question screen, as shown in Figure 4-28. 
Select the “Yes” button to return to the Pathway Factors tab shown in Figure 4-27. 

** User Note**—Remember that any changes made to the transfer factors will be carried 
forward for future runs. Defaults should be reset using the “Get Default” option. Also remember 
that saving a case/file will save all configurations and values selected for the case. Resetting to 
defaults will not affect any changes made for a particular case/file unless this file is again saved 
after values are changed back to defaults. Therefore, if there is any question about the saved 
values, it is best to reset to defaults before initiating a new case. 

 Page Defaults 

Select the “Page Defaults” button on the Pathway Factors tab shown in Figure 4-27 to return all 
pathway parameters in the GASPAR database to their default values. 

 

Figure 4-28 Transfer Factors Screen  
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4.2.7 Consumption Values Tab 

The Consumption Values tab, shown in Figure 4-29, presents the consumption and usage 
parameters for individuals and the overall population. This tab contains the Usage Parameters 
section (upper portion of tab) and the Intake Consumption Data section. The intake and 
consumption assumptions used in the code depend on the ICRP methodology (i.e., ICRP-2 
(default), ICRP-30, or ICRP-72) selected from the Dose Factors drop-down menu. The 
assumptions for ICRP-2 and ICRP-30 are taken from RG 1.109, and the assumptions for 
ICRP-72 are derived from the EPA’s EFH. 

** User Note **—For population doses, the average consumption rates are used in distributing 
the production across the different age groups, so that the appropriate DCF values for each age 
group can be applied. Population doses are not calculated for leafy vegetables, only for total 
vegetables. 

The Usage Parameters section contains the 2000 U.S. population and the fractions of the 
population comprising adults, teenagers, and children. The default value for the 2000 U.S. 
population is 2.8E+08. The default population fractions depend on the ICRP methodology 
(i.e., ICRP-2 (default), ICRP-30, or ICRP-72) selected from the Dose Factors drop-down menu. 
If the calculation is to be performed using ICRP-2 or ICRP-72 DCF values, the population 
fractions will be 0.71, 0.11, and 0.18 for adults, teenagers, and children, respectively. If using 
the ICRP-30 DCF values, the user should enter a population fraction of 1.00 for adults and 0.0 
for teenagers and children, since the ICRP-30 DCF values apply only to adults. 
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Figure 4-29 Consumption Values Tab 

• In the Intake Consumption Data section, the parameter values depend on the ICRP 
methodology selected. The ICRP-2 (default) and ICRP-30 values are from RG 1.109, 
and the ICRP-72 values are derived from the EPA’s EFH. The parameters in this section 
are as follows: 

• The Intake Type column displays either the maximum or the average consumption rate 
for each age group, depending on the ICRP methodology. 

• The maximum and average inhalation rates are displayed in cubic meters per year 
(m3/yr). The default values depend on the ICRP methodology. 

• The maximum and average vegetable intake rates are displayed in kg/yr, with the default 
values depending on the ICRP methodology. 

• The maximum and average leafy vegetable intake rates are displayed in kg/yr, with the 
default values depending on the ICRP methodology. 

• The maximum and average milk intake rates are displayed in kg/yr, with the default 
values depending on the ICRP methodology. 
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• The maximum and average meat intake rates are displayed in kg/yr, with the default 
values depending on the ICRP methodology. 

Select the “Save” button to save any changes. Select the “Usage Defaults” button to restore the 
maximum individual defaults. See appendix C to this manual for further discussion of the default 
intake and consumption assumptions for each ICRP methodology. 

** User Note**—Remember that any changes made to the consumption values will be carried 
forward for future runs. Defaults should be reset using the “Get Default” option. Also remember 
that saving a case/file will save all configurations and values selected for the case. Resetting to 
defaults will not affect any changes made for a particular case/file unless this file is again saved 
after values are changed back to defaults. Therefore, if there is any question about the saved 
values, it is best to reset to defaults before initiating a new case. 

4.3 Code Execution and Reports 

4.3.1 Executing GASPAR 

After all data for the GASPAR dose calculation have been entered, select the “Save” button, as 
shown in Figure 4-30, to save the data to the data set being used to create the input file, as well 
as to a file name if one has been created for the case. NRCDose3 will save the data to the 
GASPAR database, which will be used for the calculation. If a saved file (i.e., a *.GN3 file) is 
being used, it will also be updated. Select the “OK” button to save the data to the database file 
(for use in creating the input for the run) and, as applicable, to the open *.GN3 file. 

If the data are to be saved to a different *.GN3 database file, then open the File drop-down 
menu and select “Save to GN3 File…” as shown in Figure 4-3. This will open a Windows 
Explorer directory, as shown in Figure 4-31. Name the *.GN3 file and choose the directory 
location as desired. Future saves within NRCDose3 will save to this file name, as well as to the 
database used for code execution. 
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Figure 4-30 Saving GASPAR Inputs 

 

Figure 4-31 Windows Explorer Directory for Saving GASPAR Inputs to a New File 
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Select the “Create Input” button to activate the “View Input” and “Run GASPAR” buttons on the 
GASPAR module main screen, as shown in Figure 4-32. Select the “View Input” button to 
display the Text Viewer screen and review the text file of input data, as shown in Figure 4-34. 
Select the “Save As…” button to open a Windows Explorer directory and save the input as an 
input field file (*.GN3). Select the “Print” button to print the input text file, and the “Close” button 
to close the Text Viewer screen and return to the GASPAR module main screen. 

 

Figure 4-32 GASPAR Module Main Screen—“Create Input” Button 
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Figure 4-33 Viewing GASPAR Input—Text Viewer Screen 

Select the “Run GASPAR” button to execute the code and generate the output report. This will 
also activate the “View Output,” “FSAR Report,” and “Supplemental Report” buttons on the 
GASPAR module main screen, as shown in Figure 4-34. After NRCDose3 completes the 
GASPAR dose calculation, the output will appear as a text output file, as shown in Figure 4-35. 
Select the “Save As…” button shown in Figure 4-35 to open a Windows Explorer directory and 
save the output as a text file (*.txt). Select the “Print” button to print the output text file, and the 
“Close” button to close the Text Viewer screen and return to the GASPAR module main screen. 
The user can also access the output text file by selecting the “View Output” button. 

  



 

4-38 

 

Figure 4-34 GASPAR Module Main Screen—“Run GASPAR” Button 

 

Figure 4-35 Viewing GASPAR Output—Text Viewer Screen 
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** User Note **—Though it is not required, users should consider saving GASPAR files in a 
user-specified directory other than the NRCDose3 directory, so that future users can access 
and share the files without having to navigate to the NRCDose3 directory. 

4.3.2 GASPAR Reports 

GASPAR creates two additional reports: the FSAR Input Report and the Supplemental Report. 
As shown in Figure 4-36, the FSAR Input Report consolidates the input data and dose 
calculations into a single text report that provides the information considered most important for 
the preparation and review of results for licensing documents. Select the “Save As…” button 
shown in Figure 4-36 to open a Windows Explorer directory and save the FSAR Input Report 
output as a text file (*.txt). Select the “Print” button to print the FSAR Input Report, and the 
“Close” button to close the Text Viewer screen and return to the GASPAR module main screen. 

 

Figure 4-36 GASPAR FSAR Input Report Screen 

As shown in Figure 4-37, the Supplemental Report provides additional documentation of the 
modeling assumptions used for the calculations, such as exposure, transfer factors, and various 
pathway constants. Select the “Save As…” button shown in Figure 4-33 to open a Windows 
Explorer directory and save the Supplemental Report output as a text file (*.txt). Select the 
“Print” button to print the Supplemental Report, and the “Close” button to close the Text Viewer 
screen and return to the GASPAR module main screen. 
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Figure 4-37 GASPAR Supplemental Report Screen 

** User Note **—Only one report is viewable at a time. A report may be either printed or saved 
as a text file, which can then be further edited or saved in different formats using standard text 
editor functions. 
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5.0 XOQDOQ 
The XOQDOQ module within NRCDose3 executes a modified version of the XOQDOQ Fortran 
code. This update to the NRCDose code has not changed the basic calculation methods 
(algorithms) of XOQDOQ, as described in NUREG/CR-2919. However, significant changes 
have been made to the data management and operation to support the expanded capabilities of 
NRCDose3. XOQDOQ calculates the relative atmospheric dispersion (X/Q) and relative 
atmospheric deposition (D/Q) values at locations specified by the user, for various standard 
radial distances and downwind direction sectors. The model is based on a straight-line 
Gaussian model, and the code can account for variation in the location of release points, 
additional plume dispersion due to building wakes, plume depletion through dry deposition and 
radioactive decay, and nonstraight trajectories. 

The following sections discuss the steps for using XOQDOQ in NRCDose3. The user is directed 
to NUREG/CR-2919 for the XOQDOQ Fortran code user guide and technical bases, which 
discuss in detail the assumptions, limitations, and methods of the XOQDOQ code. 

To open the XOQDOC module, select the “XOQDOQ Annual Average Meteorological 
Dispersion and Deposition” button, shown in Figure 5-1, on the NRCDose3 main selection 
screen. This will open the XOQDOQ module main screen, shown in Figure 5-2. 

 

Figure 5-1 NRCDose3 Main Selection Screen (XOQDOQ Module) 
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Figure 5-2 XOQDOQ Module Main Screen 

The XOQDOQ module main screen opens with the case data last saved in the database. It 
contains three main functional areas for entering data and performing XOQDOQ dispersion and 
deposition calculations: (1) the toolbar and initial setup area, (2) the data input tabs, and 
(3) code execution and reports. The following sections discuss these areas and describe the 
options and capabilities in each. 

5.1 Toolbar and Initial Setup 

As shown in Figure 5-2, this portion of the XOQDOQ module main screen contains three tools 
and one initial setup input field: the File, Quit, and About tools, and the Main Title field. 

5.1.1 File Tool 

The File tool provides the functionality for managing the XOQDOQ files, as shown in Figure 5-3. 
The File drop-down menu offers the following options: 

• New—Select this option to begin a new XOQDOQ case. This will clear any 
previously entered information from the database. 

• Open XN3 File—Select this option to access and open a *.XN3 file previously 
created with NRCDose3. 
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• Open Legacy Input File—Select this option to open a Windows Explorer directory 
and navigate to an XOQDOQ legacy *.dat file. This option allows a user to load input 
files created in text format for use with the original XOQDOQ Fortran code. If the 
user opens a legacy file, the file structure will already be in the format needed for 
running the code. There is no need to create input; simply select the “Run XOQDOQ” 
button. The input screens and options in NRCDose3 cannot be used to edit or 
update a legacy file. To edit a legacy file, use a text editor, following the format and 
file structure described in NUREG/CR-2919, and save the file as a *.dat file for future 
use. 

• Save to Database—Select this option to save the current case to the database. 
When XOQDOQ is opened with “Current Project” selected, the information in the 
database, as last saved before exiting, will populate all XOQDOQ screens and 
windows. 

• Save to XN3 File—Select this option to save the completed case to a *.XN3 file, for 
later use or for sharing with others. 

• Delete—Select this option to open an Explorer window that will allow the user to 
delete any previously saved *.XN3 files. 

 

Figure 5-3 XOQDOQ Toolbar with File Drop-down Menu 
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5.1.2 Quit Tool 

The Quit tool allows the user to terminate the operation of the XOQDOQ module. When the Quit 
tool is selected, the Question prompt screen (shown in Figure 5-4) will be displayed to verify that 
the user wants to exit the module. Select the “Yes” button to terminate the XOQDOQ module 
without saving any changes to the data not previously saved. To save changes (to the database 
and/or a *.XN3 file) before quitting, select the “No” button, then choose the appropriate entry 
from the File drop-down menu. 

 

Figure 5-4 XOQDOQ Module Quit Tool Screen 

5.1.3 About Tool 

Selecting the About tool brings up the About XOQDOQ screen shown in Figure 5-5, which 
displays information about XOQDOQ. Select the “OK” button to return to the XOQDOQ module 
main screen shown in Figure 5-2. 

 

Figure 5-5 About XOQDOQ Screen 

5.1.4 Main Title Field 

In the Main Title field, enter a title for the XOQDOQ calculation. This is a descriptive text field 
limited to 80 characters. The title should help users identify, for example, the facility/site, the 
period of record of the meteorological input data, and the release point. As shown in Figure 5-2, 
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the example scenario included in the NRCDose3 installation (in the installation directory, that 
is, C:/NRCDose3) is entitled “NRC NUREG-CR-2919 Test Case 1.” 

5.2 Data Input Tabs 

The two XOQDOQ data input tabs, shown in Figure 5-2, are (1) Options/Parameters and 
(2) Met Data. 

It is recommended, though not required, that the user enter the necessary case parameters and 
data into the data input tabs in the order in which they are listed. 

5.2.1 Options/Parameters Tab 

The Options/Parameters tab is used to enter various parameters for the XOQDOQ calculations. 
The tab includes the Options section (left-hand side) and the Parameters section (right-hand 
side), as shown in Figure 5-6. Refer to NUREG/CR-2919 and Table B-3 of appendix B to this 
manual for more information on the inputs in this tab. 

 

Figure 5-6 Options/Parameters Tab 

 Options 

As shown in Figure 5-6, the following check boxes appear in the Options section of this tab: 
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• Compute Sector Spread to Compare to Centerline Values in Purge Calcs—Select this 
option to distribute the associated X/Q values across the entire width of the downwind 
sector. The default value should be checked, as in the example case, “NRC 
NUREG-CR-2919 Test Case 1.” The option is normally checked in program execution 
(see KOPT (3) in NUREG/CR-2919). 

• Plot short-term X/Q values—Select this option to plot short-term X/Q values versus 
probability of occurrence. The value from the example case, “NRC NUREG-CR-2919 
Test Case 1,” for this option is unchecked. The option is normally unchecked in 
program execution (see KOPT (4) in NUREG/CR-2919). 

• Use Cubic Spline in Lieu of Least Squares Function for Intermittent Release 
Distribution—Select this option to use a cubic spline in lieu of a least squares function for 
fitting an intermittent-release distribution. The value from the example case, “NRC 
NUREG-CR-2919 Test Case 1,” for this option is unchecked. The option is normally 
checked in program execution (see KOPT (5) in NUREG/CR-2919). 

• Correct Χ/Q D/Q values for open terrain recirculation—Select this option to use the 
default correction for open terrain recirculation, based on Figure 3.2 of 
NUREG/CR-2919. If both this option and “Use site specific terrain recirculation data” 
(next option) are unchecked, then the calculations will include no recirculation. The 
value from “NRC NUREG-CR-2919 Test Case 1” for this option is checked, but its use 
should be based on site-specific conditions (see KOPT (8) in NUREG/CR-2919). 

• Use site specific terrain recirculation data—When using site-specific recirculation factors, 
check this option, and uncheck the option for “Correct X/Q D/Q values for open terrain 
recirculation.” Recirculation correction factors will be based on the information entered in 
the Parameters section under “Number of distances of site-specific correction factors for 
recirculation.” Otherwise, both the site-specific and the default recirculation values will be 
applied. When entering the site-specific terrain recirculation factors, the user must 
provide values for all 16 downwind direction sectors. If the recirculation factor for a given 
sector and distance is left at zero, then XOQDOC will calculate dispersion and 
deposition values of zero for that sector and distance. The value from the example case, 
“NRC NUREG-CR-2919 Test Case 1,” for this option is unchecked, but its use should 
be based on site-specific conditions and the availability of site-specific recirculation 
factors (see KOPT (9) in NUREG/CR-2919). 

• Use desert sigma curves—Select this option to use desert sigma curves for continuous 
ground-level releases in a desert environment. Desert sigma curves include the effect of 
plume meander. The value from the example case, “NRC NUREG-CR-2919 Test 
Case 1,” for this option is unchecked. The option is normally unchecked in program 
execution (see KOPT (10) in NUREG/CR-2919). 

Some options are hard-coded into XOQDOQ and are not adjustable by the user. One such 
option is the output of X/Q and D/Q values for each radial segment, discussed and identified as 
KOPT (6) in NUREG/CR-2919. In NRCDose3, the output always provides the X/Q and D/Q 
values for all radial segments. Similarly, if special receptor locations have been identified, the 
output will always provide the X/Q and D/Q values for those locations (KOPT (7) in 
NUREG/CR-2919). The option for uneven sector sizes (KOPT (11) as described in 
NUREG/CR-2919) is also not adjustable and is not used in the Fortran code calculations. Refer 
to appendix B to this manual for more information. 
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 Parameters 

In the Parameters section, the user can enter the factors that influence how the release will be 
characterized. The “Increment for which plotted results are printed out” field defaults to 
15 percent and is used in computing the X/Q values for a purge release. As shown in 
Figure 5-6, the following inputs appear in the Parameters section: 

• Number of distances with terrain data for each sector—For this parameter, enter the 
number of distances from the plant that have terrain data to be entered. The value from 
the example case, “NRC NUREG-CR-2919 Test Case 1,” is 3. If this option is selected, 
a numerical value must be entered in this field. 

** User Note **—Do not enter a value greater than 10 for the number of distances with terrain 
data. 

• Next, select the “Heights” button to open the Terrain Height Values screen, as shown in 
Figure 5-7, and enter the terrain height and distance in meters for each downwind 
direction sector. Select the “Save” button when the terrain heights and distances for all 
16 sectors have been entered. If the plant elevation is set to zero on the Met Data tab 
(see Section 5.2.2), then the terrain height and distance values are in meters. If the plant 
elevation is set to a value greater than zero, then the distances are in miles from the 
plant release point, and the terrain height is in feet above sea level (Figure 5-7). 

** User Note **—If the user changes the plant elevation so as to cause the units for terrain data 
to change, any previously entered terrain values will not be adjusted to reflect the change in 
units. 

 

Figure 5-7 Terrain Height Values Screen 
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• Increment for which plotted results are printed out—This parameter specifies the level of 
short-term X/Q percentile values to be used. The value from the example case, “NRC 
NUREG-CR-2919 Test Case 1,” is 5 percent, and the allowable range for values in this 
field is greater than 0.0 percent. This feature applies to purge releases. See Section 4.4 
of NUREG/CR-2919 for a more detailed explanation of this parameter. 

• Number of titles of receptor types—Enter the number of receptor types that will be used 
in the XOQDOQ analysis. Typically, there are three receptor points: “Residence,” 
“Garden,” and “Site Boundary.” However, the user can define fewer receptor points or 
add more as needed. The value from the example case, “NRC NUREG-CR-2919 Test 
Case 1,” is 3, and the allowable range for values in this field is between 1 and 30 
receptor points. After entering the number, select the “Define” button to open the 
Receptor Types screen shown in Figure 5-8. For each receptor type, enter the title and 
location, then select the “Define” button to open the Receptor Locations screen shown in 
Figure 5-8. On the Receptor Locations screen, select the direction from among the 16 
direction sector options in the drop-down menu, and enter the distance in meters. Then 
select the “Save” button to return to the Options/Parameters tab. 

 

Figure 5-8 Receptor Types and Receptor Locations Screens 

• Number of Release Exit Points—Enter the number of release exit points to be modeled 
using XOQDOQ. The value from the example case, “NRC NUREG-CR-2919 Test 
Case 1,” for this option is 2, and the allowable range for values in this field is between 1 
and 5 release points. Select the “Details” button to open the Location Selection screen 
shown in Figure 5-8, which allows the user to enter a descriptive title for each release 
point. 
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Figure 5-9 Location Selection and Release Point Data Screens 

• Select (highlight) the release point and the “Edit” button to open the Release Point Data 
screen shown in Figure 5-9. 

• Release Point Title—In this text field, shown in Figure 5-9, enter a descriptive title for the 
release point. 

• Vent/Stack Average Velocity—Enter the average velocity of the effluent from the plant 
vent or stack in meters per second (m/s). The allowable range for values in this field is 
greater than 0.0 m/s. 

• Vent/Stack Inside Diameter—Enter the inside diameter of the plant vent or stack in 
meters. The allowable range for values in this field is greater than 0.0 m. 

• Release Point Height—Enter the height of the release point from the plant vent or stack, 
in meters. The allowable range for values in this field is greater than 0.0 m. 

• Height of Vent’s/Stack’s Bldg—Enter the height of the building containing the plant vent 
or stack, in meters above plant grade. The allowable range for values in this field is 
greater than 0.0 m. 

• Minimum cross-sectional area for Vent’s/Stack’s Bldg—Enter the minimum 
cross-sectional area of the building with the plant vent or stack in square meters (m2). 
The allowable range for values in this field is greater than 0.0 m2. 

• Wind Height used for the vent/stack Elevated Release—Enter the wind height used for 
an elevated plant vent or stack release, in meters. The allowable range for values in this 
field is greater than 0.0 m. 

• Vent/Stack heat emission rate—Enter the heat emission rate of the plant vent or stack in 
calories per second (cal/s). The allowable range for values in this field is greater than 
0.0 cal/s. Normally, this value should be 0 for power plants. Section 4.20 of 
NUREG/CR-2919 discusses when this parameter may need to be adjusted. 
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• Purges—From the drop-down menu options, select whether there are purges. The 
drop-down menu options, shown in Figure 5-9, are “No Purge” and the purge options of 
“Decay 1,” “Decay 2,” and “Decay 3.” The “Number of intermittent releases” and 
“Average number of hours per intermittent release” options are deactivated if “No Purge” 
is selected, and activated if “Decay 1,” “Decay 2,” or “Decay 3” is selected. In the latter 
case, enter the number of intermittent releases and the average number of hours per 
release. “Decay 1,” “Decay 2,” and “Decay 3” correspond to the Card Type 4 
(i.e., DECAY(1), DECAY(2), and DECAY(3)) options in the XOQDOQ Fortran code; 
each of them represents a different way of handling decay. Typically, for “Decay 1” 
(DECAY(1)), no decay is considered; this is the standard choice. For “Decay 2” 
(DECAY(2)), a 2.26-day decay is considered, and for “Decay 3” (DECAY(3)), an 8-day 
decay (with deposition through depletion) is considered. This decay is only for the 
calculation of the short-term X/Q values and does not affect the long-term dispersion 
calculations as shown in the sector tables or for special locations. 

** User Note **—If a release point is deleted on the Location Selection screen shown in 
Figure 5-9, the number of release points identified on the Options/Parameters tab will 
automatically be updated. 

• Number of distances of site-specific correction factors for recirculation—As noted in 
Section 5.2.1.1, this option is activated when the user selects (checks) the “Use site 
specific terrain recirculation data” option in the Options section of the 
Options/Parameters tab. Enter the number of distances of site-specific correction factors 
for recirculation. (This value must be between 1 and 10.) Then select the “Corrections…” 
button to open the Distance Corrections screen shown Figure 5-10. For each distance, 
enter the distance in meters and the correction factor for each of the 16 direction 
sectors. Each value entered must be greater than 1.0. This is because each value is 
used as a direct multiplier in the dispersion and deposition calculations; therefore, an 
entry less than 1.0 will cause a proportional reduction, and an entry of zero will yield 
values of zero for X/Q and D/Q. Select “Save” when data have been entered for all 
distances. 
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Figure 5-10 Distance Corrections Screen 

• Building Wake Constant—In the example case, “NRC NUREG-CR-2919 Test Case 1,” 
the value of the building wake constant is 0.5; the allowable range for values in this field 
is greater than 0.0. If desired, the building wake constant can be changed from the 
default value. However, it should not be changed without supporting dispersion and 
building dimension data. If it is changed, a warning window will open as shown in 
Figure 5-11, stating, “For regulatory submittals to the NRC, an applicant is expected to 
provide technical justification for using an alternate value for the building wake constant.” 
Select the “OK” button to acknowledge this warning and return to the 
Options/Parameters tab. 

 

Figure 5-11 Building Wake Constant Warning Window 
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5.2.2 Met Data Tab 

The Met Data tab is used to enter the meteorological information and data parameters needed 
for XOQDOQ to determine the relative dispersion (X/Q) and relative deposition (D/Q) values. As 
shown in Figure 5-12, the tab includes a section for inputs and options (upper portion) and a 
joint frequency distribution (JFD) table (lower portion). The inputs and options are as follows (for 
more information about them, see NUREG/CR-2919): 

• Distribute calms as first wind-speed class—Select this option to distribute calms as the 
first windspeed class; this activates the “Number of hours, or percent, of calm for each 
stability category” input fields. The value from the example case, “NRC 
NUREG-CR-2919 Test Case 1,” for this option is checked. 

• Input joint frequency distribution data as percent frequency—Select this option to change 
the units of the JFD for each stability class from hours to percent. The value from the 
example case, “NRC NUREG-CR-2919 Test Case 1,” for this option is unchecked. 

 

Figure 5-12 Met Data Tab 
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• Number of velocity categories—In this field, enter the number of velocity categories. The 
value from the example case, “NRC NUREG-CR-2919 Test Case 1,” for this field is 5, 
and the allowable range for values in this field is between 1 and 14. Consistent with NRC 
guidance, it is desirable to have finer resolution (i.e., more windspeed classes) in 
summarizing windspeed data for the lower windspeed classes. Select the “Max Wind 
Speeds…” button to open the Maximum Wind Speeds screen shown in Figure 5-13. 
(Before doing so, the user should make sure that the desired units of measure—either 
miles per hour (mph) or meters per second (m/sec)—are selected for the “Wind speed 
class units” option. These units will be applied to all velocity categories and need to be 
consistent with the units of measure in the JFD table.) Select the “Save” button on the 
Maximum Wind Speeds screen to save any changes to the database. 

 

Figure 5-13 Maximum Wind Speeds Screen 

• Number of stability categories—In this field, enter the number of stability categories. The 
value from the example case, “NRC NUREG-CR-2919 Test Case 1,” for this field is 7, 
and the allowable range for values in this field is between 1 and 7. 

** User Note **—As described in RG 1.111, the NRC uses seven stability classes (A through 
G), which are based on vertical temperature differences as in RG 1.23, Revision 1, 
“Meteorological Monitoring Programs for Nuclear Power Plants,” issued March 2007 [Ref. 25]. 
By contrast, the EPA recognizes just six classes (A through F) and allows for several 
approaches to categorization. 

• Wind speed class units—Select the windspeed class option in either mph or m/sec. This 
will simultaneously change the units for the entries in the JFD table and for the “Number 
of hours, or percent, of calm for each stability category” input fields. The value from the 
example case, “NRC NUREG-CR-2919 Test Case 1,” for this option is m/sec. 
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• Number of hours, or percent, of calm for each stability category—Enter either the 
number of hours or the percentage of calm for each stability category. 

• Height (above ground level) of the measured wind presented in the joint frequency 
data—Enter the height (above ground level) of the measured windspeed, in meters. For 
ground-level or elevated/ground-level mixed release, use winds at the 10 m level. The 
value from the example case, “NRC NUREG-CR-2919 Test Case 1,” for this parameter 
is 10 m, and the allowable range for values in this field is greater than or equal to 0.0 m. 

• Plant grade elevation (above sea level)—Enter the plant elevation in meters 
(NUREG/CR-2919 calls for feet). As discussed in Section 5.2.1.2, if the plant elevation is 
set to zero, then the terrain height and distance range values will be in meters. If the 
plant elevation is set to a value greater than zero, then the distance ranges will be given 
in miles from the plant release point, and the terrain height will be given in feet above 
sea level. The value from the example case, “NRC NUREG-CR-2919 Test Case 1,” for 
this option is 0.0 m, and the allowable range for values in this field is greater than or 
equal to 0.0 m. 

• Half-lives used in Χ/Q calculations (days)—Enter the half-lives to be used in the Χ/Q 
calculations, in days, for the three decay and depletion parameters. Typically, these 
should not be changed from the default values: 

 101 days for “Undecayed, Undepleted” 

 2.26 days for “Decayed, Undepleted” 

 −8.00 days for “Decayed, Depleted” 

** User Note **—The default values are used in the XOQDOQ Fortran code to control certain 
functions and the decay time. Any value over 100 for “DECAY(1)” is used to designate that 
there is no decay and no depletion, as reflected in the option “Undecayed, Undepleted.” The 
value for DECAY(2), with a default of 2.26 days, reflects decay during transport and is used for 
the “Decayed, Undepleted” option. The DECAY(3) value of −8.00 days reflects a decay of 
8 days, as well as a plume depletion, and is used for the “Decayed, Depleted” option. 
NUREG/CR-2919 contains more information on these values. To ensure the correct use of the 
XOQDOQ results by GASPAR II, these values should not be changed. 

In the lower portion of the Met Data tab, as shown in Figure 5-12, the user can enter data in the 
JFD table. To enter data manually, select (highlight) the desired stability class (from Class A 
through Class G), and enter either the number of hours or the percentage that the wind blows in 
each of the 16 downwind sectors. Repeat this process for each stability class up to Class G. 

Alternatively, JFD data can be imported into XOQDOQ from a file generated by either MS Excel 
or the NRC’s METQA application. To import JFD data from an MS Excel file, select the “Import 
JFD Data (EXCEL)” button. This will open the windows shown in Figure 5-14. Select the “Yes” 
button on the Check screen to open the Met Data Import screen. Then double-click on the Input 
File field to open Windows Explorer and navigate to the directory containing the file to be 
imported. Select the “Open” button to enter the file in the Input File field. Finally, select the 
“Import” button to import the file. 

To import JFD data generated by METQA, select the “Import JFD Data (METQA)” button, then 
follow the same steps as for importing from an MS Excel file. METQA is an internal (NRC) 



 

5-15 

application (currently at version 2.0) implementing the guidance in NUREG-0917, “Nuclear 
Regulatory Commission Staff Computer Programs for Use with Meteorological Data,” issued 
July 1982 [Ref. 26]. Output from METQA is used in evaluating the quality and completeness 
(i.e., data recovery) of the parameters measured by an applicant’s or licensee’s onsite 
meteorological monitoring program. METQA generates meteorological data inputs for 
atmospheric dispersion models such as XOQDOQ, which are suitable for use with NRCDose3. 
In practice, many applicants and licensees have adapted and expanded the guidance in 
NUREG-0917, which is primarily related to quality assurance, to suit their own internal quality 
assurance practices and procedures and meteorological monitoring programs. 

The JFD portion of the XOQDOQ input file, whether entered manually or imported from a 
suitable file (from MS Excel or METQA), must conform to the formatting requirements specified 
in NUREG/CR-2919 (see Card Type 6 in that guidance). The JFD data are organized in an 
array according to wind direction, windspeed range, and atmospheric stability class. The seven 
stability classes range from extremely unstable (Class A) through extremely stable (Class G). 

Each row of the array has 16 entries, corresponding to the 16 standard wind direction sectors 
(N, NNE, NE, and so on, proceeding clockwise through NNW). Each entry represents the 
frequency of occurrence for a particular sector, windspeed range, and stability class; it is 
entered either as a number of hours or as a percentage relative to the total number of hours in 
the meteorological data set, depending on the option selected in the Met Data tab. The data set 
used to generate the JFD may consist of 1 year (i.e., one annual cycle) of measurements 
(i.e., as many as 8,760 hours if no values are missing), or it may be a composite of multiple 
years (annual cycles) of measurements. 

The sequence of rows in the array is as follows. The first row contains data for the first stability 
class (Class A) and the first windspeed range. The second row contains data for the same 
stability class and the next windspeed range, and so on until all windspeed ranges for the first 
stability class have been covered. The array then covers all of the windspeed ranges in turn for 
the second stability class, then the third, and so on through the last stability class. The number 
of windspeed ranges for each stability class is user-specified, up to a maximum of 14. 

As shown infigure 5-14, the JFD entries begin on the fifth row (the first four rows are generated 
by METQA); frequency values appear on 91 rows, representing 13 windspeed groups for each 
of the seven stability classes. Therefore, an XOQDOQ run under NRCDose3 would require 
1,456 frequency entries (16 in each row) as input data for a new JFD. 
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Figure 5-14 Importing JFD Information 

Selecting the “Clear” button shown in Figure 5-12 opens the Clear Grid JFDs screen shown in 
Figure 5-15. Select the “Yes” button, as shown in Figure 5-15, to clear all JFD table information 
from the Met Data tab. 

 

Figure 5-15 Clear Grid JFDs Screen 

5.3 Code Execution and Reporting 

After all data for the XOQDOQ calculation have been entered, select the “Save” button, as 
shown in Figure 5-16, to save the data to the data set being used to create the input file, as well 
as to a file name if one has been created for the case. NRCDose3 will save the data to the 
XOQDOQ database, which will be used for the calculation. If a saved file (i.e., a *.XN3 file) is 
being used, it will also be updated. Select the “OK” button to save the data to the database file 
(for use in creating the input for the run) and, as applicable, to the open *.XN3 file. 



 

5-17 

 

Figure 5-16 Saving XOQDOQ Inputs 

If the data are to be saved to a different *.XN3 database file, then open the File drop-down 
menu and select “Save to XN3 File…” as shown in Figure 5-3. This will open a Windows 
Explorer directory, as shown in Figure 5-17. Name the *.XN3 file and choose the directory 
location as desired. Future saves within NRCDose3 will save to this new file name, as well as to 
the database used for code execution. 
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Figure 5-17 Windows Explorer Directory for Saving XOQDOQ Inputs to a New File 

** User Note **—If XOQDOQ is being run from an open or saved file, then selecting “Save” will 
save both to the data set being used to create the input and to the file name. Otherwise, “Save” 
will save only to the data set being used to create the input, as no file name has been identified. 

Selecting the “Create Input” button will open the Check screen shown in Figure 5-18; select the 
“Yes” button to continue. Selecting the “Create Input” button will also have activated the “View 
Input” and “Run XOQDOQ” buttons on the XOQDOQ module main screen, as shown in 
Figure 5-19. Select the “View Input” button to display the Text Viewer screen and review the text 
file of input data, as shown in Figure 5-20. Select the “Save As…” button to open a Windows 
Explorer directory and save the input as an input field file (*.DT3). Select the “Print” button to 
print the input text file, and the “Close” button to close the Text Viewer screen and return to the 
XOQDOQ module main screen. 

 

Figure 5-18 XOQDOQ Check Screen 
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Figure 5-19 XOQDOQ Module Main Screen—“Create Input” Button 
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Figure 5-20 Viewing XOQDOQ Input—Text Viewer Screen 
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Figure 5-21 XOQDOQ Module Main Screen—“Run XOQDOQ” Button 

Select the “Run XOQDOQ” button to execute the code and generate the output report. This will 
also activate the “View Output” and “Create Alternate X/Q and D/Q Input” buttons on the 
XOQDOQ module main screen, as shown in Figure 5-21. After NRCDose3 completes the 
XOQDOQ calculation, the output will appear as a text output file, as shown in Figure 5-22. 
Select the “Save As…” button shown in Figure 5-22 to open a Windows Explorer directory and 
save the output as a text file (*.txt). Select the “Print” button to print the output text file, and the 
“Close” button to close the Text Viewer screen and return to the XOQDOQ module main screen. 
The user can also access the output text file by selecting the “View Output” button. 

** User Note **—Though it is not required, users should consider saving XOQDOQ files in a 
user-specified directory other than the NRCDose3 directory, so that future users can access 
and share the files without having to navigate to the NRCDose3 directory. 
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Figure 5-22 Viewing XOQDOQ Output—Text Viewer Screen 

Select the “Create Alternate X/Q and D/Q Input” button to create an input file containing the 
alternate meteorological data (i.e., dispersion and deposition results) for use in GASPAR II. 
Note that if the value in the “Number of release exit points” field is greater than 1, the popup 
message “Cannot create alternative met data file with more than one release point!” will appear 
(see Figure 5-23). If the number of release exit points is 1, then selecting the “Create Alternate 
X/Q and D/Q Input” button will open the Alt Met Input screen shown in Figure 5-24. Here, select 
(highlight) up to five individual records from the specific points of interest, then select the “OK” 
button to view the GASPAR II input file, as shown in Figure 5-24. 

  



 

5-23 

 

Figure 5-23 XOQDOQ Module Main Screen—“Create Alternate X/Q and D/Q Input” 
Button 
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Figure 5-24 Alt Met Input Screen 

 

Figure 5-25 Viewing Alternate Meteorological Input—Text Viewer Screen 
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Select the “Save As…” button shown in Figure 5-25 to open a Windows Explorer directory and 
save the output in a text file format suitable for use by XOQDOQ as an alternate meteorological 
data input file (*.DT3). Select the “Print” button to print the output text file, and the “Close” button 
to close the Text Viewer screen and return to the XOQDOQ module main screen. The user can 
also access the output text file by selecting the “View Alternate Input” button. 
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6.0 SIGNIFICANT REVISIONS IN NRCDose3 
The previously released NRC versions of the LADTAP II and GASPAR II Fortran codes, along 
with the CNS versions of NRCDose, all used the same DCF library. This library included DCF 
values for 170 radionuclides, four age groups, and seven organs. These DCF values were all 
based on the ICRP-2 methodology but came from various sources. They were primarily taken 
from RG 1.109, with many updated based on NUREG-0172, “Age-Specific Radiation Dose 
Commitment Factors for a One-Year Chronic Intake,” issued November 1977 [Ref. 27]. Some of 
the DCF values for strontium-90, holmium-166m, lead-210, thorium-229, and thorium-232 were 
updated based on the errata in the Battelle memorandum, “Changes and Corrections for 
NUREG-0172,” issued August 1983 [Ref. 28]. Other DCF values, notably some transuranic 
organ (i.e., bone and liver) DCF values, were taken from EMP-155, “Review and Expansion of 
USNRC Regulatory Guide 1.109 Models for Computing Dose Conversion Factors,” issued 
February 1983 [Ref. 29]. 

NRCDose3 retains the DCF libraries used in LADTAP II, GASPAR II, and NRCDose 
(version 2.3.20) in their original forms, as previously released. It can also calculate external skin 
exposure from water submersion, for which the DCF libraries in the original LADTAP II code did 
not contain the necessary values. In addition, NRCDose3 allows the user to select updated DCF 
values for dose calculations, notably those based on the ICRP-30 and ICRP-72 methodologies. 
NRCDose3 includes DCF values for a total of 203 radionuclides, encompassing all 
radionuclides appearing in the original LADTAP II and GASPAR II DCF library references from 
RG 1.109, NUREG-0172 (and errata), and EMP-155. 

6.1 ICRP-30 DCF Values 

The software package Radiological Toolbox (RadToolbox), version 3.0 
(https://ramp.nrc-gateway.gov/), was used to obtain the ICRP-30 DCF values for NRCDose3. 
These values are used for occupational exposures and apply only to adults, so NRCDose3 
calculates only adult doses if the ICRP-30 methodology is selected. 

For some ingestion radionuclides and nearly all inhalation radionuclides, multiple sets of DCF 
values are available. For ingestion, the DCF values depend on the assumed f1 value. For 
inhalation, there are different DCF values corresponding to the day (D), month (M), and year (Y) 
clearance classes in ICRP-30. NRCDose3 allows the user either to select the form and the 
corresponding DCF to be used for each radionuclide, or simply to use the default form. To 
determine the default chemical forms, the radionuclides are generally assumed to be in oxide 
form, because contamination in reactor coolant systems (the source of most nuclear power 
plant effluent releases) is commonly found in oxide form. Nuclear fuel is also in oxide form, and 
corrosion products activated in the core are incorporated in extra-core oxides. Therefore, all 
radionuclides are assumed to be oxides. Table 3, “Gastrointestinal Absorption Fractions (f1) and 
Lung Clearance Classes for Chemical Compounds,” in EPA Federal Guidance Report No. 11 
“Limiting Values of Radionuclide Intake and Air Concentration and Dose Conversion Factors for 
Inhalation, Submersion, and Ingestion” (FGR 11), issued September 1988 [Ref. 30], was 
consulted to determine the ingestion and lung clearance class for the oxide form of each 
element, as either days (D), weeks (W), or years (Y). That form has been identified as the 
default class in ICRP-30. 

Changes were also made to the external DCF values used when ICRP-30 is selected in 
NRCDose3. For air submersion, the total body and skin DCF values are taken from FGR 12. 
FGR 12 does not include DCF values for krypton-89 and xenon-137, so these were obtained 

https://ramp.nrc-gateway.gov/
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from the U.S. Department of Energy (DOE) report DOE/EH-0070, “External Dose-Rate 
Conversion Factors for Calculation of Dose to the Public,” issued July 1988 [Ref. 31]. The 
gamma air and beta air DCF values have not been changed from the values based on 
RG 1.109 that were used in the original release of LADTAP II and GASPAR II. 

FGR 12 was used for the DCF values for external exposure from ground contamination or water 
submersion, for both skin dose and effective dose, based on the ICRP-26 methodology. For 
these DCF values, contributions from progeny radionuclides were included, as shown in 
Table 6-1. 

Table 6-1 Radionuclides with Included Progeny for External DCF Values Based on 
ICRP-26 

Radionuclide 
Progeny 

Contribution 
Included 

Radionuclide 
Progeny 

Contribution 
included 

Radionuclide 
Progeny 

Contribution 
Included 

Br-83 Kr-83m Ru-106 Rh-106 I-131 Xe-131m 

Zr-95 Nb-95m Ag-110m Ag-110 I-133 Xe-133m 

Zr-97 Nb-97m Sb-126m Sb-126 I-135 Xe-135m 

Ru-103 Rh-103m Te-133m Te-133 Cs-137 Ba-137m 

    Ce-144 Pr-144m 

6.2 ICRP-72 DCF Values 

The software package RadToolbox version 3.0 (https://ramp.nrc-gateway.gov/) was used to 
obtain the ICRP-72 DCF values for NRCDose3. The ICRP-72 DCF values cover six age groups 
(Newborn, 1 yr, 5 yr, 10 yr, 15 yr, and Adult). NRCDose3 calculates values for all six age groups 
when the ICRP-72 methodology is selected. 

As with ICRP-30, multiple sets of ICRP-72 DCF values are available for some ingestion 
radionuclides and nearly all inhalation radionuclides. For ingestion, the DCF values depend on 
the assumed f1 value. For inhalation, there are DCF values corresponding to fast (F), medium 
(M), and slow (S) inhalation classes, plus a vapor form (V) in some instances. NRCDose3 
allows the user either to select the form of each radionuclide to be used, or simply to use the 
default form. Section 6.1 describes how the default form of each radionuclide was determined. 
The D/W/Y lung clearance classes were directly correlated to the ICRP-72 F/M/S inhalation 
classes. For hydrogen-3 (tritium) and carbon-14, the vapor forms of tritium oxide (HTO) and 
carbon dioxide (CO2), respectively, were selected. 

Changes were also made to the external DCF values used when ICRP-72 is selected in 
NRCDose3. For air submersion, the total body and skin DCF values for the applicable noble 
gases are taken from FGR 12. FGR 12 does not include DCF values for krypton-89 and 
xenon-137, so the skin factors were obtained from DOE/EH-0070. The gamma total body DCF 
values for krypton-89 and xenon-137 used under ICRP-72 in NRCDose3 were obtained from 

https://ramp.nrc-gateway.gov/
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DOE-STD-1196-2011, “Derived Concentration Technical Standard,” issued April 2011 [Ref. 32]. 
The gamma air and beta air DCF values have not been changed from the values based on 
RG 1.109 that were used in the original release of LADTAP II and GASPAR II. 

FGR 12 was used for the DCF values for external exposure from ground contamination or water 
submersion, for both skin dose and effective dose, based on the methodology in ICRP-60, 
“1990 Recommendations of the International Commission on Radiological Protection,” issued 
1991 [Ref. 33]. For these DCF values, contributions from progeny radionuclides were included, 
as shown in Table 6-2. 

Table 6-2 Radionuclides with Included Progeny for External DCF Values Based on 
ICRP-60 

Radionuclide 
Progeny 

Contribution 
Included 

Radionuclide 
Progeny 

Contribution 
Included 

Radionuclide 
Progeny 

Contribution 
Included 

Br-83 Kr-83m Ru-106 Rh-106 I-131 Xe-131m 

Zr-95 Nb-95m Ag-110m Ag-110 I-133 Xe-133m 

Zr-97 Nb-97m Sb-126m Sb-126 I-135 Xe-135m 

Ru-103 Rh-103m Te-133m Te-133 Cs-137 Ba-137m 

    Ce-144 Pr-144m 

6.3 Biota Dose in GASPAR 

In NRCDose3, biota dose calculations have been added to GASPAR. They are performed for 
every special location defined in GASPAR, and for all species considered in previous versions 
of LADTAP II and NRCDose (version 2.3.20 and earlier), with the exception of algae, and with 
the addition of cow and fox as surrogate land-based herbivore and carnivore, respectively. 

Pathways of exposure assumed include plume (submersion noble gases), ground plane, 
inhalation, and ingestion (plants for herbivores, and meat assumed equivalent to cow meat 
concentrations for carnivores). Since GASPAR considers exposures only from gaseous 
effluents, the assumptions made for plant and (cow) meat concentrations are based on the 
RG 1.109 modeling for accumulation in feed (assumed representative of plant-based foods), as 
reflected in equations (C-5) and (C-8) for carbon-14, equation (C-9) for hydrogen-3, and 
equation (C-12) for the resulting concentration in (cow) meat. Equations (6-1), (6-2), and (6-3) 
below show how the plant and meat concentrations are integrated into the dose calculations. 
Table 6-3 lists the parameters used to calculate the biota dose. 

Table 6-3 Biota Dose Parameters for GASPAR II in NRCDose3 
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Species Mass (g) Effective 
Radius (cm) 

Primary Food 
Eaten 

Consumption Rate 
(g/d) 

Muskrat 
(from LADTAP II) 1,000 6 Plants 100 

Raccoon 
(from LADTAP II) 12,000 14 Plants 200 

Duck 
(from LADTAP II) 1,000 5 Plants 100 

Cow 
(herbivore)   Plants  

Fox 
(carnivore)a 5,700 10 Meat 520 

User-defined     

Note: 
a. Fox modeling assumptions are derived 

from http://www.britannica.com/animal/red-fox-mammal and http://www.hse.gov.uk/pesticides/resources/R/Re
search_PN0908.pdf. 

** User Note **—The code can address only a single food type, either plant or meat. While the 
raccoon is recognized to be an omnivore, by default it is modeled as a herbivore; this is 
consistent with the assumptions in LADTAP and BNWL-1754. The raccoon may also be 
modeled as a carnivore by using the “Add Biota Type” function with appropriate inputs for 
consumption. 

The total dose to any organism is the sum of the external and internal dose components. The 
external dose component is the same as the adult human ground-plane dose multiplied by a 
factor of 2 to account for proximity to the ground and divided by 0.7 to remove the shield factor 
assumed for human exposure. Thus, the external component of the biota dose is 2.86 times that 
calculated for adult humans. 

The internal dose is the adult human inhalation dose plus an ingestion dose component that 
depends on the food type. The GASPAR II and LADTAP II codes in NRCDose3 employ the 
same modeling as in BNWL-1754. Similarly to LADTAP, which uses environmental transfer 
factors (bioaccumulation factors) for fish, invertebrates, and algae, GASPAR uses transfer 
factors for vegetation and meat. The GASPAR modeling is based on defining each species as 
either herbivore or carnivore. For a carnivore, because there are only meat transfer factors, the 
meat concentration ingested is assumed to be the same as it would be for cow meat. 

** User Note **—Species-specific modeling can be performed by modifying the exposure and 
uptake assumptions and transfer factors unique to the species (e.g., defining transfer factors for 
chickens). 

  

http://www.britannica.com/animal/red-fox-mammal
http://www.hse.gov.uk/pesticides/resources/R/Research_PN0908.pdf
http://www.hse.gov.uk/pesticides/resources/R/Research_PN0908.pdf
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The ingestion dose to the muskrat, raccoon, or duck is determined using equation (6-1): 

 𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 �𝑟𝑟𝑟𝑟𝑟𝑟
𝑦𝑦𝑟𝑟
� = 𝑉𝑉𝐷𝐷𝑉𝑉.𝐶𝐶𝐷𝐷𝐶𝐶𝐶𝐶.× 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 𝑅𝑅𝑟𝑟𝐶𝐶𝑅𝑅𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 

𝑀𝑀𝑟𝑟𝐶𝐶𝐶𝐶𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 
× 70 × 𝐸𝐸𝐸𝐸𝐸𝐸𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 

𝐸𝐸𝐸𝐸𝐸𝐸𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴
× 𝐷𝐷𝐶𝐶𝐷𝐷𝐶𝐶  (6-1) 

where Veg. Conc. = the vegetable (produce) concentration for radionuclide i 
as calculated by GASPAR II for each location (pCi/kg), 

 Consumption RateSpecies = the mass of food consumed by the species (kg/yr), 

 MassSpecies = the mass of a member of the species (kg), 

 70 = a constant for the assumed mass of an adult, as used 
to derive the ICRP-2 DCFs (kg), 

 EFFSpecies = the energy for the effective radius identified for the 
species (MeV), 

 EFFAdult = the energy for the effective radius for an adult human 
(MeV), and 

 DCFi = the total body ingestion DCF for an adult human for 
radionuclide i (mrem/pCi). 

GASPAR calculates radionuclide concentrations in cow meat, so the effective radius dose 
coefficients are used to calculate the internal dose component through the cow meat ingestion 
pathway using equation (6-2): 

 𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 �𝑟𝑟𝑟𝑟𝑟𝑟
𝑦𝑦𝑟𝑟
� = 0.0187 × 𝑀𝑀𝐷𝐷𝑀𝑀𝑀𝑀 𝐶𝐶𝐷𝐷𝐶𝐶𝐶𝐶.× 𝐸𝐸𝐷𝐷𝐷𝐷𝐶𝐶 (6-2) 

where 0.0187 = the conversion factor (dis-kg-mrad per pCi-yr-MeV), 

 Meat Conc. = the cow meat concentration for radionuclide i as 
calculated by GASPAR II for each location (pCi/kg), 

 MassSpecies = the mass of a member of the species (kg), and 

 EFFi = the energy per decay for the effective radius identified 
for the species (MeV/dis). 
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The ingestion dose to the fox is determined using equation (6-3): 

 𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 �𝑟𝑟𝑟𝑟𝑟𝑟
𝑦𝑦𝑟𝑟
� = 𝑀𝑀𝐷𝐷𝑀𝑀𝑀𝑀 𝐶𝐶𝐷𝐷𝐶𝐶𝐶𝐶.× 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 𝑅𝑅𝑟𝑟𝐶𝐶𝑅𝑅𝐹𝐹𝐹𝐹𝐹𝐹 

𝑀𝑀𝑟𝑟𝐶𝐶𝐶𝐶𝐹𝐹𝐹𝐹𝐹𝐹 
× 70 × 𝐸𝐸𝐸𝐸𝐸𝐸𝐹𝐹𝐹𝐹𝐹𝐹 

𝐸𝐸𝐸𝐸𝐸𝐸𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴
× 𝐷𝐷𝐶𝐶𝐷𝐷𝐶𝐶 (6-3) 

where Meat Conc. = the meat concentration for radionuclide i as calculated 
by GASPAR for each location (pCi/kg), 

 Consumption RateFox = the mass of food consumed by the fox (kg/yr),  

 MassFox = the mass of the fox (kg), 

 70 = a constant for the assumed mass of an adult human 
(kg), 

 EFFFox = the energy for the effective radius identified for the fox 
(MeV), 

 EFFAdult = the energy for the effective radius for an adult human 
(MeV), and 

 DCFi = the total body ingestion DCF for an adult human for 
radionuclide i (mrem/pCi). 

GASPAR calculates the vegetable and meat concentrations using the PARTS subroutine, with 
specific modeling for carbon-14 and hydrogen-3 (tritium) performed in the CARBON and 
TRITIUM subroutines, respectively. 

For all biota, the inhalation dose is approximated as equal to the adult inhalation (total body) 
dose at the specific location. The ground-plane dose to biota is approximated as equal to the 
adult ground-plane dose, multiplied by a factor of 2 to conservatively account for the possibility 
that non-human organisms are closer to the ground, and divided by 0.7 to remove the shield 
factor assumed for human exposure. 
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APPENDIX A    
RADIONUCLIDES IN REACTOR EFFLUENTS IN NRCDose3 

The range of radionuclides covered by NRCDose3 has been expanded from those available in 
the original versions of the LADTAP II, GASPAR II, and XOQDOQ Fortran codes. The 
radionuclides and dose conversion factor (DCF) values in the original versions of the codes are 
largely (but not all) based on Regulatory Guide (RG) 1.109, Revision 1, “Calculation of Annual 
Doses to Man from Routine Releases of Reactor Effluents for the Purpose of Evaluating 
Compliance with 10 CFR Part 50, Appendix I,” issued October 1977 [Ref. 1]. To determine the 
sources of the DCF values in the original versions of the codes, the U.S. Nuclear Regulatory 
Commission (NRC) staff compared the values in the LADTAP.LIB file with those in the following 
sources, which are based on International Commission on Radiological Protection (ICRP) 
Publication 2, “Report of Committee II on Permissible Dose for Internal Radiation” (ICRP-2), 
issued 1960 [Ref. 2]: 

• RG 1.109, Revision 1

• NUREG-0172, “Age-Specific Radiation Dose Commitment Factors for a One-Year
Chronic Intake,” issued November 1977 [Ref. 3]

• NUREG-0172 errata (Battelle memorandum), “Changes and Corrections for
NUREG-0172,” issued August 1983 [Ref. 4]

• NUREG/CR-2384, “Age-Specific Inhalation Radiation Dose Commitment Factors for
Selected Radionuclides,” issued August 1982 [Ref. 5]

• EMP-155, “Review and Expansion of USNRC Regulatory Guide 1.109 Models for
Computing Dose Conversion Factors,” February 1983 [Ref. 6]

Table A-1 lists the radionuclides for which DCF values are included in the identified source 
documents. Highlighted entries indicate radionuclides that are not in the original LADTAP.LIB 
file as used in NRCDose (version 2.3.20). 



 

A-2 

Table A-1 NRCDose3 Radionuclides, DCF Values, and Reference Documents 

No. LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 
1 H-3 H-3 H-3   H-3 

2 Be-10   Be-10   Be-10 

3 C-14 C-14 C-14   C-14 

4 N-13   N-13     

5 F-18   F-18     

6 Na-22   Na-22     

7 Na-24 Na-24 Na-24     

8 P-32 P-32 P-32     

9       S-35   

10       Cl-36   

11     Ar-39     

12     Ar-41     

13 Ca-41   Ca-41     

14       Ca-45   

15 Sc-46   Sc-46     

16 Cr-51 Cr-51 Cr-51   Cr-51 

17 Mn-54 Mn-54 Mn-54   Mn-54 

18 Mn-56 Mn-56 Mn-56     

19 Fe-55 Fe-55 Fe-55     

20 Fe-59 Fe-59 Fe-59   Fe-59 

21 Co-57   Co-57     

22 Co-58 Co-58 Co-58   Co-58 

23 Co-60 Co-60 Co-60   Co-60 

24 Ni-59   Ni-59     

25 Ni-63 Ni-63 Ni-63     
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes. No ingestion or other 
organ DCF values are included. 

Radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF values 
are selected. 
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Table A-1 NRCDose3 Radionuclides, DCF Values, and Reference Documents (cont.) 

No. LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 
26 Ni-65 Ni-65 Ni-65     

27 Cu-64 Cu-64 Cu-64     

28       Ga-67 Ga-67 

29 Zn-65 Zn-65 Zn-65     

30 Zn-69m   Zn-69m   Zn-69m 

31 Zn-69 Zn-69 Zn-69     

32       Se-75   

33 Se-79   Se-79     

34 Br-82   Br-82     

35 Br-83 Br-83 Br-83     

36 Br-84 Br-84 Br-84     

37 Br-85 Br-85 Br-85     

38     Kr-83ma     

39     Kr-85ma     

40     Kr-85a     

41     Kr-87a     

42     Kr-88a     

43     Kr-89a     

44 Rb-86 Rb-86 Rb-86     

45 Rb-87   Rb-87     

46 Rb-88 Rb-88 Rb-88     

47 Rb-89 Rb-89 Rb-89     

48       Sr-85   

49 Sr-89 Sr-89 Sr-89   Sr-89 

50 Sr-90 Sr-90 Sr-90   Sr-90 
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes. No ingestion or other 
organ DCF values are included. 

Radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF values 
are selected. 
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Table A-1 NRCDose3 Radionuclides, DCF Values, and Reference Documents (cont.) 

No. LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 
51 Sr-91 Sr-91 Sr-91     

52 Sr-92 Sr-92 Sr-92     

53 Y-90 Y-90 Y-90   Y-90 

54 Y-91m Y-91m Y-91m     

55 Y-91 Y-91 Y-91   Y-91 

56 Y-92 Y-92 Y-92     

57 Y-93 Y-93 Y-93     

58 Zr-93   Zr-93   Zr-93 

59 Zr-95 Zr-95 Zr-95   Zr-95 

60 Zr-97 Zr-97 Zr-97     

61 Nb-93m   Nb-93m     

62 Nb-95 Nb-95 Nb-95   Nb-95 

63 Nb-97   Nb-97     

64 Mo-93   Mo-93     

65 Mo-99 Mo-99 Mo-99     

66 Tc-99m Tc-99m Tc-99m     

67 Tc-99   Tc-99   Tc-99 

68 Tc-101 Tc-101 Tc-101     

69 Ru-103 Ru-103 Ru-103   Ru-103 

70 Ru-105 Ru-105 Ru-105     

71 Ru-106 Ru-106 Ru-106   Ru-106 

72 Rh-105   Rh-105     

73 Pd-107   Pd-107     

74 Pd-109   Pd-109     

75       Cd-109   
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes. No ingestion or other 
organ DCF values are included. 

Radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF values 
are selected. 
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Table A-1 NRCDose3 Radionuclides, DCF Values, and Reference Documents (cont.) 

No. LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 
76 Ag-110m Ag-110m Ag-110m   Ag-110m 

77 Ag-111   Ag-111     

78 Cd-113m   Cd-113m     

79 Cd-115m   Cd-115m   Cd-115m 

80       Sn-113   

81 Sn-123   Sn-123   Sn-123 

82 Sn-125   Sn-125     

83 Sn-126   Sn-126     

84 Sb-124   Sb-124   Sb-124 

85 Sb-125   Sb-125   Sb-125 

86 Sb-126   Sb-126     

87 Sb-127   Sb-127     

88 Te-125m Te-125m Te-125m   Te-125m 

89 Te-127m Te-127m Te-127m     

90 Te-127 Te-127 Te-127     

91 Te-129m Te-129m Te-129m     

92 Te-129 Te-129 Te-129     

93 Te-131m Te-131m Te-131m     

94 Te-131 Te-131 Te-131     

95 Te-132 Te-132 Te-132     

96 Te-133m   Te-133m     

97 Te-134   Te-134     

98       I-125   

99 I-129   I-129   I-129 

100 I-130 I-130 I-130     
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes. No ingestion or other 
organ DCF values are included. 

Radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF values 
are selected. 
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Table A-1 NRCDose3 Radionuclides, DCF Values, and Reference Documents (cont.) 

No. LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 
101 I-131 I-131 I-131   I-131 

102 I-132 I-132 I-132     

103 I-133 I-133 I-133     

104 I-134 I-134 I-134     

105 I-135 I-135 I-135     

106     Xe-131ma     

107     Xe-133ma     

108     Xe-133a     

109     Xe-135ma     

110     Xe-135a     

111     Xe-137a     

112     Xe-138a     

113 Cs-134m   Cs-134m     

114 Cs-134 Cs-134 Cs-134   Cs-134 

115 Cs-135   Cs-135     

116 Cs-136 Cs-136 Cs-136     

117 Cs-137 Cs-137 Cs-137   Cs-137 

118 Cs-138 Cs-138 Cs-138     

119 Cs-139   Cs-139     

120       Ba-133   

121 Ba-139 Ba-139 Ba-139     

122 Ba-140 Ba-140 Ba-140   Ba-140 

123 Ba-141 Ba-141 Ba-141     

124 Ba-142 Ba-142 Ba-142     

125 La-140 La-140 La-140   La-140 
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes. No ingestion or other 
organ DCF values are included. 

Radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF values 
are selected. 
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Table A-1 NRCDose3 Radionuclides, DCF Values, and Reference Documents (cont.) 

No. LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 
126 La-141   La-141     

127 La-142 La-142 La-142     

128 Ce-141 Ce-141 Ce-141   Ce-141 

129 Ce-143 Ce-143 Ce-143     

130 Ce-144 Ce-144 Ce-144   Ce-144 

131 Pr-143 Pr-143 Pr-143     

132 Pr-144 Pr-144 Pr-144     

133 Nd-147 Nd-147 Nd-147     

134 Pm-147   Pm-147   Pm-147 

135 Pm-148m   Pm-148m     

136 Pm-148   Pm-148     

137 Pm-149   Pm-149     

138 Pm-151   Pm-151     

139 Sm-151   Sm-151   Sm-151 

140 Sm-153   Sm-153     

141 Eu-152   Eu-152     

142 Eu-154   Eu-154   Eu-154 

143 Eu-155   Eu-155   Eu-155 

144 Eu-156   Eu-156     

145 Tb-160   Tb-160     

146 Ho-166m   Ho-166m   Ho-166m 

147       Tm-170   

148       Yb-169   

149 W-181   W-181     

150 W-185   W-185     
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes. No ingestion or other 
organ DCF values are included. 

Radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF values 
are selected. 
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Table A-1 NRCDose3 Radionuclides, DCF Values, and Reference Documents (cont.) 

No. LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 
151 W-187 W-187 W-187     

152       Ta-182   

153       Ir-192   

154       Au-198   

155       Tl-201 Tl-201 

156       Tl-204   

157 Pb-210   Pb-210   Pb-210 

158 Bi-210   Bi-210   Bi-210 

159 Po-210   Po-210     

160     Rn-222     

161 Ra-223   Ra-223     

162 Ra-224   Ra-224     

163 Ra-225   Ra-225     

164 Ra-226   Ra-226     

165 Ra-228   Ra-228     

166 Ac-225   Ac-225     

167 Ac-227   Ac-227     

168 Th-227   Th-227     

169 Th-228   Th-228     

170 Th-229   Th-229   Th-229 

171 Th-230   Th-230     

172 Th-232   Th-232   Th-232 

173 Th-234   Th-234     

174 Pa-231   Pa-231     

175 Pa-233   Pa-233     
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes. No ingestion or other 
organ DCF values are included. 

Radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF values 
are selected. 
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Table A-1 NRCDose3 Radionuclides, DCF Values, and Reference Documents (cont.) 

No. LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 
176 U-232   U-232   U-232 

177 U-233   U-233     

178 U-234   U-234   U-234 

179 U-235   U-235   U-235 

180 U-236   U-236   U-236 

181 U-237   U-237     

182 U-238   U-238   U-238 

183 Np-237   Np-237   Np-237 

184 Np-238   Np-238     

185 Np-239 Np-239 Np-239   Np-239 

186       Pu-236 Pu-236 

187 Pu-238   Pu-238   Pu-238 

188 Pu-239   Pu-239   Pu-239 

189 Pu-240   Pu-240   Pu-240 

190 Pu-241   Pu-241   Pu-241 

191 Pu-242   Pu-242   Pu-242 

192 Pu-244   Pu-244   Pu-244 

193 Am-241   Am-241   Am-241 

194 Am-242m   Am-242m   Am-242m 

195 Am-243   Am-243   Am-243 

196 Cm-242   Cm-242   Cm-242 

197 Cm-243   Cm-243   Cm-243 

198 Cm-244   Cm-244   Cm-244 

199 Cm-245   Cm-245     
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes. No ingestion or other 
organ DCF values are included. 

Radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF values 
are selected. 
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Table A-1 NRCDose3 Radionuclides, DCF Values, and Reference Documents (cont.) 

No. LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 
200 Cm-246   Cm-246     

201 Cm-247   Cm-247     

202 Cm-248   Cm-248     

203 Cf-252   Cf-252   Cf-252 
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes. No ingestion or other 
organ DCF values are included. 

Radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF values 
are selected. 

The radionuclides that are highlighted in the table above are not contained in the original 
versions of LADTAP II, GASPAR II, or NRCDose, but have been added to the database files for 
NRCDose3 and are available when ICRP-2 DCF values are selected. 

The 203 radionuclides listed are the same as those available when the DCF values selected in 
NRCDose3 are from ICRP Publication 30, “Limits for Intakes of Radionuclides by Workers,” 
issued 1979 [Ref. 7], or ICRP Publication 72, “Age-Dependent Dose to Members of the Public 
from Intake of Radionuclides,” issued 1996 [Ref. 8]. 
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APPENDIX B 
USER-MODIFIABLE PARAMETERS 

The LADTAP II, GASPAR II, and XOQDOQ Fortran codes rely on many parameters and 
assumptions as inputs to perform their dose assessments. One of the design objectives of the 
updated NRCDose3 was to allow users increased flexibility to modify and adjust these 
parameters as needed. Therefore, all parameters used in XOQDOQ, LADTAP II, and 
GASPAR II have been identified, including all radiological and nonradiological parameters that 
are either user-modifiable or hardwired in the codes. 

The LADTAP II, GASPAR II, and XOQDOQ Fortran input cards were reviewed for modifiable 
parameters, and it was confirmed that these input card parameters could be modified through 
the existing NRCDose code (version 2.3.20). Tables B-1 through B-3 identify the modifiable 
parameters in LADTAP II, GASPAR II, and XOQDOQ. Also, the LADTAP II, GASPAR II, and 
XOQDOQ Fortran codes were reviewed to identify the variables and parameters hardwired into 
the original codes. Tables B-4 through B-6 identify the hardwired parameters in the LADTAP II, 
GASPAR II, and XOQDOQ Fortran codes that can now be modified by the user in NRCDose3. 

Table B-1 LADTAP II Modifiable Parameters 

Parameter/Information Description LADTAP II 
Notation 

Where Adjusted in 
NRCDose3 

Plant Title Text of plant title or run N/A Main Screen. “Scenario” 

Water Type Selection Determines saltwater vs. freshwater site LT Selections -> “Site Type” 

Discharge Liquid effluent discharge rate to 
impoundment system CFS Selections -> “Discharge Flow 

Rate” 

Source Term Multiplier UML Selections -> “Source Term 
Multiplier” 

Control printing percent contribution by 
nuclide LCT Selections -> “Dose 

Contributions” 

Blockdata Changing and printing block data 
parameters IFLAG Not used in NRCDose3 

Population Total population within 50 miles POP Selections -> “50-mile 
Population” 

Control parameter for reading record TR 

Population Fraction Fraction of population adult PERA Selections -> Modify 
defaults -> Edit 

Population Fraction Fraction of population teen PERT Selections -> Modify 
defaults -> Edit 
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Table B-1 LADTAP II Modifiable Parameters (cont.) 

Parameter/Information Description LADTAP II 
Notation Where Adjusted in NRCDose3 

Population Fraction Fraction of population child PERC Selections -> Modify defaults -> Edit 

Release Nuclide Nuclide released; element 
symbol  IA Source Term -> Add Nuclide; 

parameters combined into a drop-down 
selection menu for the nuclides Release Nuclide Nuclide released; mass 

including M for metastable IM 

Release Rate Annual release (Ci/yr) QQ Selections -> Source Term -> Add 
Nuclide 

Reconcentration Factor 
Radionuclide reconcentration 
factor; option for user input of 
value for each nuclide 

R Selections -> Source Term 

Reconcentration Model M Selections -> Reconcentration. Model. 

Discharge Rate Effluent discharge rate QSUBB Selections -> Reconcentration. 

Impoundment Volume Total volume (ft3) VSUBT Selections -> Reconcentration. 

Shore-Width Factor SWF 
ALARA Locations -> ALARA – Max. 
Individual (or Additional Usage 
Locations) -> Shore-width factor 

Dilution Factor (DF) DF for aquatic food and 
boating DILU, BDIL 

ALARA Locations -> ALARA – Max. 
Individual -> Dilution Factor. Aquatic 
food and boating. 

Dilution Factor DF for shoreline and 
swimming SHD 

ALARA Locations -> ALARA – Max. 
Individual -> Dilution Factor. Shoreline 
and swimming 

Dilution Factor DF for drinking water DWD 
 ALARA Locations -> ALARA – Max. 
Individual -> Dilution Factor. Drinking 
water. 

Transit Time 
Time from discharge to 
receiving water body to 
exposure location (hr) 

T 

ALARA Locations -> ALARA – Max. 
Individual (or Additional Usage 
Locations) -> Transit Time. Other 
pathways (All pathways). 

Transit Time 
Time from discharge to 
receiving water body to 
drinking water (hr) 

TD 
ALARA Locations -> ALARA – Max. 
Individual -> Transit Time. Drinking 
water. 
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Table B-1 LADTAP II Modifiable Parameters (cont.) 

Parameter/Information Description LADTAP II 
Notation 

Where Adjusted in 
NRCDose3 

Fish Consumption 

Annual fish 
consumption (adult, 
teen, child, infant) 
(kg/yr) 

FIUS, TAF, CHF, TDF 

ALARA Locations -> ALARA – 
Max. Individual -> Change 
default usage and 
consumption data. Edit. 

Invertebrate 
Consumption  

Annual invertebrate 
consumption (adult, 
teen, child, infant) 
(kg/yr) 

CRUS, TAC, CHC, TDC 

ALARA Locations -> ALARA – 
Max. Individual -> Change 
default usage and 
consumption data. Edit. 

Aquatic Plant 
Consumption 

Annual algae 
consumption (adult, 
teen, child, infant) 
(kg/yr) 

ALUS, TAA, CHA, TDA 

ALARA Locations -> ALARA – 
Max. Individual -> Change 
default usage and 
consumption data. Edit. 

Drinking Water 

Annual drinking 
water consumption 
(adult, teen, child, 
infant) (kg/yr) 

WUSE, TAW, CHW, TDW 

ALARA Locations -> ALARA – 
Max. Individual -> Change 
default usage and 
consumption data. Edit. 

Shoreline Usage 
Annual shoreline 
usage (adult, teen, 
child, infant) (hr/yr) 

SHU, TAS, CHS, TDS 

ALARA Locations -> ALARA – 
Max. Individual -> Change 
default usage and 
consumption data. Edit. 

Swimming Exposure 

Annual swimming 
exposure time (adult, 
teen, child, infant) 
(hr/yr) 

SWU, TASW, CHSW, TDSW 

ALARA Locations -> ALARA – 
Max. Individual -> Change 
default usage and 
consumption data. Edit. 

Boating Usage 

Annual boating 
usage time (adult, 
teen, child, infant) 
(hr/yr) 

BUSE, TAB, CHB, TDB 

ALARA Locations -> ALARA – 
Max. Individual -> Change 
default usage and 
consumption data. Edit. 

Flow Velocity Average flow velocity 
(ft/s) UR 

ALARA Locations -> ALARA – 
Max. Individual (or Additional 
Usage Locations) -> Dilution 
Factor -> Calc -> Surface 
Water Velocity 

Average Depth Depth of water body 
(ft) HR 

ALARA Locations -> ALARA – 
Max. Individual (or Additional 
Usage Locations) -> Dilution 
Factor -> Calc -> Surface 
Water Depth 
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Table B-1 LADTAP II Modifiable Parameters (cont.) 

Parameter/Information Description LADTAP II 
Notation 

Where Adjusted in 
NRCDose3 

Distance 
Downshore distance 
from discharge point 
to usage location (ft) 

XR 

ALARA Locations -> ALARA – 
Max. Individual (or Additional 
Usage Locations) -> Dilution 
Factor -> Calc -> Downstream 
Distance 

Distance 
Offshore distance to 
water usage location 
(ft) 

YR 

ALARA Locations -> ALARA – 
Max. Individual (or Additional 
Usage Locations) -> Dilution 
Factor -> Calc -> Offshore 
Distance 

River Width 
Width of river or 
depth of discharge 
point in the lake (ft) 

BW 

ALARA Locations -> ALARA – 
Max. Individual (or Additional 
Usage Locations) -> Dilution 
Factor -> Calc -> River Width 

Sport Fishing Usage Annual sport fish 
harvest (kg/yr) CATH 

Fish/Population/Biota -> Fish 
Usage Location -> Sport 
Fishing…Add 

Sport Fishing Usage Dilution factor DILU 
Fish/Population/Biota -> Fish 
Usage Location -> Sport 
Fishing…Add 

Sport Fishing Usage Transit time T 
Fish/Population/Biota -> Fish 
Usage Location -> Sport 
Fishing…Add 

Commercial Fishing 
Usage Location 

(see Sport Fishing 
above) CATH, DILU, T 

Fish/Population/Biota -> Fish 
Usage Location->Commercial 
Fishing…Add 

Sport Invertebrate 
Harvest Location 

(see Sport Fishing 
above) CATH, DILU, T 

Fish/Population/Biota -> Fish 
Usage Location -> Sport 
Invertebrate Harvest…Add 

Commercial 
Invertebrate Harvest 
Location Data 

(see Sport Fishing 
above) CATH, DILU, T 

Fish/Population/Biota -> Fish 
Usage Location -> 
Commercial Invertebrate 
Harvest…Add 

Population 
Population served by 
drinking water 
location 

P 
Fish/Population/Biota -> 
Population Usage -> Drinking 
Water…Add 

Dilution Factor DF at the intake 
location DILU 

Fish/Population/Biota -> 
Population Usage -> Drinking 
Water…Add 
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Table B-1 LADTAP II Modifiable Parameters (cont.) 

Parameter/Information Description LADTAP II 
Notation 

Where Adjusted in 
NRCDose3 

Distance 
Offshore distance to 
water usage location 
(ft) 

YR 

ALARA Locations -> ALARA – 
Max. Individual (or Additional 
Usage Locations) -> Dilution 
Factor -> Calc -> Offshore 
Distance 

River Width 
Width of river or 
depth of discharge 
point in the lake (ft) 

BW 

ALARA Locations -> ALARA – 
Max. Individual (or Additional 
Usage Locations) -> Dilution 
Factor -> Calc -> River Width 

Sport Fishing Usage Annual sport fish 
harvest (kg/yr) CATH 

Fish/Population/Biota -> Fish 
Usage Location -> Sport 
Fishing…Add 

Sport Fishing Usage Dilution factor DILU 
Fish/Population/Biota -> Fish 
Usage Location -> Sport 
Fishing…Add 

Sport Fishing Usage Transit time T 
Fish/Population/Biota -> Fish 
Usage Location -> Sport 
Fishing…Add 

Commercial Fishing 
Usage Location 

(see Sport Fishing 
above) CATH, DILU, T 

Fish/Population/Biota -> Fish 
Usage Location->Commercial 
Fishing…Add 

Sport Invertebrate 
Harvest Location 

(see Sport Fishing 
above) CATH, DILU, T 

Fish/Population/Biota -> Fish 
Usage Location -> Sport 
Invertebrate Harvest…Add 

Commercial 
Invertebrate Harvest 
Location Data 

(see Sport Fishing 
above) CATH, DILU, T 

Fish/Population/Biota -> Fish 
Usage Location -> 
Commercial Invertebrate 
Harvest…Add 

Population 
Population served by 
drinking water 
location 

P 
Fish/Population/Biota -> 
Population Usage -> Drinking 
Water…Add 

Dilution Factor DF at the intake 
location DILU 

Fish/Population/Biota -> 
Population Usage -> Drinking 
Water…Add 

Transit Time 
Time from discharge 
point to water supply 
intake (hr) 

T 
Fish/Population/Biota -> 
Population Usage -> Drinking 
Water…Add 
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Table B-1 LADTAP II Modifiable Parameters (cont.) 

Parameter/Information Description LADTAP II 
Notation 

Where Adjusted in 
NRCDose3 

Volume Supply rate of 
drinking water (gal/d) GAL 

Fish/Population/Biota -> 
Population Usage -> Drinking 
Water…Add 

Drinking Water Usage 
Average rate of 
drinking water usage 
by individuals (gal/d) 

GUS 
Fish/Population/Biota -> 
Population Usage -> Drinking 
Water…Add 

Population Shoreline Population shoreline 
usage (person-hr/yr) SHU, DILU, T, SWF 

Fish/Population/Biota -> 
Population 
Usage-Shoreline…Add 

Population Swimming 
Population 
Swimming Usage 
(person-hr/yr) 

SWU, DILU, T 
Fish/Population/Biota -> 
Population 
Usage-Swimming…Add 

Population Boating Population Boating 
Usage (person-hr/yr) BTUSE, DILU, T 

Fish/Population/Biota -> 
Population Usage -> 
Boating…Add 

Irrigated Foods Irrigation rate 
(L/m2/month) IRRIG Irrigated Food Data -> 

Irrigation Food Data -> Add 

Irrigated Foods 

Fraction of animal 
feed NOT produced 
with contaminated 
water 

FFED Irrigated Food Data -> 
Irrigation Food Data -> Add 

Irrigated Foods 
Fraction of animal 
drinking water NOT 
contaminated 

FDH20 Irrigated Food Data -> 
Irrigation Food Data -> Add 

Irrigated Foods 
Total production rate 
of food product 
(kg/yr) 

TFMG Irrigated Food Data -> 
Irrigation Food Data -> Add 

Irrigated Foods Growing period for 
food product (d) TGRW Irrigated Food Data -> 

Irrigation Food Data -> Add 

Irrigated Foods Crop yield for food 
product (kg/m2) YLD Irrigated Food Data -> 

Irrigation Food Data -> Add 

Food Consumption 

Maximum current 
food consumption 
rate (adult, teen, 
child) (kg/yr) 

ACON, TCON, CCON 

Irrigated Food Data -> 
Irrigation Food Data -> Add. 
Modify Food Consumption 
Default data. Edit. 
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Table B-1 LADTAP II Modifiable Parameters (cont.) 

Parameter/Information Description LADTAP II 
Notation 

Where Adjusted in 
NRCDose3 

Food Consumption 

Average current food 
consumption rate 
(adult, teen, child) 
(kg/yr) 

AC, TC, CC 

Irrigated Food Data -> 
Irrigation Food Data -> Add. 
Modify Food Consumption 
Default data. Edit. 

Holdup Time Holdup time to 
average person (h) HOLD 

Irrigated Food Data -> 
Irrigation Food Data -> Add. 
Modify Food Consumption 
Default data. Edit. 

Holdup Time Holdup time to 
maximum person (h) HOLD1 

Irrigated Food Data -> 
Irrigation Food Data -> Add. 
Modify Food Consumption 
Default data. Edit. 

Production Rate 
Production rate for 
current food product 
(kg/yr or L/yr) 

PROD 
Irrigated Food Data -> 
Irrigation Food Data -> Add -> 
Usage Locations 

Food Product Water 
Usage Location Data DF, transit time DILU, T 

Irrigated Food Data -> 
Irrigation Food Data -> Add -> 
Usage Locations 

Biota Exposure 
Location Data DF, transit time DILU, T Fish/Population/Biota -> Biota 

Exposures -> Add 

Miscellaneous 
Pathways and 
Consumption Factors 

Numerous factors on 
Pathway Factors tab 
that can be modified, 
reflecting 
site-specific 
conditions  

Various; refer to Table B-4 Pathways Factors 
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Table B-2 GASPAR II Modifiable Parameters 

Parameter/Information Description GASPAR II 
Notation Where Adjusted in NRCDose3 

Plant Title Text of plant title or run N/A Main Screen. “Case Title” 

Input Deck Type Determines population dose, 
individual dose, or both JC(1) Options -> “Calculate Individual 

doses only” 

Number of Source 
Terms 

Number of release points (with 
associated source terms) JC(2) NOTE: NRCDose3 limited to a 

single source term. 

Cumulative Doses 
Prints cumulative doses from 
each source term, or only total 
dose from all source terms 

JC(3) Options -> “Print cumulative dose 
reports only” 

Block Data Records Block data changes JC(4) Not used in NRCDose3 

Dose Factor Library Dose factor report selection JC(5) Options -> Print dose-factor library 
data 

Vegetable Growth Fraction of year leafy vegetables 
are grown FV Options -> “Fraction of the year 

leafy vegetables are grown" 

Cow Pasture Fraction of year cows are on 
pasture FP Options -> “Fraction of the year milk 

cows are on pasture” 

Crop from Garden Fraction of crop from garden FG 
Options -> ”Fraction of max 
individual’s vegetable intake from 
own garden” 

Cow Intake Fraction of cow intake from 
pasture, while on pasture FPF 

Options -> “Fraction of milk-cow 
feed intake from pasture while on 
pasture” 

Humidity 

Relative humidity provided a 
value other than zero (0) is 
entered for “Average 
temperature over growing 
season” (next entry in this 
column). However, with the 
“Average temperature over 
growing season” entered as zero 
(0), this represents absolute 
humidity, 

H Options -> “Humidity” 

Temperature 
Average temperature over 
growing season (degrees 
Fahrenheit) 

T Options -> “Average temperature 
over growing season” 

Goat Pasture Fraction of year goats on pasture FGT Options -> “Fraction of the year 
goats are on pasture” 
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Table B-2 GASPAR II Modifiable Parameters (cont.) 

Parameter/Information Description GASPAR II 
Notation Where Adjusted in NRCDose3 

Goat Intake Fraction of goat intake from 
pasture, while on pasture FPG 

Options -> “Fraction of goat feed 
intake from pasture while on 
pasture” 

Beef Cow Pasture Fraction of year beef cows are 
on pasture FB Options -> “Fraction of the year beef 

cows are on pasture” 

Beef Cow Intake Fraction of beef cow intake from 
pasture, while on pasture FBF 

Options -> “Fraction of beef cow 
feed intake from pasture while on 
pasture” 

Population Total population within 50 miles LS, 
PERSON 

Pop/Prod Data tab -> Population 
Data. Population Control. Uncheck 
“Input by distance and direction” -> 
Data Entry 

Population 
Population in given downwind 
direction sector and annular 
distance 

POP(160) 

Pop/Prod Data tab -> Population 
Data. Population Control. Check 
“Input by distance and direction” -> 
Data Entry 

Milk Production 
Milk production in given 
downwind direction sector and 
annular distance 

ZMILK(160) 

Pop/Prod Data tab -> Milk 
Production Data. Milk Production 
Control. Check “Input by distance 
and direction” -> Data Entry 

Milk Production Total milk production within 
50 miles ZMLKT 

Pop/Prod Data tab -> Milk 
Production Data. Milk Production 
Control. Uncheck “Input by distance 
and direction” -> Data Entry 

Meat Production 
Meat production in given 
downwind direction sector and 
annular distance 

ZMEAT(160) 

Pop/Prod Data tab -> Meat 
Production Data. Meat Production 
Control. Check “Input by distance 
and direction” -> Data Entry 

Meat Production Total meat production within 
50 miles ZMETT 

Pop/Prod Data tab -> Meat 
Production Data. Meat Production 
Control. Uncheck “Input by distance 
and direction” -> Data Entry 

Vegetable Production 
Vegetable production in given 
downwind direction sector and 
annular distance 

ZVEGT(160) 

Pop/Prod Data tab -> Vegetable 
Production Data. Vegetable 
Production Control. Check “Input by 
distance and direction” -> Data 
Entry 
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Table B-2 GASPAR II Modifiable Parameters (cont.) 

Parameter/Information Description GASPAR II 
Notation Where Adjusted in NRCDose3 

Vegetable Production Total vegetable production within 
50 miles ZVEGTT 

Pop/Prod Data tab -> Vegetable 
Production Data. Vegetable 
Production Control. Uncheck “Input 
by distance and direction” -> Data 
Entry 

Source Term Multiplier Multiplier to account for multiunit 
sites with same release UML 

Variables -> Source Term. Source 
Data. “Source Multiplication Factor” 

Note: NRCDose3 limited to a single 
source term. 

New MET Data Determines whether last MET 
data can be reused JC1 

Note: Not used in NRCDose3. 
NRCDose3 limited to a single 
source term. 

New Release Data Determines whether last release 
data can be reused JC2 

Note: Not used in NRCDose3. 
NRCDose3 limited to a single 
source term. 

Purge Duration Total annual purge release time PURGE Source Term -> Source Data 
“Release time for purges” 

Release Nuclide Nuclide released; element 
symbol  IA Source Term -> Add Nuclide; 

parameters combined into a 
drop-down selection menu for the 
nuclides Release Nuclide Nuclide released; mass including 

M for metastable IM 

Annual Release Annual release (Ci) QQ, Q(33) Source Term -> Add Nuclide 

Release Point— Title for data source, date, 
height, release point, etc.  Pop/Prod Data -> Meteorological -> 

Title 

Undecayed, 
Undepleted X/Q  

X/Q at each downwind sector 
and annular distance XQ(160) 

Pop/Prod Data -> Meteorological -> 
Undecayed, Undepleted -> Data 
Entry 

Decayed, Undepleted 
X/Q 

Decayed, undepleted X/Q at 
each downwind sector and 
annular distance  

XQD Pop/Prod Data -> Meteorological -> 
Decayed, Undepleted ->Title 

Decayed, Depleted X/Q 
Decayed, depleted X/Q at each 
downwind sector and annular 
distance 

XQDD(160) Pop/Prod Data -> Meteorological -> 
Decayed, Depleted -> Data Entry 

Deposition D/Q 
Deposition D/Q at each 
downwind sector and annular 
distances. 

DEP(160) Pop/Prod Data -> Meteorological -> 
Ground Deposition ->Data Entry 
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Table B-2 GASPAR II Modifiable Parameters (cont.) 

Parameter/Information Description GASPAR II 
Notation Where Adjusted in NRCDose3 

Special Location Data Determines whether detailed 
pathway reports are printed JS(n) Special Location Data -> Add. 

“Don't print any detailed reports” 

Special Location Name Name identifier Name Special Location Data -> Add. 
“Name of Location” 

Special Location 
Downwind Direction 
Sector 

Meteorological sector for special 
location (DIR) Special Location Data -> Add. 

“Downwind direction from site” 

Special Location 
Distance Distance to special location DIST Special Location Data -> Add. 

“Distance from Site (m)” 

Special Location X/Q Special location undecayed, 
undepleted X/Q X/Q, XQ1 

Special Location Data -> Add -> 
Atmospheric Dispersion Factors -> 
Undecayed, Undepleted 

Special Location XQD Special location decayed, 
undepleted X/Q XQD, XQD1 

Special Location Data -> Add -> 
Atmospheric Dispersion Factors -> 
Decayed, Undepleted 

Special Location XQDD Special location decayed, 
depleted X/Q 

XQDD, 
XQDD1 

Special Location Data -> Add -> 
Atmospheric Dispersion Factors -> 
Decayed, Depleted 

Special Location DEP Special location D/Q DEP1 
Special Location Data -> Add -> 
Atmospheric Deposition Factors -> 
Ground Deposition Factor 

Miscellaneous 
Pathways Factors 

Numerous factors on Pathway 
Factors tab that can be modified, 
reflecting site-specific conditions  

Various; 
refer to 

Table B-5 
Pathways Factors 

Consumption Values 

Usage (inhalation and intake) 
values on Consumption Values 
tab for the various pathways and 
age groups, which may be 
modified to reflect site-specific 
conditions. 

Various; 
refer to 

Table B-5 
Consumption Values 

  



 

B-12 

Table B-3 XOQDOQ Modifiable Parameters 

Parameter/Information Description XOQDOQ 
 Notation Where Adjusted in NRCDose3 

Calms selection Option Distribute calms as first 
windspeed class KOPT(1) Met Data tab 

JFD input Option 
Input joint frequency 
distribution as percent 
frequency 

KOPT(2) 
Met Data tab -> Input joint 
frequency distribution data as 
percent frequency 

Sector spread Option Compute sector spread KOPT(3) Options/Parameters tab, Options 

Short-term x/Q Option Plot short-term X/Q values KOPT(4) Options/Parameters tab, Options 

Cubic Spline Option Use cubic spline KOPT(5) Options/Parameters tab, Options 

Radial segment Option Punch radial segment X/Q KOPT(6) Not included on screen. Not 
adjustable in NRCDose3. 

Output Option Punch output X/Q at point of 
interest KOPT(7) Not included on screen. Not 

adjustable in NRCDose3. 

Open terrain Option Correct value for open 
terrain KOPT(8) Options/Parameters tab, Options 

Site specific terrain 
Option 

Site specific terrain 
recirculation data KOPT(9) Options/Parameters tab, Options 

Desert sigma Option Desert sigma curves KOPT(10) Options/Parameters tab, Options 

30 degree sector Option 
Uneven sector sizes—
30 degrees in N, E, S, W 
and 20 degrees elsewhere 

KOPT(11) 
Not included on screen. Not 
adjustable in NRCDose3. Not used 
in Fortran code. 

Number wind velocities  Number of velocity 
categories NVEL Met Data tab 

Number stabilities Number of stability 
categories NSTA Met Data tab 

Units for wind speed Windspeed class units (mph 
or m/s) User selectable Met Data tab 

Number distances terrain 
data 

Number of distances with 
terrain data for each 
downwind sector 

NDIS Options/Parameters tab, 
Parameters 
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Table B-3 XOQDOQ Modifiable Parameters (cont.) 

Parameter/Information Description XOQDOQ 
 Notation Where Adjusted in NRCDose3 

Selection for plotting 
Increment for which plotted 
results are printed out (in 
percent) 

INC Options/Parameters tab, Parameters 

Receptors Number of titles of receptor 
types NPTYPE Options/Parameters tab, Parameters 

Release points Number of release exit points NEXIT Options/Parameters tab, Parameters 

Distances for 
recirculation 

Number of distances of 
site-specific correction factors 
for recirculation 

NCOR Options/Parameters tab, Parameters 

Wind Measurement 
Height 

Height above ground level (m) 
of measured windspeed 
presented in the JFD 

PLEV Met Data tab, Misc. 

X/Q Half-Lives 
Half-lives used in undecayed, 
decayed, and decayed/depleted 
X/Q calculations 

DECAYS 
Met Data tab. Half-lives used in X/Q 
calculations (days) (with explanations 
of departures from typical values) 

Plant Grade Elevation Plant grade elevation above sea 
level PLGRAD Met Data tab, Misc. 

Calms Data 
Time (hours) or percent 
frequency of calms for each 
stability class 

CALM Met Data tab 

Joint Frequency Data 

Time (hours) or percent 
frequency for each of the 16 
standard wind direction sectors, 
for each stability class and 
windspeed category 

FREQ 

Met Data tab, select stability class, 
enter the frequencies of occurrence for 
each wind direction sector 
(i.e., direction from relative to True 
North) and windspeed category 

Maximum Windspeeds Maximum speed in each 
windspeed class (mph or m/s) UMAX Met Data tab -> Max Windspeeds 

Correction Factor 
Distance 

Distance to site-specific 
correction factor in each of the 
16 downwind direction sectors 
(m) 

VRDIST 

Options/Parameters tab, 
Parameters -> Corrections, select 
distance number, enter site-specific 
distance for each correction factor for 
each downwind sector 
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Table B-3 XOQDOQ Modifiable Parameters (cont.) 

Parameter/Information Description XOQDOQ 
 Notation Where Adjusted in NRCDose3 

Correction Factor 

Site specific correction 
factor in each downwind 
direction sector for the 
specified distance 

VRCR 

Options/Parameters tab, Parameters -> 
Corrections, select distance number, 
enter site-specific correction factor for 
each downwind sector 

Terrain Factor 

Distance range for which 
terrain heights are given 
in each of the 16 
downwind direction 
sectors 

DIST 

Options/Parameters tab, Parameters -> 
Heights, select distance range, enter 
distance range with terrain data for each 
downwind sector  

Terrain Factor 

Terrain height per 
distance range in each of 
the 16 downwind 
direction sectors 

HT 
Options/Parameters tab, Parameters -> 
Heights, select distance range, enter 
terrain height for each downwind sector 

Receptors 
Number of receptor 
locations for a particular 
receptor type 

NPOINT 

Options/Parameters tab, Parameters -> 
Number of titles of receptor types -> 
Define, enter number of receptor locations 
(points) per receptor type 

Receptors Titles of receptor types TITLPT 
Options/Parameters tab, Parameters -> 
Number of titles of receptor types -> 
Define, enter titles of receptor types 

Receptors 
Receptor downwind 
direction and distance 
(m) 

KDIR, PTDIST 

Options/Parameters tab, Parameters -> 
Number of titles of receptor types -> 
Define -> Define, enter downwind 
direction and distance per receptor 
location (point) 

Release Points Vent/stack average 
velocity (m/s) EXIT 

Options/Parameters tab, Parameters -> 
Number of release exit points -> Details, 
select Release Point -> Edit 

Release Points Vent/stack inside 
diameter (m) DIAMTR 

Options/Parameters tab, Parameters -> 
Number of release exit points -> Details, 
select Release Point -> Edit 

Release Points Release point height (m) HSTACK 
Options/Parameters tab, Parameters -> 
Number of release exit points -> Details, 
select Release Point -> Edit 

Release Points Height of vent/stack 
building (m) HBLDG 

Options/Parameters tab, Parameters -> 
Number of release exit points -> Details, 
select Release Point -> Edit 

Release Points 
Minimum cross section 
area for vent/stack 
building (m2) 

CRSEC 
Options/Parameters tab, Parameters -> 
Number of release exit points -> Details, 
select Release Point -> Edit 
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Table B-3 XOQDOQ Modifiable Parameters (cont.) 

Parameter/Information Description XOQDOQ 
 Notation 

Where Adjusted in 
NRCDose3 

Release Points Wind height used for 
vent/stack release (m) SLEV 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details, 
select Release Point -> Edit 

Release Points Vent/stack heat emission 
rate (cal/s) HEATR 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details, 
select Release Point -> Edit 

Release Points Intermittent release X/Q to 
use IPURGE 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details -> 
Edit, select No Purge or Decay 
type 

Release Points Number of intermittent 
releases per year NPURGE 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details, 
select Release Point -> Edit 

Release Points Average number of hours 
per intermittent release NPRGHR 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details, 
select Release Point -> Edit 
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Table B-4 LADTAP II Hardwired Parameters 

Name Description 
Location in 

Fortran 
Code 

Value Units 

FACCA Bioaccumulation factors 
for freshwater plants BLOC 132 Values provided on a chemical 

element basis L/kg 

FACCF Bioaccumulation factors 
for freshwater fish BLOC 100 Values provided on a chemical 

element basis L/kg 

FACCI 
Bioaccumulation factors 
for freshwater 
invertebrates 

BLOC 116 Values provided on a chemical 
element basis L/kg 

SACCA Bioaccumulation factors 
for saltwater plants BLOC 180 Values provided on a chemical 

element basis L/kg 

SACCF Bioaccumulation factors 
for saltwater fish BLOC 148 Values provided on a chemical 

element basis L/kg 

SACCI Bioaccumulation factors 
for saltwater invertebrates BLOC 164 Values provided on a chemical 

element basis L/kg 

PLNTLF, PL Midpoint of plant life (yr) BLOC 195 20.0 years 

POP Total population in 50 
miles BLOC 40 260000000.0 people 

TPROCF Processing time for 
aquatic foods (hr) BLOC 215 24.0 hours 

TPROCW Processing time for water 
supply systems BLOC 215 12.0 hours 

DFL Ingestion dose factors  LADTAP.LIB 
file 

Values provided in separate file for 
each radionuclide, age range, and 
organ 

 

EXS 

External dose conversion 
factors for water 
immersion for each 
radionuclide/age group 
and organ (mrem/hr per 
pCi/L) 

LADTAP.LIB 
file 

Values provided in separate file for 
each radionuclide, age range, and 
organ 

 

EXG 

External dose conversion 
factors for ground 
exposure for each 
radionuclide/age group 
and organ (mrem/hr per 
pCi/m2) 

LADTAP.LIB 
file 

Values provided in separate file for 
each radionuclide, age range, and 
organ 
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Table B-4 LADTAP II Hardwired Parameters (cont.) 

Name Description 
Location in 

Fortran 
Code 

Value Units 

Q1 Milk animal pasture grass 
consumption rate (kg/d) BLOC 44 50.0  

Q2 Milk animal water 
consumption rate BLOC 44 60.0  

Q3 
Beef animal pasture 
grass consumption rate 
(kg/d) 

BLOC 44 50.0  

Q4 Beef animal water 
consumption rate (L/d) BLOC 44 50.0  

FRAC Fraction of deposition 
captured by vegetation BLOC 48 0.25  

ZMET Meat transfer coefficient  BLOC 50 Values provided in code for each 
chemical element  

SOIL Soil-to-plant transfer 
factors BLOC 68 Values provided in code for each 

chemical element  

ZMLK Milk transfer coefficient BLOC 84 Values provided in code for each 
chemical element  
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Table B-5 GASPAR II Hardwired Parameters 

Name Description 
Location in 

Fortran 
Code 

Value Units RG 1.109 
Notation 

AREA Total area within 50 
miles (mi2) BLKDATA17 2.00E+10 m2  

AVMET Average meat intake: 
child, teen, adult BLKDATA16 37, 59, 95 kg/yr Ua 

AVMLK Average milk intake: 
child, teen, adult BLKDATA15 170, 200, 110 L/yr Ua 

AVVEG Average vegetable 
intake: child, teen, adult BLKDATA15 200, 240, 190 kg/yr Ua 

POPF Population fractions: 
child, teen, adult BLKDATA15 0.18, 0.11, 0.71  fa 

USPOP U.S. population BLKDATA15 2.80E+08 people  

AVINH Average inhalation rate: 
child, teen, adult BLKDATA15 3700, 8000, 8000 L/yr Ua 

AVLVEG Average leafy vegetable 
intake: child, teen, adult BLKDATA15 10, 20, 30 kg/yr Ua 

SPINH Max inhalation rate: 
infant, child, teen, adult BLKDATA16 1400, 3700, 8000, 8000 L/yr Ua 

SPVEG Max vegetable intake: 
infant, child, teen, adult BLKDATA16 0, 520, 630, 520 kg/yr Ua 

SLVEG 
Max leafy vegetable 
intake: infant, child, teen, 
adult 

BLKDATA16 0, 26, 42, 64 kg/yr Ua 

SPMLK Max milk intake: infant, 
child, teen, adult BLKDATA16 330, 330, 400, 310 L/y Ua 

SPMET Max meat intake: infant, 
child, teen, adult BLKDATA16 0, 41, 65, 110 kg/yr Ua 

BLDAY 
Growing period for veg. 
consumed by an 
individual 

BLKDATA10 60 day te 

COWIN Cow feed ingestion rate BLKDATA10 50 kg/d QF 

DFA Inhalation dose factors  BLKDATA19 
Values provided in separate file 
for each radionuclide, age 
range, and organ 
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Table B-5 GASPAR II Hardwired Parameters (cont.) 

Name Description 
Location in 

Fortran 
Code 

Value Units RG 1.109 
Notation 

FID Fraction of iodine that 
deposits BLKDATA17 0.5   

GOATIN Goat feed ingestion rate BLKDATA10 6 kg/d QF 

PARTUP 

Retention factor of 
vegetables for 
particulates other than 
iodine 

BLKDATA10 0.2  r 

PLIFE Midpoint of plant life BLKDATA17 6.31E+08 s tb 

REMVEG Weather removal 
constant BLKDATA10 5.73E-07 sec-1 λw 

SD Soil surface density BLKDATA10 240 kg/m2 P 

SOIL Soil-to-plant transfer 
factors BLKDATA14 Values provided in code for 

each chemical element  Biv 

SF Shielding factor for 
individuals BLKDATA17 0.7  SF 

SSF Shielding factor for 
populations BLKDATA17 0.5  SF 

TAU Rad. decay constant BLKDATA21 Values provided in code for 
each radionuclide sec-1 λi 

TIM(1) 
Holdup and transport 
time: meat to 
consumption 

BLKDATA10 1.73E+06 sec ts and tp 

TIM(2) Holdup and transport 
time: milk to population BLKDATA10 3.46E+05 sec th and tp 

TIM(3) 
Holdup and transport 
time: vegetable to 
population 

BLKDATA10 1.21E+06 sec th and tp 

TIM(4) 
Holdup and transport 
time: vegetable to 
individual 

BLKDATA10 5.18E+06 sec th and tp 

TIM(5) Holdup and transport 
time: milk to individual BLKDATA10 1.73E+05 sec tf and tp 
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Table B-5 GASPAR II Hardwired Parameters (cont.) 

Name Description 
Location in 

Fortran 
Code 

Value Units RG 1.109 
Notation 

TIM(6) 
Holdup and transport 
time: leafy vegetables to 
individual 

BLKDATA10 8.64E+04 sec th and tp 

TIM(7) 
Holdup and transport 
time: pasture grazing 
period 

BLKDATA10 2.59E+06 sec te 

TIM(8) Holdup and transport 
time: feed storage time BLKDATA10 7.78E+06 sec th 

VHS Hydrosphere water 
volume  2.70E+19 L  

VIORET Iodine retention  BLKDATA10 1  r 

VNA Volume of the 
atmosphere BLKDATA17 3.80E+18 m3  

YA1 Pasture grass yield BLKDATA10 0.7 kg/m2 Yv 

YA2 Feed crop yield BLKDATA10 2 kg/m2 Yv 

YV Garden vegetable crop 
yield BLKDATA10 2 kg/m2 Yv 

ZGMLK 
Goat feed to milk 
transfer factor for each 
element 

BLKDATA10 Values provided for each 
chemical element d/L Fm 

ZMET Feed-to-meat transfer 
factor for each element BLKDATA12 Values provided for each 

chemical element d/kg Ff 

ZMLK Feed-to-cow transfer 
factor for each element BLKDATA11 Values provided for each 

chemical element d/L Fm 

BOTB Bone correction factor CARBON19 5 for bone, 1 for all others. 
Applies to carbon doses only.   

DFL Ingestion dose factors  DFLIB 
Values provided in separate file 
for each radionuclide, age 
range, and organ 

mrem/µ
Ci  

EXG 
External ground dose 
factors (mrem/hr per 
pCi/m2) 

PART 6 Values provided in separate file 
for each radionuclide 

(mrem/h
r per 

pCi/m2) 
DFG 
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Table B 6 XOQDOQ Hardwired Parameters 

Name Description 
Location in 

Fortran 
Code 

Value Units NOTE 

NDIR Number of wind 
direction sectors Line 124 16  

Not included on screen. Not 
adjustable in NRCDose3. 

C Building wake 
constant Line 124 0.5  

Default value may be changed 
on Options/Parameters tab, 
Parameters, but requires 
justification. 

KOPT(6) Punch radial 
segment X/Q    Not included on screen. Not 

adjustable in NRCDose3. 

KOPT(7) Punch output X/Q 
at point of interest    Not included on screen. Not 

adjustable in NRCDose3. 

KOPT(11
) 

Uneven sector 
sizes—
30 degrees in N, 
E, S, W and 
20 degrees 
elsewhere 

Line 501 0  
Not adjustable in NRCDose3. 
Not used in Fortran code. 

UCOR 
Correction for 
windspeed from 
mph to m/s 

 0.44704 m/s per mph  
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APPENDIX C 
USAGE PARAMETERS 

C.1 ICRP-30 Usage and Consumption Factors

In NRCDose3, the assumed usage and consumption values depend on the dose conversion 
factor (DCF) values chosen, regardless of whether the calculation is for a maximum or average 
individual or for a population or individual dose. When the DCF values used are those of 
International Commission on Radiological Protection (ICRP) Publication 2, “Report of 
Committee II on Permissible Dose for Internal Radiation” (ICRP-2), issued 1960 [Ref. 1], or 
ICRP Publication 30, “Limits for Intakes of Radionuclides by Workers” (ICRP-30), issued 1979 
[Ref. 2], the default usage and consumption values are based on Regulatory Guide (RG) 1.109, 
Revision 1, “Calculation of Annual Doses to Man from Routine Releases of Reactor Effluents for 
the Purpose of Evaluating Compliance with 10 CFR Part 50, Appendix I,” issued October 1977 
[Ref. 3]. Tables C-1 and C-2 display the usage and consumption values for the ICRP-2 and 
ICRP-30 DCF values from Tables E-4 and E-5 of RG 1.109. 

Table C-1 ICRP-2 and ICRP-30 DCF Average Individual Exposure Assumptions 

Pathway Units Infant Child Teen Adult Source 

Drinking Water L/yr 260 260 370 RG 1.109, Table E-4 

Inhalation m3/yr 3700 8000 8000 RG 1.109, Table E-4 

Fruit/Vegetables/Grain kg/yr 200 240 190 RG 1.109, Table E-4 

Leafy Vegetables kg/yr 10 20 30 Original LADTAP II code 

Milk L/yr 170 200 110 RG 1.109, Table E-4 

Meat kg/yr 37 59 95 RG 1.109, Table E-4 

Fish kg/yr 2.2 5.2 6.9 RG 1.109, Table E-4 

Other Seafood kg/yr 0.33 0.75 1.0 RG 1.109, Table E-4 
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Table C-2 ICRP-2 and ICRP-30 DCF Maximum Individual Exposure Assumptions 

Pathway Units Infant Child Teen Adult Source 
Drinking Water L/yr 330 510 510 730 RG 1.109, Table E-5 

Inhalation m3/yr 1400 3700 8000 8000 RG 1.109, Table E-5 

Fruit/Vegetables/Grain kg/yr 0 520 630 520 RG 1.109, Table E-5 

Leafy Vegetables kg/yr 0 26 42 64 RG 1.109, Table E-5 

Milk L/yr 330 330 400 310 RG 1.109, Table E-5 

Meat kg/yr 0 41 65 110 RG 1.109, Table E-5 

Fish kg/yr 0 6.9 16 21 RG 1.109, Table E-5 

Other Seafood kg/yr 0 1.7 3.8 5.0 RG 1.109, Table E-5 

Shoreline hr/yr 0 14 67 12 RG 1.109, Table E-5 

C.2 ICRP-72 Usage and Consumption Factors 

With the DCF values from ICRP Publication 60, “1990 Recommendations of the International 
Commission on Radiological Protection” (ICRP-60), issued 1991, or ICRP Publication 72, 
“Age-Dependent Dose to Members of the Public from Intake of Radionuclides, Part 5: 
Compilation of Ingestion and Inhalation Dose Coefficients” (ICRP-72), issued 1996, NRCDose3 
assumes usage and consumption values derived from the U.S. Environmental Protection 
Agency’s “Exposure Factors Handbook: 2011 Edition,” issued September 2011 [Ref. 6]. For all 
calculations, the usage and consumption values may be adjusted to account for site-specific 
behaviors. Tables C-3 and C-4 display the usage and consumption values assumed for the 
ICRP-60 and ICRP-72 DCF values. 

** User Note **—An applicant or licensee preparing a U.S. Nuclear Regulatory Commission 
(NRC) license amendment request should discuss the use of ICRP-72 usage and consumption 
values with the NRC staff before submitting the request. 
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Table C-3 ICRP-72 DCF Average Individual Exposure Assumptions 

Pathway Units Infant 
1-year 
(Child) 

5-year 
(Child) 

10-year 
(Child) 

15-year 
(Teen) Adult 

Drinking Water L/yr   139  187 448 

Inhalation m3/yr 1971 3249 3760 4380 5548 5950 

Fruit/Vegetables/Grain kg/yr 71 107 111 123 120 175 

Milk L/yr 26 197 141 125 83 70 

Meat kg/yr 6.4 18 22 29 35 47 

Fish kg/yr   7.1  11 18 

Other Seafood kg/yr   1.8  2.9 4.4 

Table C-4 ICRP-72 DCF Maximum Individual Exposure Assumptions 

Pathway Units Infant 
1-year 
(Child) 

5-year 
(Child) 

10-year 
(Child) 

15-year 
(Teen) Adult 

Drinking Water L/yr 385 320 350 480 480 1080 

Inhalation m3/yr 3360 5000 5040 6060 8000 8980 

Fruit/Vegetables/Grain kg/yr 182 249 269 323 296 429 

Milk L/yr 150 477 347 369 340 301 

Meat kg/yr 27 51 58 74 97 120 

Fish kg/yr 8 24 20 25 30 58 

Other Seafood (saltwater 
invert.) 

kg/yr 2 6 5 6 7 15 

Shoreline hr/yr 17 48 48 48 48 48 

Swimming hr/yr 19 36 36 36 36 36 
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APPENDIX D 
EFFECTIVE RADIUS 

D.1 Absorbed Energy in Spheres of Various Sizes

In LADTAP II and GASPAR II, the calculation of doses to aquatic and terrestrial biota is based 
on the energy absorbed in a unit-density sphere (considered muscle) due to nuclear 
transformation (decay) of an incorporated radionuclide. In earlier versions of NRCDose, 
LADTAP II and GASPAR II addressed a limited number of radionuclides, with the absorbed 
energy derived using dated analytical methods for computing the energies and intensities of the 
emitted radiations and the absorbed fraction of the photon emissions. The methodology in 
NRCDose3 has been updated to use nuclear decay data from International Commission on 
Radiological Protection (ICRP) Publication 107, “Nuclear Decay Data for Dosimetric 
Calculations” (ICRP-107), issued 2008 [Ref. 1], and photon absorbed fraction data from Stabin 
and Konijnenberg [Ref. 2] to tabulate the absorbed energy for eight unit-density spheres, 
ranging in radius from 1.0 to 30 centimeters (cm), for 203 radionuclides of interest. 

The absorbed energy  is computed using equation (D-1): 

𝐸𝐸𝑟𝑟𝑎𝑎𝐶𝐶 = ∑𝑟𝑟  ∑ 𝑌𝑌𝑟𝑟,𝐶𝐶  𝐸𝐸𝑟𝑟,𝐶𝐶  𝐴𝐴𝐷𝐷𝑟𝑟,𝐶𝐶
𝑁𝑁𝑟𝑟
𝐶𝐶  (D-1) 

where ∑𝑟𝑟 = summation over the various radiation types r, 

∑𝐶𝐶
𝑁𝑁𝑟𝑟 = summation over the Nr radiations of type r emitted in 

the decay of the radionuclide, 

Yr,i = the yield per decay in becquerel-seconds (Bq s), 

Er,i = the energy per decay in megaelectron volts (MeV), and 

AFr,i = the absorbed fraction in the sphere (unitless). 

The value of AFr,i for all radiations other than photons, and for photons of energy less than 
10 kiloelectronvolts (keV), is assumed to be 1. For photons of energy greater than 10 keV, the 
absorbed fraction is based on Stabin and Konijnenberg [Ref. 2]. For spheres of radius 15 or 
30 cm, Monte Carlo calculations were undertaken using the Monte Carlo N-Particle (MCNP) 
Transport Code [Ref. 3]. The resulting quantity is in units of MeV/Bq s. The computations use no 
relative biological effectiveness factors. Table D-1 gives the radius, in centimeters, and the 
mass, in kilograms, of each of the eight spheres considered. Table D-2 gives the absorbed 
energies derived for the 203 radionuclides. 
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Table D-1 Radii and Masses of Unit-Density Spheres 

Radius (cm) Mass (kg) 

1.0 0.0042 

1.5 0.014 

2.5 0.065 

3.5 0.18 

5.0 0.52 

10 4.2 

15 14 

30 113 

Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius 

Nuclide 
Radius (cm) 

1 1.5 2.5 3.5 5 10 15 30 
H-3 5.68E-03 5.68E-03 5.68E-03 5.68E-03 5.68E-03 5.68E-03 5.68E-03 5.68E-03 

Be-10 2.52E-01 2.52E-01 2.52E-01 2.52E-01 2.52E-01 2.52E-01 2.52E-01 2.52E-01 
C-14 4.95E-02 4.95E-02 4.95E-02 4.95E-02 4.95E-02 4.95E-02 4.95E-02 4.95E-02 
N-13 5.14E-01 5.27E-01 5.51E-01 5.76E-01 6.14E-01 7.30E-01 8.01E-01 1.01E+00 
F-18 2.64E-01 2.77E-01 3.00E-01 3.24E-01 3.61E-01 4.73E-01 5.42E-01 7.42E-01 

Na-22 2.39E-01 2.64E-01 3.12E-01 3.60E-01 4.34E-01 6.63E-01 8.15E-01 1.24E+00 
Na-24 6.06E-01 6.43E-01 7.16E-01 7.90E-01 9.03E-01 1.25E+00 1.52E+00 2.22E+00 
P-32 6.95E-01 6.95E-01 6.95E-01 6.95E-01 6.95E-01 6.95E-01 6.95E-01 6.95E-01 
S-35 4.87E-02 4.87E-02 4.87E-02 4.87E-02 4.87E-02 4.87E-02 4.87E-02 4.87E-02 
Cl-36 2.73E-01 2.73E-01 2.73E-01 2.73E-01 2.73E-01 2.73E-01 2.73E-01 2.73E-01 
Ar-39 2.19E-01 2.19E-01 2.19E-01 2.19E-01 2.19E-01 2.19E-01 2.19E-01 2.19E-01 
Ar-41 4.87E-01 5.01E-01 5.27E-01 5.54E-01 5.93E-01 7.18E-01 8.07E-01 1.05E+00 
Ca-41 3.23E-03 3.23E-03 3.23E-03 3.23E-03 3.23E-03 3.23E-03 3.23E-03 3.23E-03 
Ca-45 7.72E-02 7.72E-02 7.72E-02 7.72E-02 7.72E-02 7.72E-02 7.72E-02 7.72E-02 
Sc-46 1.53E-01 1.76E-01 2.19E-01 2.63E-01 3.29E-01 5.33E-01 6.75E-01 1.07E+00 
Cr-51 5.70E-03 6.09E-03 6.85E-03 7.62E-03 8.85E-03 1.27E-02 1.48E-02 2.14E-02 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius (cm) 

1 1.5 2.5 3.5 5 10 15 30 
Mn-54 2.35E-02 3.37E-02 5.22E-02 7.11E-02 9.98E-02 1.87E-01 2.47E-01 4.14E-01 
Mn-56 8.60E-01 8.78E-01 9.13E-01 9.47E-01 1.00E+00 1.16E+00 1.28E+00 1.60E+00 
Fe-55 5.83E-03 5.83E-03 5.83E-03 5.83E-03 5.83E-03 5.83E-03 5.83E-03 5.83E-03 
Fe-59 1.41E-01 1.54E-01 1.79E-01 2.03E-01 2.41E-01 3.58E-01 4.41E-01 6.71E-01 
Co-57 2.55E-02 2.69E-02 2.98E-02 3.29E-02 3.79E-02 5.41E-02 6.09E-02 9.02E-02 
Co-58 5.69E-02 6.89E-02 9.07E-02 1.13E-01 1.47E-01 2.51E-01 3.20E-01 5.16E-01 
Co-60 1.44E-01 1.70E-01 2.22E-01 2.74E-01 3.52E-01 5.96E-01 7.70E-01 1.25E+00 
Ni-59 6.89E-03 6.89E-03 6.89E-03 6.89E-03 6.89E-03 6.89E-03 6.89E-03 6.90E-03 
Ni-63 1.74E-02 1.74E-02 1.74E-02 1.74E-02 1.74E-02 1.74E-02 1.74E-02 1.74E-02 
Ni-65 6.38E-01 6.44E-01 6.55E-01 6.66E-01 6.84E-01 7.38E-01 7.76E-01 8.82E-01 
Cu-64 1.30E-01 1.32E-01 1.37E-01 1.41E-01 1.48E-01 1.69E-01 1.82E-01 2.19E-01 
Ga-67 4.47E-02 4.64E-02 5.00E-02 5.39E-02 6.02E-02 8.02E-02 8.96E-02 1.24E-01 
Zn-65 2.14E-02 2.79E-02 4.02E-02 5.25E-02 7.13E-02 1.29E-01 1.70E-01 2.83E-01 

Zn-69m 3.25E-02 3.77E-02 4.76E-02 5.77E-02 7.36E-02 1.22E-01 1.51E-01 2.34E-01 
Zn-69 3.22E-01 3.22E-01 3.22E-01 3.22E-01 3.22E-01 3.22E-01 3.22E-01 3.22E-01 
Se-75 2.78E-02 3.26E-02 4.18E-02 5.13E-02 6.67E-02 1.15E-01 1.38E-01 2.24E-01 
Se-79 5.29E-02 5.29E-02 5.29E-02 5.29E-02 5.29E-02 5.29E-02 5.29E-02 5.29E-02 
Br-82 2.01E-01 2.32E-01 2.90E-01 3.49E-01 4.39E-01 7.15E-01 9.00E-01 1.42E+00 
Br-83 3.26E-01 3.26E-01 3.26E-01 3.26E-01 3.27E-01 3.27E-01 3.28E-01 3.29E-01 
Br-84 1.26E+00 1.28E+00 1.31E+00 1.34E+00 1.40E+00 1.55E+00 1.67E+00 1.97E+00 
Br-85 1.04E+00 1.04E+00 1.04E+00 1.04E+00 1.05E+00 1.05E+00 1.06E+00 1.07E+00 

Kr-83m 4.09E-02 4.10E-02 4.12E-02 4.13E-02 4.14E-02 4.15E-02 4.15E-02 4.15E-02 
Kr-85m 2.59E-01 2.61E-01 2.64E-01 2.68E-01 2.75E-01 2.94E-01 3.04E-01 3.40E-01 
Kr-85 2.51E-01 2.51E-01 2.51E-01 2.51E-01 2.51E-01 2.51E-01 2.51E-01 2.52E-01 
Kr-87 1.34E+00 1.35E+00 1.36E+00 1.38E+00 1.40E+00 1.48E+00 1.53E+00 1.67E+00 
Kr-88 3.98E-01 4.16E-01 4.52E-01 4.88E-01 5.44E-01 7.16E-01 8.47E-01 1.19E+00 
Kr-89 1.40E+00 1.42E+00 1.46E+00 1.50E+00 1.56E+00 1.73E+00 1.86E+00 2.21E+00 
Rb-86 6.70E-01 6.71E-01 6.73E-01 6.75E-01 6.78E-01 6.87E-01 6.94E-01 7.12E-01 
Rb-87 1.15E-01 1.15E-01 1.15E-01 1.15E-01 1.15E-01 1.15E-01 1.15E-01 1.15E-01 
Rb-88 2.08E+00 2.09E+00 2.10E+00 2.11E+00 2.13E+00 2.19E+00 2.23E+00 2.35E+00 
Sr-85 2.52E-02 3.20E-02 4.44E-02 5.66E-02 7.55E-02 1.32E-01 1.66E-01 2.66E-01 
Rb-89 9.91E-01 1.01E+00 1.06E+00 1.10E+00 1.17E+00 1.38E+00 1.54E+00 1.95E+00 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius (cm) 

1 1.5 2.5 3.5 5 10 15 30 
Sr-89 5.85E-01 5.85E-01 5.85E-01 5.85E-01 5.85E-01 5.85E-01 5.85E-01 5.85E-01 
Sr-90 1.96E-01 1.96E-01 1.96E-01 1.96E-01 1.96E-01 1.96E-01 1.96E-01 1.96E-01 
Sr-91 6.70E-01 6.78E-01 6.94E-01 7.09E-01 7.33E-01 8.07E-01 8.56E-01 9.97E-01 
Sr-92 2.27E-01 2.40E-01 2.68E-01 2.95E-01 3.36E-01 4.65E-01 5.57E-01 8.09E-01 
Y-89m 2.67E-02 3.76E-02 5.73E-02 7.73E-02 1.08E-01 2.01E-01 2.65E-01 4.45E-01 
Y-90 9.33E-01 9.33E-01 9.33E-01 9.33E-01 9.33E-01 9.33E-01 9.33E-01 9.33E-01 

Y-91m 4.02E-02 4.69E-02 5.93E-02 7.19E-02 9.15E-02 1.51E-01 1.88E-01 2.95E-01 
Y-91 6.03E-01 6.03E-01 6.03E-01 6.03E-01 6.04E-01 6.04E-01 6.04E-01 6.05E-01 
Y-92 1.45E+00 1.46E+00 1.46E+00 1.47E+00 1.48E+00 1.50E+00 1.52E+00 1.57E+00 
Y-93 1.17E+00 1.17E+00 1.18E+00 1.18E+00 1.18E+00 1.19E+00 1.20E+00 1.22E+00 
Zr-93 1.94E-02 1.94E-02 1.94E-02 1.94E-02 1.94E-02 1.94E-02 1.94E-02 1.94E-02 
Zr-95 1.35E-01 1.44E-01 1.60E-01 1.77E-01 2.03E-01 2.81E-01 3.33E-01 4.81E-01 
Zr-97 7.40E-01 7.51E-01 7.71E-01 7.91E-01 8.21E-01 9.15E-01 9.77E-01 1.15E+00 

Nb-93m 3.04E-02 3.06E-02 3.08E-02 3.10E-02 3.11E-02 3.13E-02 3.13E-02 3.14E-02 
Nb-95 6.13E-02 7.08E-02 8.79E-02 1.05E-01 1.32E-01 2.14E-01 2.68E-01 4.22E-01 

Nb-95m 1.84E-01 1.86E-01 1.88E-01 1.90E-01 1.93E-01 2.02E-01 2.06E-01 2.20E-01 
Nb-97 4.83E-01 4.92E-01 5.07E-01 5.22E-01 5.46E-01 6.19E-01 6.65E-01 8.00E-01 

Nb-97m 4.83E-01 4.92E-01 5.07E-01 5.22E-01 5.46E-01 6.19E-01 6.65E-01 8.00E-01 
Mo-93 1.01E-02 1.12E-02 1.27E-02 1.36E-02 1.44E-02 1.53E-02 1.56E-02 1.59E-02 
Mo-99 3.96E-01 3.98E-01 4.02E-01 4.05E-01 4.11E-01 4.27E-01 4.37E-01 4.68E-01 
Tc-99m 1.94E-02 2.08E-02 2.39E-02 2.71E-02 3.23E-02 4.87E-02 5.60E-02 8.65E-02 
Tc-99 1.01E-01 1.01E-01 1.01E-01 1.01E-01 1.01E-01 1.01E-01 1.01E-01 1.01E-01 
Tc-101 4.80E-01 4.84E-01 4.92E-01 5.01E-01 5.14E-01 5.54E-01 5.76E-01 6.47E-01 
Ru-103 7.76E-02 8.38E-02 9.55E-02 1.07E-01 1.26E-01 1.83E-01 2.17E-01 3.17E-01 
Ru-105 4.58E-01 4.67E-01 4.85E-01 5.02E-01 5.30E-01 6.12E-01 6.64E-01 8.16E-01 
Ru-106 1.00E-02 1.00E-02 1.00E-02 1.00E-02 1.00E-02 1.00E-02 1.00E-02 1.00E-02 

Rh-103m 3.83E-02 3.85E-02 3.87E-02 3.88E-02 3.90E-02 3.92E-02 3.93E-02 3.93E-02 
Rh-105 1.55E-01 1.56E-01 1.58E-01 1.60E-01 1.63E-01 1.72E-01 1.77E-01 1.93E-01 

Rh-105m 1.55E-01 1.56E-01 1.58E-01 1.60E-01 1.63E-01 1.72E-01 1.77E-01 1.93E-01 
Pd-107 9.58E-03 9.58E-03 9.58E-03 9.58E-03 9.58E-03 9.58E-03 9.58E-03 9.58E-03 
Pd-109 4.40E-01 4.41E-01 4.42E-01 4.43E-01 4.44E-01 4.46E-01 4.46E-01 4.48E-01 
Cd-109 8.85E-02 9.07E-02 9.41E-02 9.64E-02 9.89E-02 1.03E-01 1.04E-01 1.07E-01 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius (cm) 

1 1.5 2.5 3.5 5 10 15 30 
Ag-110 1.18E+00 1.18E+00 1.18E+00 1.18E+00 1.18E+00 1.19E+00 1.19E+00 1.20E+00 

Ag-110m 1.33E-01 1.66E-01 2.26E-01 2.87E-01 3.80E-01 6.66E-01 8.60E-01 1.41E+00 
Ag-111 3.55E-01 3.55E-01 3.55E-01 3.56E-01 3.57E-01 3.60E-01 3.62E-01 3.68E-01 

Cd-113m 1.85E-01 1.85E-01 1.85E-01 1.85E-01 1.85E-01 1.85E-01 1.85E-01 1.85E-01 
Cd-115m 6.05E-01 6.06E-01 6.06E-01 6.07E-01 6.08E-01 6.11E-01 6.14E-01 6.20E-01 
Sn-113 1.00E-02 1.16E-02 1.41E-02 1.59E-02 1.81E-02 2.19E-02 2.33E-02 2.61E-02 
Sn-123 5.23E-01 5.23E-01 5.23E-01 5.23E-01 5.23E-01 5.24E-01 5.25E-01 5.26E-01 
Sn-125 8.10E-01 8.14E-01 8.21E-01 8.28E-01 8.39E-01 8.72E-01 8.96E-01 9.61E-01 
Sn-126 1.41E-01 1.42E-01 1.45E-01 1.47E-01 1.50E-01 1.59E-01 1.63E-01 1.75E-01 
Sb-124 4.18E-01 4.38E-01 4.77E-01 5.15E-01 5.75E-01 7.58E-01 8.86E-01 1.24E+00 
Sb-125 1.13E-01 1.19E-01 1.31E-01 1.42E-01 1.59E-01 2.11E-01 2.41E-01 3.29E-01 
Sb-126 4.16E-01 4.50E-01 5.13E-01 5.77E-01 6.76E-01 9.77E-01 1.17E+00 1.73E+00 

Sb-126m 6.67E-01 6.86E-01 7.22E-01 7.58E-01 8.15E-01 9.86E-01 1.09E+00 1.41E+00 
Sb-127 3.32E-01 3.40E-01 3.56E-01 3.73E-01 3.98E-01 4.75E-01 5.23E-01 6.64E-01 

Te-125m 1.14E-01 1.16E-01 1.20E-01 1.23E-01 1.27E-01 1.34E-01 1.37E-01 1.41E-01 
Te-127m 8.42E-02 8.48E-02 8.60E-02 8.69E-02 8.81E-02 9.03E-02 9.11E-02 9.24E-02 
Te-127 2.25E-01 2.25E-01 2.25E-01 2.25E-01 2.25E-01 2.26E-01 2.26E-01 2.27E-01 

Te-129m 2.73E-01 2.74E-01 2.75E-01 2.77E-01 2.78E-01 2.83E-01 2.86E-01 2.93E-01 
Te-129 5.46E-01 5.47E-01 5.49E-01 5.51E-01 5.53E-01 5.61E-01 5.65E-01 5.77E-01 

Te-131m 2.18E-01 2.35E-01 2.68E-01 3.00E-01 3.51E-01 5.03E-01 6.05E-01 8.94E-01 
Te-131 7.22E-01 7.27E-01 7.36E-01 7.46E-01 7.62E-01 8.10E-01 8.38E-01 9.26E-01 
Te-132 1.19E-01 1.22E-01 1.29E-01 1.36E-01 1.48E-01 1.79E-01 1.94E-01 2.45E-01 
Te-133 7.13E-01 7.26E-01 7.52E-01 7.78E-01 8.18E-01 9.41E-01 1.02E+00 1.26E+00 

Te-133m 4.26E-01 4.48E-01 4.89E-01 5.30E-01 5.93E-01 7.85E-01 9.14E-01 1.28E+00 
Te-134 2.47E-01 2.58E-01 2.79E-01 3.00E-01 3.33E-01 4.33E-01 4.92E-01 6.72E-01 
I-125 2.55E-02 2.80E-02 3.26E-02 3.63E-02 4.10E-02 4.96E-02 5.23E-02 5.76E-02 
I-129 6.80E-02 6.92E-02 7.15E-02 7.35E-02 7.62E-02 8.16E-02 8.33E-02 8.69E-02 
I-130 3.26E-01 3.53E-01 4.01E-01 4.51E-01 5.28E-01 7.62E-01 9.11E-01 1.34E+00 
I-131 2.01E-01 2.06E-01 2.15E-01 2.24E-01 2.39E-01 2.84E-01 3.10E-01 3.88E-01 
I-132 5.41E-01 5.69E-01 6.19E-01 6.70E-01 7.48E-01 9.87E-01 1.15E+00 1.60E+00 
I-133 4.28E-01 4.35E-01 4.50E-01 4.64E-01 4.86E-01 5.54E-01 5.97E-01 7.20E-01 
I-134 6.31E-01 6.62E-01 7.18E-01 7.75E-01 8.63E-01 1.13E+00 1.31E+00 1.83E+00 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius (cm) 

1 1.5 2.5 3.5 5 10 15 30 
I-134m 1.01E-01 1.05E-01 1.14E-01 1.22E-01 1.35E-01 1.72E-01 1.91E-01 2.51E-01 
I-135 3.75E-01 3.92E-01 4.24E-01 4.57E-01 5.06E-01 6.59E-01 7.68E-01 1.07E+00 

Xe-131m 1.49E-01 1.50E-01 1.52E-01 1.54E-01 1.56E-01 1.60E-01 1.61E-01 1.64E-01 
Xe-133m 1.95E-01 1.96E-01 1.99E-01 2.01E-01 2.03E-01 2.10E-01 2.13E-01 2.20E-01 
Xe-133 1.40E-01 1.42E-01 1.44E-01 1.46E-01 1.49E-01 1.58E-01 1.61E-01 1.70E-01 

Xe-135m 1.11E-01 1.16E-01 1.27E-01 1.37E-01 1.53E-01 2.02E-01 2.32E-01 3.17E-01 
Xe-135 3.27E-01 3.30E-01 3.35E-01 3.42E-01 3.51E-01 3.82E-01 3.98E-01 4.52E-01 
Xe-137 1.70E+00 1.70E+00 1.71E+00 1.71E+00 1.72E+00 1.74E+00 1.75E+00 1.79E+00 
Xe-138 6.79E-01 6.90E-01 7.13E-01 7.35E-01 7.69E-01 8.76E-01 9.52E-01 1.16E+00 

Cs-134m 1.15E-01 1.15E-01 1.17E-01 1.18E-01 1.20E-01 1.24E-01 1.26E-01 1.31E-01 
Cs-134 1.98E-01 2.17E-01 2.53E-01 2.88E-01 3.44E-01 5.11E-01 6.21E-01 9.35E-01 
Cs-135 8.94E-02 8.94E-02 8.94E-02 8.94E-02 8.94E-02 8.94E-02 8.94E-02 8.94E-02 
Cs-136 1.90E-01 2.15E-01 2.62E-01 3.09E-01 3.81E-01 6.04E-01 7.53E-01 1.18E+00 
Cs-137 1.88E-01 1.88E-01 1.88E-01 1.88E-01 1.88E-01 1.88E-01 1.88E-01 1.88E-01 
Cs-138 1.29E+00 1.31E+00 1.36E+00 1.41E+00 1.48E+00 1.70E+00 1.86E+00 2.30E+00 
Cs-139 1.66E+00 1.67E+00 1.67E+00 1.68E+00 1.69E+00 1.72E+00 1.74E+00 1.79E+00 
Ba-133 6.85E-02 7.48E-02 8.70E-02 9.91E-02 1.18E-01 1.71E-01 1.97E-01 2.79E-01 

Ba-137m 7.89E-02 8.65E-02 1.00E-01 1.14E-01 1.36E-01 2.01E-01 2.43E-01 3.64E-01 
Ba-139 9.02E-01 9.03E-01 9.04E-01 9.05E-01 9.07E-01 9.13E-01 9.16E-01 9.26E-01 
Ba-140 3.26E-01 3.28E-01 3.33E-01 3.38E-01 3.45E-01 3.66E-01 3.79E-01 4.16E-01 
Ba-141 9.82E-01 9.92E-01 1.01E+00 1.03E+00 1.07E+00 1.17E+00 1.23E+00 1.42E+00 
Ba-142 4.36E-01 4.49E-01 4.72E-01 4.95E-01 5.31E-01 6.42E-01 7.14E-01 9.23E-01 
La-140 5.76E-01 6.00E-01 6.47E-01 6.94E-01 7.67E-01 9.90E-01 1.15E+00 1.58E+00 
La-141 9.88E-01 9.88E-01 9.89E-01 9.89E-01 9.90E-01 9.93E-01 9.95E-01 1.00E+00 
La-142 9.04E-01 9.26E-01 9.70E-01 1.01E+00 1.08E+00 1.29E+00 1.45E+00 1.87E+00 
Ce-141 1.73E-01 1.74E-01 1.76E-01 1.78E-01 1.82E-01 1.92E-01 1.97E-01 2.15E-01 
Ce-143 4.44E-01 4.48E-01 4.56E-01 4.64E-01 4.76E-01 5.11E-01 5.30E-01 5.87E-01 
Ce-144 9.23E-02 9.25E-02 9.31E-02 9.38E-02 9.48E-02 9.76E-02 9.88E-02 1.03E-01 
Pr-143 3.15E-01 3.15E-01 3.15E-01 3.15E-01 3.15E-01 3.15E-01 3.15E-01 3.15E-01 
Pr-144 1.21E+00 1.21E+00 1.21E+00 1.21E+00 1.21E+00 1.21E+00 1.22E+00 1.22E+00 

Pr-144m 4.89E-02 4.93E-02 5.01E-02 5.09E-02 5.20E-02 5.47E-02 5.57E-02 5.78E-02 
Nd-147 2.74E-01 2.76E-01 2.80E-01 2.84E-01 2.91E-01 3.10E-01 3.20E-01 3.48E-01 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius (cm) 

1 1.5 2.5 3.5 5 10 15 30 
Pm-147 6.19E-02 6.19E-02 6.19E-02 6.19E-02 6.19E-02 6.19E-02 6.19E-02 6.19E-02 

Pm-148m 2.15E-01 2.39E-01 2.85E-01 3.31E-01 4.03E-01 6.23E-01 7.62E-01 1.16E+00 
Pm-148 7.40E-01 7.46E-01 7.58E-01 7.70E-01 7.89E-01 8.46E-01 8.86E-01 9.97E-01 
Pm-149 3.65E-01 3.65E-01 3.66E-01 3.66E-01 3.67E-01 3.68E-01 3.69E-01 3.71E-01 
Pm-151 3.13E-01 3.17E-01 3.25E-01 3.33E-01 3.47E-01 3.87E-01 4.09E-01 4.77E-01 
Sm-151 2.00E-02 2.00E-02 2.00E-02 2.00E-02 2.00E-02 2.00E-02 2.00E-02 2.00E-02 
Sm-153 2.73E-01 2.74E-01 2.76E-01 2.78E-01 2.82E-01 2.93E-01 2.98E-01 3.11E-01 
Eu-152 1.54E-01 1.68E-01 1.94E-01 2.21E-01 2.61E-01 3.86E-01 4.68E-01 6.99E-01 
Eu-154 2.99E-01 3.13E-01 3.40E-01 3.68E-01 4.10E-01 5.39E-01 6.27E-01 8.74E-01 
Eu-155 6.67E-02 6.75E-02 6.92E-02 7.10E-02 7.41E-02 8.38E-02 8.78E-02 1.02E-01 
Eu-156 4.80E-01 4.93E-01 5.18E-01 5.43E-01 5.81E-01 7.00E-01 7.85E-01 1.02E+00 
Tb-160 2.83E-01 2.96E-01 3.21E-01 3.46E-01 3.84E-01 5.02E-01 5.81E-01 8.05E-01 

Ho-166m 1.87E-01 2.07E-01 2.44E-01 2.82E-01 3.41E-01 5.21E-01 6.35E-01 9.68E-01 
Tm-170 3.28E-01 3.28E-01 3.29E-01 3.29E-01 3.29E-01 3.29E-01 3.30E-01 3.31E-01 
Yb-169 1.60E-01 1.64E-01 1.72E-01 1.81E-01 1.97E-01 2.45E-01 2.75E-01 3.46E-01 
W-181 1.61E-02 1.66E-02 1.77E-02 1.89E-02 2.10E-02 2.76E-02 3.19E-02 4.00E-02 
W-185 1.27E-01 1.27E-01 1.27E-01 1.27E-01 1.27E-01 1.27E-01 1.27E-01 1.27E-01 
W-187 3.10E-01 3.16E-01 3.26E-01 3.37E-01 3.54E-01 4.05E-01 4.37E-01 5.28E-01 
Ta-182 2.38E-01 2.52E-01 2.80E-01 3.08E-01 3.50E-01 4.84E-01 5.74E-01 8.28E-01 
Ir-192 2.37E-01 2.47E-01 2.66E-01 2.86E-01 3.18E-01 4.14E-01 4.69E-01 6.38E-01 

Au-198 3.37E-01 3.42E-01 3.52E-01 3.62E-01 3.77E-01 4.24E-01 4.52E-01 5.33E-01 
Tl-201 5.10E-02 5.23E-02 5.47E-02 5.73E-02 6.17E-02 7.55E-02 8.17E-02 1.03E-01 
Tl-204 2.37E-01 2.37E-01 2.37E-01 2.37E-01 2.37E-01 2.38E-01 2.38E-01 2.38E-01 
Pb-210 4.29E-02 4.32E-02 4.35E-02 4.37E-02 4.39E-02 4.44E-02 4.47E-02 4.51E-02 
Bi-210 3.89E-01 3.89E-01 3.89E-01 3.89E-01 3.89E-01 3.89E-01 3.89E-01 3.89E-01 
Po-210 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 
Rn-222 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 
Ra-223 5.85E+00 5.86E+00 5.86E+00 5.86E+00 5.87E+00 5.89E+00 5.90E+00 5.93E+00 
Ra-225 1.07E-01 1.08E-01 1.09E-01 1.09E-01 1.11E-01 1.13E-01 1.15E-01 1.17E-01 
Ra-224 5.78E+00 5.78E+00 5.78E+00 5.78E+00 5.78E+00 5.78E+00 5.78E+00 5.78E+00 
Ra-226 4.86E+00 4.86E+00 4.86E+00 4.86E+00 4.87E+00 4.87E+00 4.87E+00 4.87E+00 
Ra-228 1.50E-02 1.52E-02 1.55E-02 1.57E-02 1.59E-02 1.61E-02 1.61E-02 1.62E-02 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius (cm) 

1 1.5 2.5 3.5 5 10 15 30 
Ac-225 5.92E+00 5.92E+00 5.92E+00 5.92E+00 5.92E+00 5.92E+00 5.92E+00 5.93E+00 
Ac-227 8.50E-02 8.50E-02 8.51E-02 8.52E-02 8.52E-02 8.52E-02 8.53E-02 8.53E-02 
Th-227 6.07E+00 6.07E+00 6.08E+00 6.08E+00 6.09E+00 6.10E+00 6.11E+00 6.14E+00 
Th-228 5.52E+00 5.52E+00 5.52E+00 5.52E+00 5.52E+00 5.52E+00 5.52E+00 5.52E+00 
Th-229 5.09E+00 5.09E+00 5.10E+00 5.10E+00 5.10E+00 5.12E+00 5.12E+00 5.14E+00 
Th-230 4.77E+00 4.77E+00 4.77E+00 4.77E+00 4.77E+00 4.77E+00 4.77E+00 4.77E+00 
Th-232 4.08E+00 4.08E+00 4.08E+00 4.08E+00 4.08E+00 4.08E+00 4.08E+00 4.08E+00 
Th-234 6.35E-02 6.37E-02 6.41E-02 6.45E-02 6.50E-02 6.65E-02 6.71E-02 6.92E-02 
Pa-231 5.12E+00 5.12E+00 5.12E+00 5.12E+00 5.13E+00 5.13E+00 5.13E+00 5.14E+00 
Pa-233 2.25E-01 2.29E-01 2.35E-01 2.41E-01 2.50E-01 2.77E-01 2.91E-01 3.37E-01 
U-232 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 
U-233 4.91E+00 4.91E+00 4.91E+00 4.91E+00 4.91E+00 4.91E+00 4.91E+00 4.91E+00 
U-234 4.86E+00 4.86E+00 4.86E+00 4.86E+00 4.86E+00 4.86E+00 4.86E+00 4.86E+00 
U-235 4.53E+00 4.53E+00 4.54E+00 4.54E+00 4.55E+00 4.57E+00 4.58E+00 4.62E+00 
U-236 4.57E+00 4.57E+00 4.57E+00 4.57E+00 4.57E+00 4.57E+00 4.57E+00 4.57E+00 
U-237 2.09E-01 2.11E-01 2.16E-01 2.20E-01 2.27E-01 2.46E-01 2.55E-01 2.86E-01 
U-238 4.27E+00 4.27E+00 4.27E+00 4.27E+00 4.27E+00 4.27E+00 4.27E+00 4.27E+00 
Np-237 4.92E+00 4.93E+00 4.93E+00 4.93E+00 4.93E+00 4.94E+00 4.94E+00 4.94E+00 
Np-238 2.67E-01 2.74E-01 2.88E-01 3.01E-01 3.20E-01 3.80E-01 4.21E-01 5.37E-01 
Np-239 2.72E-01 2.75E-01 2.80E-01 2.85E-01 2.93E-01 3.17E-01 3.28E-01 3.68E-01 
Pu-236 5.87E+00 5.87E+00 5.87E+00 5.87E+00 5.87E+00 5.87E+00 5.87E+00 5.87E+00 
Pu-238 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 
Pu-239 5.24E+00 5.24E+00 5.24E+00 5.24E+00 5.24E+00 5.24E+00 5.24E+00 5.24E+00 
Pu-240 5.25E+00 5.26E+00 5.26E+00 5.26E+00 5.26E+00 5.26E+00 5.26E+00 5.26E+00 
Pu-241 5.36E-03 5.36E-03 5.36E-03 5.36E-03 5.36E-03 5.36E-03 5.36E-03 5.36E-03 
Pu-242 4.98E+00 4.98E+00 4.98E+00 4.99E+00 4.99E+00 4.99E+00 4.99E+00 4.99E+00 
Pu-244 4.89E+00 4.89E+00 4.89E+00 4.89E+00 4.89E+00 4.89E+00 4.89E+00 4.90E+00 
Am-241 5.61E+00 5.61E+00 5.62E+00 5.62E+00 5.62E+00 5.62E+00 5.63E+00 5.63E+00 

Am-242m 7.03E-02 7.08E-02 7.14E-02 7.18E-02 7.22E-02 7.27E-02 7.29E-02 7.31E-02 
Am-243 5.38E+00 5.39E+00 5.39E+00 5.39E+00 5.39E+00 5.40E+00 5.41E+00 5.42E+00 
Cm-242 6.21E+00 6.21E+00 6.22E+00 6.22E+00 6.22E+00 6.22E+00 6.22E+00 6.22E+00 
Cm-243 6.04E+00 6.04E+00 6.04E+00 6.05E+00 6.05E+00 6.07E+00 6.08E+00 6.10E+00 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius (cm) 

1 1.5 2.5 3.5 5 10 15 30 
Cm-244 5.90E+00 5.90E+00 5.90E+00 5.90E+00 5.90E+00 5.90E+00 5.90E+00 5.90E+00 
Cm-245 5.54E+00 5.54E+00 5.54E+00 5.55E+00 5.55E+00 5.57E+00 5.57E+00 5.59E+00 
Cm-246 5.52E+00 5.52E+00 5.52E+00 5.52E+00 5.53E+00 5.53E+00 5.53E+00 5.53E+00 
Cm-247 5.05E+00 5.05E+00 5.06E+00 5.07E+00 5.08E+00 5.12E+00 5.14E+00 5.20E+00 
Cm-248 2.13E+01 2.13E+01 2.13E+01 2.13E+01 2.14E+01 2.15E+01 2.16E+01 2.18E+01 
Cf-252 1.24E+01 1.24E+01 1.24E+01 1.24E+01 1.24E+01 1.24E+01 1.25E+01 1.26E+01 
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APPENDIX E 
ASSUMED F1 VALUES AND INHALATION CLASS 

NRCDose3 contains data on 203 radionuclides that can be assumed to exist in multiple forms 
for ingestion and inhalation. This appendix lists the forms of each radionuclide available for 
selection in NRCDose3. 

E.1 NRCDose3—ICRP-30 Dosimetric Methodology

Table E-1 outlines the f1 values and the ingestion and inhalation classes available for selection 
in NRCDose3 when the user has selected the methodology of International Commission on 
Radiological Protection (ICRP) Publication 30, “Limits for Intakes of Radionuclides by 
Workers” (ICRP-30), issued 1979 [Ref. 1]. The default form is noted for both ingestion and 
inhalation. 

Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes 

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

H-3 1 X All forms 1 X V Water vapor 

Be-10 0.005 X All forms 
0.005 W All others 

0.005 X Y Oxides, halides, and 
nitrates 

C-14 1 X Organic 
1 c Organic forms 
1 m Monoxides 
1 X d Dioxide 

N-13 X X 

F-18 1 X All forms 

1 X D See assignment of 
associated element 

1 W See assignment of 
associated element 

1 Y See assignment of 
associated element 

Na-22 1 X All forms 1 X D All forms 
Na-24 1 X All forms 1 X D All forms 

P-32 0.8 X All forms 
0.8 X D 

0.8 W Phosphates of particular 
element 

S-35
0.8 All inorganic 

forms 0.8 D Sulfides and sulfates of 
associated elements 

0.1 X Elemental 0.8 W Elemental 
1 X V Gases 

Cl-36 1 X All forms 
1 D See assignment of 

associated element 

1 X W See assignment of 
associated element 

Ar-39 X 
Ar-41 X 
Ca-41 0.3 X All forms 0.3 X W All forms 
Ca-45 0.3 X All forms 0.3 X W All forms 
Sc-46 0.0001 X All forms 0.0001 X Y All forms 

Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 
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Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes (cont.) 

  

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

Mn-54 0.1 X All forms 
0.1  D All others 

0.1 X W Oxides, hydroxides, 
halides, and nitrates 

Mn-56 0.1 X All forms 
0.1  D All others 

0.1 X W Oxides, hydroxides, 
halides, and nitrates 

Fe-55 
0.1 X All forms 

0.1  D All others 

0.1 X W Oxides, hydroxides, and 
halides 

0.1 X All forms 
0.1  D All others 

0.1 X W Oxides, hydroxides, and 
halides 

Co-57 
0.05 X 

Oxides, 
hydroxides, and 
trace inorganic 

0.05  W All others 

0.3  
Organic 
complexed and 
other inorganics 

0.05 X Y Oxides, hydroxides, 
halides, and nitrates 

Co-58 
0.05 X 

Oxides, 
hydroxides, and 
trace inorganic 

0.05  W All others 

0.3  
Organic 
complexed and 
other inorganics 

0.05 X Y Oxides, hydroxides, 
halides, and nitrates 

Co-60 
0.05 X 

Oxides, 
hydroxides, and 
trace inorganic 

0.05  W All others 

0.3  
Organic 
complexed and 
other inorganics 

0.05 X Y Oxides, hydroxides, 
halides, and nitrates 

Ni-59 0.05 X All forms 

0.05  D All others 

0.05 X W Oxides, hydroxides, and 
carbides 

10  V Vapors 

Ni-63 0.05 X All forms 

0.05  D All others 

0.05 X W Oxides, hydroxides, and 
carbides 

10  V Vapors 

Ni-65 0.05  All forms 

0.05  D All others 

0.05 X W Oxides, hydroxides, and 
carbides 

10  V Vapors 

Cu-64 0.5 X All forms 

0.5  D All others 

0.5  W Sulfites, halides, and 
nitrates 

0.5 X Y Oxides and hydroxides 
Zn-65 0.5 X All forms 0.5 X Y All forms 

Zn-69m 0.5 X All forms 0.5 X Y All forms 
Zn-69 0.5 X All forms 0.5 X Y All forms 

Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 
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Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes (cont.) 

  

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

Ga-67 0.001 X All forms 

0.001  D All others 

0.001 X W 
Oxides, hydroxides, 
carbides, halides, and 
nitrates 

Se-75 
0.8  All others 0.8  D All others 

0.05 X Elemental 0.8 X W Oxides, hydroxides, 
carbides, and elemental 

Se-79 
0.8  All others 0.8  D All others 

0.05 X Elemental 0.8 X W Oxides, hydroxides, 
carbides, and elemental 

Br-82 1 X All forms 
1 X D See bromide assignment 

of associated element 

1  W See bromide assignment 
of associated element 

Br-83 1 X All forms 
1 X D See bromide assignment 

of associated element 

1  W See bromide assignment 
of associated element 

Br-84 1 X All forms 
1 X D See bromide assignment 

of associated element 

1  W See bromide assignment 
of associated element 

Br-85  X All forms  X   
Kr-83m  X   X   
Kr-85m  X   X   
Kr-85  X   X   
Kr-87  X   X   
Kr-88  X   X   
Kr-89  X   X   
Rb-86 1 X All forms 1 X D All forms 
Rb-87  X All forms  X   
Rb-88 1 X All forms 1 X D All forms 
Rb-89 1 X All forms 1 X D All forms 

Sr-85 0.3 X Soluble salts 0.3 Y D All others 
0.01  SrTiO3 0.01  Y SrTiO3 

Sr-89 0.3 X Soluble salts 0.3 Y D All others 
0.01  SrTiO3 0.01  Y SrTiO3 

Sr-90 0.3 X Soluble salts 0.3 Y D All others 
0.01  SrTiO3 0.01  Y SrTiO3 

Sr-91 0.3 X Soluble salts 0.3 Y D All others 
0.01  SrTiO3 0.01  Y SrTiO3 

Sr-92 0.3 X Soluble salts 0.3 Y D All others 
0.01  SrTiO3 0.01  Y SrTiO3 

Y-90 0.0001 X All forms 0.0001  W All others 
0.0001 X Y Oxides and hydroxides 

Y-91m 0.0001 X All forms 0.0001  W All others 
0.0001 X Y Oxides and hydroxides 

Y-91 0.0001 X All forms 0.0001  W All others 
0.0001 X Y Oxides and hydroxides 

Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 
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Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes (cont.) 

  

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

Y-92 0.0001 X All forms 0.0001  W All others 
0.0001 X Y Oxides and hydroxides 

Y-93 0.0001 X All forms 0.0001  W All others 
0.0001 X Y Oxides and hydroxides 

Zr-93 0.002 X All forms 

0.002  D All others 

0.002 X W Oxides, hydroxides, 
halides, and nitrates 

0.002  Y Carbides 

Zr-95 0.002 X All forms 

0.002  D All others 

0.002 X W Oxides, hydroxides, 
halides, and nitrates 

0.002  Y Carbides 

Zr-97 0.002 X All forms 

0.002  D All others 

0.002 X W Oxides, hydroxides, 
halides, and nitrates 

0.002  Y Carbides 

Nb-93m 0.01 X All forms 0.01  W All others 
0.01 X Y Oxides and hydroxides 

Nb-95 0.01 X All forms 0.01  W All others 
0.01 X Y Oxides and hydroxides 

Nb-97 0.01 X All forms 0.01  W All others 
0.01 X Y Oxides and hydroxides 

Mo-93 
0.8 X All others 0.8  D All others 

0.05  MoS2 0.05 X Y Oxides, hydroxides, and 
MoS2 

Mo-99 
0.8 X All others 0.8  D All others 

0.05  MoS2 0.05 X Y Oxides, hydroxides, and 
MoS2 

Tc-99m 0.8 X All forms 
0.8  D All others 

0.8 X W Oxides, hydroxides, 
halides, and nitrates 

Tc-99 0.8 X All forms 
0.8  D All others 

0.8 X W Oxides, hydroxides, 
halides, and nitrates 

Tc-101 0.8 X All forms 
0.8  D All others 

0.8 X W Oxides, hydroxides, 
halides, and nitrates 

Ru-103 0.05 X All forms 
0.05  D All others 
0.05  W Halides 
0.05 X Y Oxides and hydroxides 

Ru-105 0.05 X All forms 
0.05  D All others 
0.05  W Halides 
0.05 X Y Oxides and hydroxides 

Ru-106 0.05 X All forms 
0.05  D All others 
0.05  W Halides 
0.05 X Y Oxides and hydroxides 

Rh-105 0.05 X All forms 
0.05  D All others 
0.05  W Halides 
0.05 X Y Oxides and hydroxides 

Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 
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Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes (cont.) 

  

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

Ru-106 0.05 X All forms 
0.05  D All others 
0.05  W Halides 
0.05 X Y Oxides and hydroxides 

Rh-105 0.05 X All forms 
0.05  D All others 
0.05  W Halides 
0.05 X Y Oxides and hydroxides 

Pd-107 0.005 X All forms 
0.005  D All others 
0.005  W Nitrates 
0.005 X Y Oxides and hydroxides 

Pd-109 0.005 X All forms 
0.005  D All others 
0.005  W Nitrates 
0.005 X Y Oxides and hydroxides 

Ag-110m 0.05 X All forms 
0.05  D All others 
0.05  W Nitrates and sulfides 
0.05 X Y Oxides and hydroxides 

Ag-111 0.05 X All forms 
0.05  D All others 
0.05  W Nitrates and sulfides 
0.05 X Y Oxides and hydroxides 

Cd-109 0.05 X All forms 

0.05  D All others 

0.05  W Sulfates, halides, and 
nitrates 

0.05 X Y Oxides and hydroxides 

Cd-113m 0.05 X All forms 

0.05  D All others 

0.05  W Sulfates, halides, and 
nitrates 

0.05 X Y Oxides and hydroxides 

Cd-115m 0.05 X All forms 

0.05  D All others 

0.05  W Sulfates, halides, and 
nitrates 

0.05 X Y Oxides and hydroxides 

Sn-113 

0.02 X All forms 0.02  D All others 

   0.02 X W 
Oxides, hydroxides, 
halides, nitrates, sulfides, 
and Sn3(PO4)4 

Sn-123 

0.02 X All forms 0.02  D All others 

   0.02 X W 
Oxides, hydroxides, 
halides, nitrates, sulfides, 
and Sn3(PO4)4 

Sn-125 

0.02 X All forms 0.02  D All others 

   0.02 X W 
Oxides, hydroxides, 
halides, nitrates, sulfides, 
and Sn3(PO4)4 

Sn-126 

0.02 X All forms 0.02  D All others 

   0.02 X W 
Oxides, hydroxides, 
halides, nitrates, sulfides, 
and Sn3(PO4)4 

Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 
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Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes (cont.) 

  

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

Sb-124 

0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates, 
and nitrates 

Sb-125 

0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates, 
and nitrates 

Sn-126 

0.02 X All forms 0.02  D All others 

   0.02 X W 
Oxides, hydroxides, 
halides, nitrates, sulfides, 
and Sn3(PO4)4 

Sb-124 

0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates, 
and nitrates 

Sb-125 

0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates, 
and nitrates 

Sb-126 

0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates, 
and nitrates 

Sb-127 

0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates, 
and nitrates 

Te-125m 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides, and 
nitrates 

Te-127m 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides, and 
nitrates 

Te-127 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides, and 
nitrates 

Te-129m 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides, and 
nitrates 

Te-129 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 

Te-131m 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides, and 
nitrates 

Te-131 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides, and 
nitrates 

Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 
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Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes (cont.) 

  

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

Te-132 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides, and 
nitrates 

Te-133m 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides, and 
nitrates 

Te-134 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides, and 
nitrates 

I-125 1 X All forms 1 X D All forms 
I-129 1 X All forms 1 X D All forms 
I-130 1 X All forms 1 X D All forms 
I-131 1 X All forms 1 X D All forms 
I-132 1 X All forms 1 X D All forms 
I-133 1 X All forms 1 X D All forms 
I-134 1 X All forms 1 X D All forms 
I-135 1 X All forms 1 X D All forms 

Xe-131m  X   X   
Xe-133m  X   X   
Xe-133  X   X   

Xe-135m  X   X   
Xe-135  X   X   
Xe-137  X   X   
Xe-138  X   X   

Cs-134m 1 X All forms 1 X D All forms 
Cs-134 1 X All forms 1 X D All forms 
Cs-135 1 X All forms 1 X D All forms 
Cs-136 1 X All forms 1 X D All forms 
Cs-137 1 X All forms 1 X D All forms 
Cs-138 1 X All forms 1 X D All forms 
Cs-139 1 X All forms 1 X D All forms 
Ba-133 0.1 X All forms 0.1 X D All forms 
Ba-139 0.1 X All forms 0.1 X D All forms 
Ba-140 0.1 X All forms 0.1 X D All forms 
Ba-141 0.1 X All forms 0.1 X D All forms 
Ba-142 0.1 X All forms 0.1 X D All forms 

La-140 0.001 X All forms 0.001  D All others 
0.001 X W Oxides and hydroxides 

La-141 0.001 X All forms 0.001  D All others 
0.001 X W Oxides and hydroxides 

La-142 0.001 X All forms 0.001  D All others 
0.001 X W Oxides and hydroxides 

Ce-141 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, and 
fluorides 

Ce-143 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, and 
fluorides 

Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 



 

E-8 

Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes (cont.) 

  

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

Ce-144 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, and 
fluorides 

Pr-143 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbide, and fluorides 

Pr-144 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbide, and fluorides 

Nd-147 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides, and fluorides 

Pm-147 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides, and fluorides 

Pm-148m 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides, and fluorides 

Pm-148 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides, and fluorides 

Pm-149 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides, and fluorides 

Pm-151 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides, and fluorides 

Sm-151 0.0003 X All forms 0.0003 X W All forms 
Sm-153 0.0003 X All forms 0.0003 X W All forms 
Eu-152 0.001 X All forms 0.001 X W All forms 
Eu-154 0.001 X All forms 0.001 X W All forms 
Eu-155 0.001 X All forms 0.001 X W All forms 
Eu-156 0.001 X All forms 0.001 X W All forms 
Tb-160 0.0003 X All forms 0.0003 X W All forms 

Ho-166m 0.0003 X All forms 0.0003 X W All forms 
Tm-170 0.0003 X All forms 0.0003 X W All forms 

Yb-169 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, and 
fluorides 

Ta-182 0.001 X All forms 

0.001  W All others 

0.001 X Y 
Oxides, hydroxides, 
halides, carbides, nitrates, 
and nitrides 

W-181 0.01  Tungstic acid 0.3 X D All forms 0.3 X All others 

W-185 0.01  Tungstic acid 0.3 X D All forms 0.3 X All others 

W-187 0.01  Tungstic acid 0.3 X D All forms 0.3 X All others 
Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 
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Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes (cont.) 

  

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

Ir-192 0.01 X All forms 

0.01  D All others 

0.01  W Halides, nitrates, and 
metallic form 

0.01 X Y Oxides and hydroxides 

Au-198 0.1 X All forms 
0.1  D All others 
0.1  W Halides and nitrates 
0.1 X Y Oxides and hydroxides 

Tl-201 1 X All forms 1 X D All forms 
Tl-204 1 X All forms 1 X D All forms 
Pb-210 0.2 X All forms 0.2 X D All forms 

Bi-210 0.05 X All forms 0.05  D Nitrates 
0.05 Y W All others 

Po-210 0.1 X All forms 
0.1  D All others 

0.1 X W Oxides, hydroxides, and 
nitrates 

Rn-222        
Ra-223 0.2 X All forms 0.2 X W All forms 
Ra-224 0.2 X All forms 0.2 X W All forms 
Ra-225 0.2 X All forms 0.2 X W All forms 
Ra-226 0.2 X All forms 0.2 X W All forms 
Ra-228 0.2 X All forms 0.2 X W All forms 

Ac-225 0.001 X All forms 
0.001  D All others 
0.001  W Halides and nitrates 
0.001 X Y Oxides and hydroxides 

Ac-227 0.001 X All forms 
0.001  D All others 
0.001  W Halides and nitrates 
0.001 X Y Oxides and hydroxides 

Th-227 0.0002 X All forms 0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Th-228 0.0002 X All forms 0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Th-229 0.0002 X All forms 0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Th-230 0.0002 X All forms 0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Th-232 0.0002 X All forms 0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Th-234 0.0002 X All forms 0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Pa-231 0.001 X All forms 0.001  W All others 
0.001 X Y Oxides and hydroxides 

Pa-233 0.001 X All forms 0.001  W All others 
0.001 X Y Oxides and hydroxides 

U-232 
0.05  Hexavalent 0.05  D UF6, UO2F2, and 

UO2(NO3)2 

0.002 X Insoluble forms 0.05  W UO3, UF4, and UCl4 
0.002 X Y UO2, U3O8 

Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 
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Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes (cont.) 

  

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

U-233 
0.05  Hexavalent 0.05  D UF6, UO2F2, and 

UO2(NO3)2 

0.002 X Insoluble forms 0.05  W UO3, UF4, and UCl4 
0.002 X Y UO2, U3O8 

U-234 
0.05  Hexavalent 0.05  D UF6, UO2F2, and 

UO2(NO3)2 

0.002 X Insoluble forms 0.05  W UO3, UF4, and UCl4 
0.002 X Y UO2, U3O8 

U-235 
0.05  Hexavalent 0.05  D UF6, UO2F2, and 

UO2(NO3)2 

0.002 X Insoluble forms 0.05  W UO3, UF4, and UCl4 
0.002 X Y UO2, U3O8 

U-236 
0.05  Hexavalent 0.05  D UF6, UO2F2, and 

UO2(NO3)2 

0.002 X Insoluble forms 0.05  W UO3, UF4, and UCl4 
0.002 X Y UO2, U3O8 

U-237 
0.05  Hexavalent 0.05  D UF6, UO2F2, and 

UO2(NO3)2 

0.002 X Insoluble forms 0.05  W UO3, UF4, and UCl4 
0.002 X Y UO2, U3O8 

U-238 
0.05  Hexavalent 0.05  D UF6, UO2F2, and 

UO2(NO3)2 

0.002 X Insoluble forms 0.05  W UO3, UF4, and UCl4 
0.002 X Y UO2, U3O8 

Np-237 0.001 X All forms 0.001 X W All forms 
Np-238 0.001 X All forms 0.001 X W All forms 
Np-239 0.001 X All forms 0.001 X W All forms 

Pu-236 
0.001  Others 0.001  W All others 
0.0001  Nitrates 1E-05 X Y Oxides 0.00001 X Oxides 

Pu-238 
0.001  Others 0.001  W All others 
0.0001  Nitrates 1E-05 X Y Oxides 0.00001 X Oxides 

Pu-239 
0.001  Others 0.001  W All others 
0.0001  Nitrates 1E-05 X Y Oxides 0.00001 X Oxides 

Pu-240 
0.001  Others 0.001  W All others 
0.0001  Nitrates 1E-05 X Y Oxides 0.00001 X Oxides 

Pu-241 
0.001  Others 0.001  W All others 
0.0001  Nitrates 1E-05 X Y Oxides 0.00001 X Oxides 

Pu-242 
0.001  Others 0.001  W All others 
0.0001  Nitrates 1E-05 X Y Oxides 0.00001 X Oxides 

Pu-244 
0.001  Others 0.001  W All others 
0.0001  Nitrates 1E-05 X Y Oxides 0.00001 X Oxides 

Am-241 0.001 X All forms 0.001 X W All forms 
Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 
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Table E-1 NRCDose3—ICRP-30 f1 Values and Ingestion and Inhalation Classes (cont.) 

E.2 NRCDose3—ICRP-72 Dosimetric Methodology 

Table E-2 outlines the f1 values and the ingestion and inhalation classes available for selection 
in NRCDose3 when the user has selected the methodology in ICRP Publication 72, 
“Age-Dependent Dose to Members of the Public from Intake of Radionuclides, Part 5: 
Compilation of Ingestion and Inhalation Dose Coefficients” (ICRP-72), issued 1996 [Ref. 2]. The 
default form is noted for both ingestion and inhalation. 

Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

H-3 

1 OBT  1 OBT  V 

1 X 

1 HT  V 
1 CH3T  V 
1 HTO X V 

1  F 
0.2  M 

0.02  S 

Be-10 0.02 X 0.02  M 
0.02 X S 

C-14 1 X 

1 CO2 X V 
1 CO  V 
1 CH4  V 

1  V 
1  F 

0.2  M 
0.02  S 

N-13  X  X  
Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 

  

Nuclide Ingestion Inhalation 
f1 Default Form f1 Default Class Form 

Am-242m 0.001 X All forms 0.001 X W All forms 
Am-243 0.001 X All forms 0.001 X W All forms 
Cm-242 0.001 X All forms 0.001 X W All forms 
Cm-243 0.001 X All forms 0.001 X W All forms 
Cm-244 0.001 X All forms 0.001 X W All forms 
Cm-245 0.001 X All forms 0.001 X W All forms 
Cm-246 0.001 X All forms 0.001 X W All forms 
Cm-247 0.001 X All forms 0.001 X W All forms 
Cm-248 0.001 X All forms 0.001 X W All forms 

Cf-252 0.001 X All forms 0.001  W All others 
0.001 X Y Oxides and hydroxides 

Notes: 
ICRP-30 Inhalation Class D, W, and Y corresponds to days, weeks, and years classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

F-18 1 X 
1 X F 
1  M 
1  S 

Na-22 1 X 1 X F 
Na-24 1 X 1 X F 

P-32 1 X 1 X F 
1  M 

S-35 

1  1 SO2 Y V 

1 X 

1 CS2  V 
1  F 

0.2  M 
0.02  S 

Cl-36 1 X 1  F 
1 X M 

Ar-39  X  X  
Ar-41  X  X  

Ca-41 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ca-45 0.6 X 
0.6  F 
0.2 X M 

0.02  S 
Sc-46 0.001 X 0.001 X S 

Cr-51 
0.2  0.2  F 

0.02 X 0.2  M 
0.2 X S 

Mn-54 0.2 X 0.2  F 
0.2 X M 

Mn-56 0.2 X 0.2  F 
0.2 X M 

Fe-55 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Fe-59 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Co-57 0.6 X 
0.6  F 
0.2  M 

0.02 X S 

Co-58 0.6 X 
0.6  F 
0.2  M 

0.02 X S 

Co-60 0.6 X 
0.6  F 
0.2  M 

0.02 X S 
Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Ni-59 0.1 X 

0.1  V 
0.1  F 
0.1 X M 

0.02  S 

Ni-63 0.1 X 

0.1  V 
0.1  F 
0.1 X M 

0.02  S 

Ni-65 0.1 X 

0.1  V 
0.1  F 
0.1 X M 

0.02  S 

Cu-64 1 X 
1  F 
1  M 
1 X S 

Zn-65 1 X 
1  F 

0.2  M 
0.02 X S 

Zn-69 1 X 
1  F 

0.2  M 
0.02 X S 

Zn-69m 1 X 
1  F 

0.2  M 
0.02 X S 

Ga-67 0.01 X 0.01  F 
0.01 X M 

Se-75 1 X 
1  F 

0.2 X M 
0.02  S 

Se-79 1 X 
1  F 

0.2 X M 
0.02  S 

Br-82 1 X 1 X F 
1  M 

Br-83 1 X 1 X F 
1  M 

Br-84 1 X 1 X F 
1  M 

Br-85  X  X  
Kr-83M  X  X  
Kr-85M  X  X  
Kr-85  X  X  
Kr-87  X  X  
Kr-88  X  X  
Kr-89  X  X  
Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 

  



 

E-14 

Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Rb-86 1 X 1 X F 
Rb-87 1 X 1 X F 
Rb-88 1 X 1 X F 
Rb-89 1 X 1 X F 

Sr-85 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Sr-89 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Sr-90 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Sr-91 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Sr-92 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Y-90 0.001 X 0.001  M 
0.001 X S 

Y-91 0.001 X 0.001  M 
0.001 X S 

Y-91m 0.001 X 0.001  M 
0.001 X S 

Y-92 0.001 X 0.001  M 
0.001 X S 

Y-93 0.001 X 0.001  M 
0.001 X S 

Zr-93 0.02 X 
0.02  F 
0.02 X M 
0.02  S 

Zr-95 0.02 X 
0.02  F 
0.02 X M 
0.02  S 

Zr-97 0.02 X 
0.02  F 
0.02 X M 
0.02  S 

Nb-93m 0.02 X 
0.02  F 
0.02  M 
0.02 X S 

Nb-95 0.02 X 
0.02  F 
0.02  M 
0.02 X S 

Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Nb-97 0.02 X 
0.02  F 
0.02  M 
0.02 X S 

Mo-93 1 X 
1  F 

0.2  M 
0.02 X S 

Mo-99 1 X 
1  F 

0.2  M 
0.02 X S 

Tc-99 1 X 
1  F 

0.2 X M 
0.02  S 

Tc-99m 1 X 
1  F 

0.2 X M 
0.02  S 

Tc-101 1 X 
1  F 

0.2 X M 
0.02  S 

Ru-103 0.1 X 

0.1  V 
0.1  F 
0.1  M 

0.02 X S 

Ru-105 0.1 X 

0.1  V 
0.1  F 
0.1  M 

0.02 X S 

Ru-106 0.1 X 

0.1  V 
0.1  F 
0.1  M 

0.02 X S 

Rh-105 0.1 X 
0.1  F 
0.1  M 
0.1 X S 

Pd-107 0.05 X 
0.05  F 
0.05  M 
0.05 X S 

Pd-109 0.05 X 
0.05  F 
0.05  M 
0.05 X S 

Ag-110m 0.1 X 
0.1  F 
0.1  M 

0.02 X S 

Ag-111 0.1 X 
0.1  F 
0.1  M 

0.02 X S 
Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Cd-109 0.1 X 
0.1  F 
0.1  M 
0.1 X S 

Cd-113m 0.1 X 
0.1  F 
0.1  M 
0.1 X S 

Cd-115m 0.1 X 
0.1  F 
0.1  M 
0.1 X S 

Sn-113 0.04 X 0.04  F 
0.04 X M 

Sn-123 0.04 X 0.04  F 
0.04 X M 

Sn-125 0.04 X 0.04  F 
0.04 X M 

Sn-126 0.04 X 0.04  F 
0.04 X M 

Sb-124 0.2 X 
0.2  F 

0.02 X M 
0.02  S 

Sb-125 0.2 X 
0.2  F 

0.02 X M 
0.02  S 

Sb-126 0.2 X 
0.2  F 

0.02 X M 
0.02  S 

Sb-127 0.2 X 
0.2  F 

0.02 X M 
0.02  S 

Te-125m 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-127 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-127m 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-129 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 
Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Te-129m 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-131 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-131m 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-132 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-133m 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-134 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

I-125 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-129 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-130 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-131 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

I-132 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-133 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-134 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-135 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

Xe-131m  X  X  
Xe-133m  X  X  
Xe-133  X  X  
Xe-135m  X  X  
Xe-135  X  X  
Xe-137  X  X  
Xe-138  X  X  

Cs-134 1 X 
1 X F 

0.2  M 
0.02  S 

Cs-134m 1 X 
1 X F 

0.2  M 
0.02  S 

Cs-135 1 X 
1 X F 

0.2  M 
0.02  S 

Cs-136 1 X 
1 X F 

0.2  M 
0.02  S 

Cs-137 1 X 
1 X F 

0.2  M 
0.02  S 

Cs-138 1 X 
1 X F 

0.2  M 
0.02  S 

Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

CS-139  X  X  

Ba-133 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Ba-139 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Ba-140 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Ba-141 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Ba-142 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

La-140 0.005 X 0.005  F 
0.005 X M 

La-141 0.005 X 0.005  F 
0.005 X M 

La-142 0.005 X 0.005  F 
0.005 X M 

Ce-141 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Ce-143 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Ce-144 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Pr-143 0.005 X 0.005  M 
0.005 X S 

Pr-144 0.005 X 0.005  M 
0.005 X S 

Nd-147 0.005 X 0.005  M 
0.005 X S 

Pm-147 0.005 X 0.005  M 
0.005 X S 

Pm-148 0.005 X 0.005  M 
0.005 X S 

Pm-148m 0.005 X 0.005  M 
0.005 X S 

Pm-149 0.005 X 0.005  M 
0.005 X S 

Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Pm-151 0.005 X 0.005  M 
0.005 X S 

Sm-151 0.005 X 0.005 X M 
Sm-153 0.005 X 0.005 X M 
Eu-152 0.005 X 0.005 X M 
Eu-154 0.005 X 0.005 X M 
Eu-155 0.005 X 0.005 X M 
Eu-156 0.005 X 0.005 X M 
Tb-160 0.005 X 0.005 X M 
Ho-166m 0.005 X 0.005 X M 
Tm-170 0.005 X 0.005 X M 

Yb-169 0.005 X 0.005  M 
0.005 X S 

Ta-182 0.01 X 0.01  M 
0.01 X S 

W-181 0.6 X 0.6 X F 
W-185 0.6 X 0.6 X F 
W-187 0.6 X 0.6 X F 

Ir-192 0.02 X 
0.02  F 
0.02  M 
0.02 X S 

Au-198 0.2 X 
0.2  F 
0.2  M 
0.2 X S 

Tl-201 1 X 1 X F 
Tl-204 1 X 1 X F 

Pb-210 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Bi-210 0.1 X 0.1  F 
0.1 X M 

Po-210 1 X 
0.2  F 
0.2 X M 

0.02  S 
RN-222  X  X  

Ra-223 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ra-224 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ra-225 0.6 X 
0.6  F 
0.2 X M 

0.02  S 
Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Ra-226 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ra-228 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ac-225 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Ac-227 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-227 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-228 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-229 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-230 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-232 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-234 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Pa-231 0.005 X 0.005  M 
0.005 X S 

Pa-233 0.005 X 0.005  M 
0.005 X S 

U-232 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-233 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-234 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

U-235 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-236 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-237 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-238 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

Np-237 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Np-238 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Np-239 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Pu-236 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-238 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-239 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-240 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-241 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-242 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-244 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Am-241 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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Table E-2 NRCDose3—ICRP-72 f1 Values and Ingestion and Inhalation Classes (cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Am-242m 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Am-243 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-242 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-243 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-244 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-245 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-246 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-247 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-248 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cf-252 0.005 X 0.005 X M 
Notes: 
ICRP-72 inhalation classes F, M, S, and V correspond to fast, medium, slow, and vapor classes, respectively. 
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